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Single User Copyright and License Agreement, Diagnostic Instruments 
Carefully read the following terms and conditions before using the software.  By using the software 
on the enclosed CD, you indicate your complete and unconditional acceptance of these terms and 
conditions. 

This document is a legal agreement between you, the end user, and Diagnostic Instruments, 
concerning the use of the enclosed software.  This agreement constitutes the complete agreement 
between you and Diagnostic Instruments. 

If you do not agree to the terms of this agreement, do not use the CD.  Promptly return the CD, 
including the written materials, the binder, and all other equipment/containers to the dealer where 
you purchased them from.  You will receive a full refund. 
 
1. LICENSE:  Diagnostic Instruments grants you the LICENSEE, a limited, non-exclusive license to use 

the enclosed software.  You do not need a separate license for using the software on multiple 
computers.  This means that your organization may install the software on more than one computer 
that is owned or leased by the organization.  You may make a copy of the Software for backup and 
archival purposes, provided that the original copyright notice and/or other legend is reproduced on 
each copy.  You may not modify, translate, adapt, reverse engineer, decompile, disassemble, or create 
derivative words based on the Software.   

2. TITLE:  Diagnostic Instruments retains title to the Software, subject to your right to possess and use 
the software while the License is in effect.  You will agree to use your best efforts to protect the 
software from unauthorized use, illegal reproduction, or illicit distribution. 

3. COPYRIGHTS and TRADE SECRETS:  Diagnostic Instruments owns all rights to the Software.  
This agreement does not convey ownership of the software to you, but only the right to use a copy of 
the software strictly in accordance with this agreement.  The unauthorized duplication or distribution 
of the software or the documentation is an infringement of Diagnostic Instruments' rights to the 
software and may be subject to criminal and/or civil penalties. 

4. UPDATE POLICY: To receive updates to the Software, complete and return the enclosed registration 
card to Diagnostic Instruments.  All updates provided to you shall become part of the Software 
governed by the terms of this agreement. 

5. GENERAL:  This agreement merges all prior written and oral communication regarding the Software 
and sets forth the entire agreement of the parties.  This agreement shall be governed by the laws of the 
state of Michigan, without regard to the conflict of law provisions thereof, as if it was performed 
wholly within the state. 

 
 
Copyright 2001 - 2002, Diagnostic Instruments, Inc. 
All rights reserved. 
 
Trademarks: 

Adobe Photoshop is a registered trademark of Adobe Systems Incorporated. 
Image Pro is a registered trademark of Media Cybernetics 
SPOT, SPOT Enhanced, Insight, RT, RT Slider and Vision,  are registered trademarks of Diagnostic 
Instruments, Inc. 
Windows 95, Windows 98, Windows NT, Windows 200, and Windows ME are registered trademarks     

 of Microsoft,Inc. 
 

All other product names mentioned in this document are the property of their respective trademark holders. 
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FCC “Class A” Product Warning 

All SPOT cameras fall into the Class A category of the FCC (Federal Communications Commission) 
emission standard EN55022/CISPR22.  The following is the FCC’s standard warning for this type of 
device:    

WARNING: 
This is a Class A Product.  In a domestic environment this product may cause radio 
interference in which case the user may be required to take adequate measures. 

 

Warranty Information 

LIMITED WARRANTY: Diagnostic Instruments, Inc. (henceforth referred to as Diagnostic) warrants to 
the original purchaser, that the camera will be free of defects in material and workmanship for a period of 
one year from the date of purchase.  Diagnostic shall, at its choice, either repair or replace, free of charge, 
any product that, upon inspection by Diagnostic, is found to be defective.  Abuse, misuse, or improper 
maintenance and/or repair during the one year period invalidates this warranty.  This warranty does not 
cover defects caused by ordinary wear and tear.   

In no event shall Diagnostic be liable for any consequential, indirect, incidental, or special damages of any 
nature arising from the sale or use of this product.   

In no event, and under no circumstance shall Diagnostic be liable to the Dealer or to any other individual or 
entity for any indirect, special, consequential, or incidental losses or damages, including without limitation, 
lost profits. 

EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, DIAGNOSTIC INSTRUMENTS, 
INC., MAKES NO WARRANTIES OR REPRESENTATIONS TO THE DEALER OR USER, EITHER 
EXPRESS OR IMPLIED.  THIS INCLUDES, WITHOUT LIMITATION, WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR THE VALIDITY, NON-
INFRINGEMENT, OR OWNERSHIP OF ANY PATENTS OR TECHNOLOGY IN OR CONCERNING 
THE CAMERA.  DIAGNOSTIC INSTRUMENTS INC., HEREBY EXPRESSLY DISCLAIMS ALL 
SUCH WARRANTIES, GUARANTIES, REPRESENTATIONS, OR CONDITIONS. 
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About This Manual 

Introduction 
The manual contains instructions for the SPOT Vision cameras (Color and B/W) and version 3.5 of the 
accompanying SPOT software.  An on-line version of this manual in PDF (portable document format) is 
also included on the CD that contains the SPOT software.  Refer to the Installation Guidelines chapter for 
more information on accessing and using the on-line manual.  

Document Conventions  
The following is a list of the textual conventions used in this manual: 

Notes ! Note:  This is an example of a note.  Notes appear within the text to indicate 
information for further consideration or reference. 

 

Cautions CAUTION! 
This is an example of a cautionary note.  Cautionary notes appear to indicate that 
you should carefully consider the implications of an action. 

  

Warnings "WARNING" 

THIS IS AN EXAMPLE OF A WARNING.  WARNINGS INDICATE THAT THE ACTION 
YOU ARE TAKING COULD EITHER CAUSE INJURY TO YOURSELF OR COULD 
HARM YOUR SYSTEM 

   
   

Vision B/W Vision 
B/W 

Vision B/W notes indicate specific instructions for users with the monochrome version 
of the SPOT Vision camera.  In most cases, these notes indicate that a color related 
option is unavailable. 

   

Software 
Development ! Software Development informational notes indicate special circumstances related to 

the current release of the SPOT software.  These notes also describe how to obtain 
free updates from Diagnostic Instruments.   
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Organization of the Manual 
The User Guide to the SPOT Vision Camera is structured as shown in the table below.   

 
Chapter 

 
Description 

About This Manual Describes document conventions, manual structure. 

Installation Guidelines Describes hardware/software installation. 

Quick Start Steps for immediately capturing your first image. 

Ch. 1 – Navigating the   
Program  

Details the program environment.   

Ch. 2 – Preparing to 
Take a Picture 

Describes the different procedures involved in setting up the software for image 
captures. 

Ch. 3 – Taking a Picture Describes the image capture process. 

Ch. 4 – Viewing, Editing, 
and Annotating Images 

Describes the image editing and annotation features in the software. 

Ch. 5 – Reporting Describes the reporting functionality in the software.   

Ch. 6 – Printing Images Describes the procedures for printing images from the SPOT program. 

Ch. 7 – Using Other 
Windows Imaging 

Applications  

Describes how to capture images (via a TWAIN interface) with the SPOT 
camera using other imaging programs such as Photoshop or Image-Pro Plus.  

Ch. 8 – Using Other Mac 
Imaging Applications  

Describes how to capture images (via a 3rd Party Interface) with the SPOT 
camera using other imaging programs such as Photoshop or Image-Pro Plus.  

Appendix A: Electronic 
Imaging Theory and 

SPOT Cameras 

An introduction to the theory behind SPOT cameras. 

Appendix B: 
Specifications 

Technical specifications for the SPOT hardware and software. 

Appendix C: Keyboard 
and Toolbar Button 

Commands 

A table of menu commands and their keystroke and button equivalents. 

Appendix D: Selected 
Error Messages 

A table of errors, causes, and solutions 
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Free Software Updates 
Registered SPOT camera owners can download free software updates via the Internet.  When you register 
your product, Diagnostic Instruments supplies you with the user name and password needed to download 
the latest release of the software, as well as PDF user guides, software developer kits, and SPOT third party 
DLLs.   To register, contact Diagnostic Instruments at 1 (586) 731-6000. You should periodically check 
Diagnostic Instruments’ web site (www.diaginc.com/software) for the latest release.   

To download files, follow these steps: 

1. Access the software download page on Diagnostics Instruments’ web  site – 
www.diaginc.com/software. 

2. Click on the link for your software/operating system.  You are prompted for a user name and 
password. 

3. Enter your User Name and Password.  If you have not yet registered your product, contact 
Diagnostic Instruments at 1 (586) 731-6000 to do so and obtain the user name and password. 

4. Click OK.    
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Introduction 
The following sections detail the system and installation guidelines for using the SPOT Vision camera and 
v 3.5 of the SPOT software.  They are as follows: 

• System Requirements 
• What is in the Box 
• Installing the Software 
• Installing the Hardware 
• Using SPOT’s On-line Documentation 

System Requirements 
The following sections details the hardware and software requirements needed for the SPOT Vision 
camera/software.  Minimum and optimal system recommendations are detailed for each item. 

Equipment Standards - Windows 
 Minimum Optimal System Recommendations 

Processor Pentium,  
166 MHz 

Dell Dimension 4100 
with 1 GHz Pentium III Processor 

In addition to the fact that this is a fast and reliable machine, there are many 
good reasons to order from Dell, including: 
• Easy to use web site 
• On-line ordering and product selection 
• One week shipping time 
• Excellent technical support  

Video Card  A card that 
supports 24 bit, 
true color at the 

desired resolution 
with a refresh rate 

above 70 Hz. 

32 Mb Nvidia TNT2 M64 AGP Graphics Card 
This is the standard card offered on the aforementioned Dell Dimension 4100.  
For customers who want to videotape their live image output, Diagnostic 
Instruments recommends the following cards: 
• Matrox G400 Dual Head video card 
• ATI Radeon 64 Mb VIVO card 
Both of these cards have video outputs for connection to a standard VCR. 
All of the above cards offer refresh rates of 85 MHz or more at 1600 x 1200 
resolution.  All of these cards provide displays with sharp resolution, superb 
color quality, and clean, artifact-free images. 

With some video cards, you might experience system crashes or display problems in live image mode; you might also 
experience display problems when zooming in on captured images.  To correct these problems, lower the Graphics 
Acceleration setting in Windows, as described in the  “Video Card Related Problems” section below.  

RAM 64 Mb 256 Mb of RAM is recommended for optimal smoothness of operation. 

PCI Slot 
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Equipment Standards – Windows (cont.) 

 Minimum Optimal System Recommendations 

Monitor Any color  monitor 
with at least 800 x 

600 pixel resolution 
at 24 bit RGB, and 
a refresh rate over 

70 Hz.   

Hitachi CM 815 Plus  

This is Hitachi’s latest 21“ monitor, the replacement for the 814.  It has perfect 
focus from the center to the corners of the screen, very fine resolution, and 
consistent color rendition.  A very bright monitor, the 815 can display brilliant 
images even in high ambient light environments.   It is also compact by 
comparison to other 21” monitors. 

Operating 
System 

Windows 95/98/NT/ 
2000/ME/XP 

Windows XP  

Microsoft intends to replace all versions of the Windows operating system with 
Windows XP.  Previous versions of the Spot software experienced significantly 
slower Live image frame rates when operating under Windows NT/2000 than 
when operating under Windows 95/98/ME.  This situation has been rectified. 
With v3.5 of the Spot software, live image frame rates are equally fast with ALL 
versions of Windows, including XP. 

Printer  Epson Stylus Photo 750 
This printer produces high resolution, true color, 8.5 x 11 glossy prints that look 
better than those produced by many dye sub printers.  It is perfect for printing 
reports that contain a mixture of images and text.  It sells for an incredible $298.  
Refer to the “Epson Printer Settings” section below for details on how to optimize 
print quality. 

Additional Hardware and Software 

Web 
Browser 

Internet Explorer 4.0 or greater.   

This requirement applies only to Windows 95 users.  Current releases of Internet Explorer are available 
as free downloads from www.microsoft.com/downloads.  

Coupler A digital camera coupler designed to fit a camera with a C mount.  

Diagnostic Instruments makes couplers for most microscopes.  They are available from the dealer 
where the camera was purchased. Diagnostic Instruments suggest the D10XXC – 1x C-Mount 
Coupler, which works with most microscopes.  If the D10 series will not work with your microscope, 
Diagnostic Instruments suggests the following alternatives: 

• HRU060-CMT coupler (0.60x) and the appropriate bottom clamp. 

• HRD100-CMT coupler (1x) and the appropriate bottom clamp. 

Lens C- Mount lens for 1” format CCD 

Light 
Source 

Because the SPOT Vision camera is capable of extremely short exposure times, light sources whose 
intensity varies with the waveform of the 60 Hz line supply, should be avoided.   Problem light sources 
include fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps.  These light 
sources cause the Live Image window to flicker and result in incorrect brightness and color balance 
readings in captured images.  We have found that the low voltage halogen/xenon lamps used on most 
microscopes work well, as do the mercury burners used on fluorescence illuminators. 

If your work requires you to use a light source that is problematic, you can use the Minimum Exposure 
option on the Image Settings window to avoid flicker and give you correct brightness and color balance 
readings.  Refer to Ch. 2 – Preparing to Take a Picture (see – Exposure: Auto or Manual > More 
(additional exposure and orientation settings) for more information. 
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Equipment Standards - Mac 
 Minimum Optimal System Recommendations 

Processor PowerPC computer with a PCI 
bus  

G4  with a Hitachi CM815 Plus monitor 
 (Note that the Apple 21” Studio Display has been discontinued) 

Note that the G4 and “Blue and White” G3 computers have new 64 
bit PCI bus connectors that are larger than the standard 32 bit PCI 
edge card connector used on the SPOT PCI bus plug-in card.  
Despite the apparent size discrepancy, the SPOT cards work when 
plugged in – the small slot on the SPOT edge connector lines up with 
the bar on the PCI bus connector. 

#### Note:  Apple Power Macintosh models 6100, 7100, and 8100 are PowerPCs, but they do not have a 
PCI bus, and thus cannot be used with the SPOT camera. The iMac does not have a PCI bus and 
cannot be used. 

Video 
Memory/ 

Card  

Enough video memory on 
either the mother board or a 
plug in video card to display 

millions of colors at the desired 
resolution, and with a refresh 

rate above 70 Hz  

The ATI Rage 128 plug-in card that is standard on G4 and “Blue and 
White” G3 computers works well. 

The ATI Radeon card is recommended for 19” and larger monitors 
used with Macs other than the G4 and “Blue and White” G3 models. 

RAM 64 Mb 256 Mb of RAM is recommended for optimal smoothness of 
operation. 

PCI Slot 
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Monitor Any color  monitor with at least 
800 x 600 pixel resolution at 

24 bit RGB, and a refresh rate 
over 70 Hz.   

Hitachi CM 815 Plus 

This is Hitachi’s latest 21“ monitor, the replacement for the 814.  It 
has perfect focus from the center to the corners of the screen, very 
fine resolution, and consistent color rendition.  A very bright monitor, 
the 815 can display brilliant images even in high ambient light 
environments.   It is also compact by comparison to other 21” 
monitors. 

Note that the 21” Apple Studio Display has been discontinued. 

Operating 
System 

Mac OS 8.6 through OSX 
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Printer  Epson Stylus Photo 750 

This printer produces high resolution, true color, 8.5 x 11 glossy 
prints that look better than those produced by many dye sub printers. 
It is perfect for printing reports that contain a mixture of images and 
text.  It sells for an incredible $298. 
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Equipment Standards – Mac (cont.) 

Additional Hardware and Software 

Coupler A digital camera coupler designed to fit a camera with a C mount.  

Diagnostic Instruments makes couplers for most microscopes.  They are available from the dealer 
where the camera was purchased. Diagnostic Instruments suggest the D10XXC – 1x C-Mount 
Coupler, which works with most microscopes.  If the D10 series will not work with your microscope, 
Diagnostic Instruments suggests the following alternatives: 

• HRU060-CMT coupler (0.60x) and the appropriate bottom clamp. 

• HRD100-CMT coupler (1x) and the appropriate bottom clamp. 

Lens C- Mount lens for 1” format CCD 

Light 
Source 

Because the SPOT Vision camera is capable of extremely short exposure times, light sources whose 
intensity varies with the waveform of the 60 Hz line supply should be avoided.   Problem light sources 
include fluorescent lamps, 120 volt incandescent bulbs, and 6 volt 20 watt halogen lamps.  These light 
sources cause the Live Image window to flicker and result in incorrect brightness and color balance 
readings in captured images.  We have found that the low voltage halogen/xenon lamps used on most 
microscopes work well, as do the mercury burners used on fluorescence illuminators. 

If your work requires you to use a light source that is problematic, you can use the Minimum Exposure 
option on the Image Settings window to avoid flicker and give you correct brightness and color balance 
readings.  Refer to Ch. 2 – Preparing to Take a Picture [see Exposure: Auto or Manual > More 
(additional exposure and orientation settings)] for more information. 
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Epson Printer Settings (Windows) 
To optimize print quality when printing images with an Epson Photo Stylus 750 printer on a PC running 
Windows 98, do the following: 

• Use photo quality, glossy paper. 

• Set the Windows printer preferences as follows (after you have installed the printer): 

a) From the Start menu, select Settings > Printers.  The Printers window displays all of the printers 
that are available to you. 

b) Right click on the Epson Stylus Photo 750 icon, and select the Properties option. The properties 
window for the printer appears. 

c) Click on the Main tab.  The properties 
window should now appear as shown at right. 

d) Set the Mode to Advanced (i.e., click on the 
Advanced button). 

e) Click on More Settings, and set the following 
parameters: 

♦ Print Quality – Super Fine 1440 dpi 
♦ Media Type – Photo Paper 
♦ Ink – Color 
♦ MicroWeave – Ensure that Super is not 

checked. 
♦ Flip Horizontal – Ensure that this option is 

not checked.  
♦ Color - ICM 

f) Click on OK.  The Current Settings under 
the Main tab on the properties window should 
appear as you defined them.  

g) Click on Apply and then click on OK to close 
the window. 

 

What is in the Box 
In addition to the manual, the shipping box should contain the following items: 

• Camera head with a dust cap 
• Power supply (with cable to camera) 
• Power cord for the power supply 
• PCI interface board  
• 50 pin data cable to connect the interface board to the camera (10 feet long) 
• Grounding wrist strap 
• One CD-R that contains: 

− The software required to operate the SPOT camera.  
− A PDF (portable document format) version of the user manual, User Guide to the SPOT Vision 

Camera.   
− The Adobe Acrobat Reader software that is required to read and/or print the user's manual.  Refer 

to “Using SPOT’s On-line Documentation” below for instructions on installing the Reader on your 
computer.
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• A registration card 
• 1 year limited warranty 

Installing the Software 
 The CD-R disk provided with your camera contains the SPOT software, which can be used with: 

• Windows 95/98/NT/2000/ME/XP 
• Mac OS 8.6 or higher 

# Note: Although the SPOT software can be installed either before or after installing the PCI card, 
Diagnostic Instruments recommends installing the software first.   

 

Windows Installation 
1. Ensure that all other application programs are closed.  Windows NT and Windows 2000 Users should 

also ensure that they are logged on with administrator privileges.  

2. If it is open, close the MS Office 95/97/2000 Tool Bar. 

3. Insert the disk into your CD drive. The SPOT InstallShield Wizard automatically runs, and the Setup 
window appears. 

4. Click on Next at the Readme Information window.  The User Information window appears.  Enter 
your name and company name. 

5. Click on Next.  The Choose Destination Location window appears.  Either press the Browse button to 
specify the destination directory, or click on Next to accept the default directory, C:\SpotCam. 

6. The Select Program Folder window appears.  Click on Next.  The Start Copying Files window 
displays the settings that you selected.  Either click on Next to accept the settings, or click on Back to 
return to the previous screens and revise the settings. 

7. After you have accepted the settings, the program files are copied over, and the installation program 
prompts you with the message Will there be a SPOT camera connected this computer?  

8. Select Yes. The installation program runs. 

9. When the installation is complete, shut down your computer, and install the plug-in card, as described 
in the Installing the Hardware section of this chapter.  At this point, if you plan to use multiple SPOT 
cameras with the computer, you can install all of the PCI cards. 

10. Re-start your computer.  Following the restart you should see a  shortcut to the SPOT program on your 
desktop. 

Video Card Related Problems (Windows) 
Diagnostic Instruments has found that the certain video cards can cause the SPOT program to crash when 
using the Live Image feature.  If you experience this problem, change the Graphics Acceleration in 
Windows to a lower setting.  Follow these steps: 

1. From the Start menu button, select Settings > Control Panel. 

2. Double click on the Display icon, 

3. Click on the Settings tab. 

4. Click on the Advanced button. 

5. Click on the Performance tab. 
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6. Change the Hardware Acceleration setting by moving the slider to a lower setting.  With some cards, 
you might have to move the slider to the lowest setting in order for live imaging to work.   

7. Click on Apply. 

8. Click on OK. 

9. Click on Close.   

10. Restart your computer before using the SPOT program. 

Windows 95 Related Errors  
If, after installing the PCI board you cannot access Windows 95, or if the camera will not communicate 
with the PC, one of the following situations might be the cause: 

• The slot that you selected for the SPOT PCI board might have been occupied (previously) by a board 
from another device. 

• The PCI slot s in the shared position (the PCI slot immediately adjacent to an ISA slot). 

These are areas that Diagnostics Instruments has found to be problematic on some installations.  This is due 
to the fact that Windows 95 is not fully plug and play compliant.  To resolve the problem, try plugging the 
board into another PCI slot. 

Windows NT Related Errors  
If, when using Windows NT, your computer freezes during an image capture process (i.e., Get Image, Live 
Image viewing. Compute Exposure, etc…), it is may be due to a problem with a setting in your computer’s 
BIOS.   To correct this problem, follow these steps: 

1. Access the BIOS settings. The method for accessing BIOS settings varies from computer to computer.  
If you are unsure of how to do this, contact your MIS department or an IT professional.   

2. Go to the Advanced Setup area.  This is the typical location, but it can vary according to the make of 
your computer.   

3. Access the PCI Bus Mastering setting. The heading that you will see depends on the make of your 
computer. 

4. Change the setting to ENABLED. 

5. Restart the computer. 

$WARNING$ 

DO NOT MODIFY OTHER BIOS SETTINGS.  ALTERING OTHER SETTINGS COULD CAUSE SYSTEM 
INSTABILITY OR RENDER THE SYSTEM UNUSABLE. 
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Mac Installation 
The CD-R disk provided with your camera contains the SPOT software, which can be used with Mac OS 
8.6 or higher.  If you are installing the SPOT software on a system with Mac OSX, ensure that you have 
an administrator password BEFORE BEGINNING THE INSTALLATION. 

To install the SPOT software on a Mac, follow the steps listed below.   

1. Insert the disk into your CD drive.  The SPOT window appears. 
2. Double click on the installer icon. 

3. Click on Continue.  The Spot 3.5 Installer window appears.  

4. Select the installation location for the program. 

5. Click on Install.  The Installing progress indicator appears.  When the installation is complete,  you 
will be prompted with one of two messages, depending on the version of the Mac OS that you are 
using: 

− If you are using Mac OS 8.6 – 9.x, the 
installation is complete.  The program 
should indicate that the installation was 
successful.  Quit the installer program, and 
restart the computer. 

− If you are using Mac OSX,  the Apple 
Package Installer program, which installs 
the device driver for the SPOT camera, 
launches and immediately prompts you to 
enter an Administrator password, as 
shown at right.  

$WARNING$ 

DO NOT CLICK ON THE CLOSE BUTTON.  IF YOU DO, THE DEVICE DRIVER WILL NOT 
INSTALL, AND YOU WILL NOT BE ABLE TO OPERATE THE CAMERA. 

6. Enter an administrator password.  To enter the password, click on the lock icon.  (“Click on the lock 
to make changes”). After you have entered a password, the SPOTPCI.pkg welcome screen appears. 

7. Click on Continue.  An informational screen appears. 

8. Click on Continue.  The program prompts you to select 
an installation destination, as shown at right. 

9. Select the Mac OSX boot drive as the installation 
destination.  The driver must be installed in this location. 

10. Click on Continue. 
11. When the installation is complete, restart the computer.  

Mac OS 8.6 - 9.0 Installation Problems 
If you are having difficulty installing the SPOT software 
with OS 8.6 – 9.0 systems, you will need to download and 
install the latest CarbonLib Apple Extension.  This is a 
standard extension included with the Mac OS, and is offered 
as a free download/upgrade from the Apple support website – www.apple.com/support.  After upgrading 
your CarbonLib extension you should be able to install the SPOT software.  

Click here to enter
an Administrator

password

Select the
Mac OSX
boot drive
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Installing the Hardware 
There are two main steps to installing the hardware: 

• Installing the PCI board  
• Connecting the camera to the microscope  

# Note: Although the SPOT software can be installed either before or after installing the PCI card, 
Diagnostic Instruments recommends installing the software first.   

 

$WARNING$ 

This (the SPOT camera) is a Class A Product.  In a domestic environment this product may cause 
radio interference in which case the user may be required to take adequate measures. 

Installing the PCI Board 
To install the PCI board, follow these steps: 

CAUTION! 
If you are unfamiliar with the procedures for installing plug in boards, refer the installation to your 
MIS department or to a qualified computer technician. 

1. Turn off the computer, and let it sit for a few minutes to let the power supply drain. 

2. Unplug all cables, and remove the power cord from the back of the computer. 

$WARNING$ 

TO AVOID ELECTRICAL SHOCK, ALWAYS REMOVE THE POWER CORD AND ALL EXTERNAL 
CABLES, AND WAIT A FEW MINUTES FOR THE POWER SUPPLY TO DRAIN BEFORE 
OPENING THE CASE. 

3. Place the computer on a clean, uncluttered surface, and remove the cover. 

4. Position the computer so that the mother board is facing you. 

$WARNING$ 

DO NOT HANDLE THE PCI INTERFACE BOARD OR TOUCH COMPONENTS INSIDE THE 
COMPUTER WITHOUT USING THE ENCLOSED GROUNDING WRIST STRAP. 

5. To discharge any static charge that might have built up on your body, touch your finger to the metal 
case of the computer’s power supply. 

6. Stick the copper foil end of the grounding wrist strap to the metal case of the computer’s power supply. 

7. Loop the other end of the strap around your wrist by pressing the sticky side against the strap, keeping 
the dark strip against your skin. 

8. Use your computer’s manual to identify the location of the PCI slot(s) on the  motherboard.    

9. Remove the metal cover plate adjacent to an available PCI slot.  Save the screw. 

# Note:  PC  users should avoid installing the PCI card in the shared slot (i.e., the PCI slot next 
to the first ISA slot. 

10. Carefully insert the PCI bus interface board into the PCI slot.   



Installation Guidelines Installing the Hardware 

User Guide to the SPOT Vision Camera xix 

11. Secure the metal bracket back into place with the screw from step nine. 

12. Put the cover back on the computer. 

13. Reboot the computer.   

− If you have Windows 95, the computer should initially indicate that it has found a new device.  
The wording of the messages varies according to which version of Windows 95 you are using. 

− Windows 95 then prompts you to reboot the computer to complete the installation.  Click on Yes 
to reboot your computer. 

− If you have Windows NT, you will not see any messages of this type because NT automatically 
updates its registry with the new information.  

Connecting the Camera to the Microscope 
After you have installed the PCI board, you can connect the SPOT camera to your microscope.  All models 
of the SPOT Vision camera require a C Mount coupler.   C-mount versions of Diagnostic Instruments’ 
D10 (1x) series couplers work with most microscopes.  If your microscope will not work with a D10 series 
coupler, the following options are available:  

• HRU060-CMT coupler (0.60x) and the appropriate bottom clamp. 

• HRD100-CMT coupler (1x) and the appropriate bottom clamp. 

To attach the camera to the microscope, follow these steps: 

1. Attach the bottom clamp to the coupler. 

2. Screw the Vision camera into the coupler/bottom clamp until it is tight. 

3. Insert the camera/coupler/bottom clamp combination into the microscope’s photoport or phototube. 

4. Tighten the thumbscrew on the microscope's phototube (or the coupler's bottom clamp) to lock the 
combination to the microscope. 

5. Connect the camera to your computer as follows: 

$WARNING$ 

MAKE SURE THAT BOTH THE COMPUTER AND THE SPOT POWER SUPPLY ARE TURNED OFF 
BEFORE CONNECTING THE CABLES.  FAILURE TO DO SO CAN RESULT IN DAMAGE TO 
ELECTRONIC COMPONENTS IN THE CAMERA. 

a) Attach one end of the of the 50 pin (10 ft.) cable to the PCI board on the back of the computer, 
and attach the other end to the camera head. 

$WARNING$ 

THE 50 PIN CABLE USES THE SAME CONNECTOR AS A PC SCSI PORT.  PLUGGING THE 
CABLE INTO A SCSI PORT WILL DAMAGE BOTH YOUR CAMERA AND SCSI CARD. 

b) Attach the power supply/cable to the camera head. 

c) Plug one end of the power cord into the power supply and the other end into a surge protector. 
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Multiple Camera Installations 
More than one SPOT camera can be operated from a single computer.   The process for installing multiple 
cameras is simple and applies to both Windows and Mac users.  Any combination of SPOT, RT, Insight or 
Vision cameras can be used. 

To install multiple cameras on one machine, follow these steps: 

1. Install the software, as specified in Installing the Software (see above). 

2.  Shut down the computer and install ALL of the PCI cards for the cameras that you want to connect to 
the computer, as described in Installing the Hardware (see above). 

3. Re-start the computer.  When you  open the SPOT program, you are prompted to select the camera that 
you want to use. 

Using SPOT’s On-line  Documentation  
To use the on-line documentation  that accompanies your SPOT camera, you must first install the Acrobat 
Reader software  that is included on the CD.  This software enables you to read and/or print the Portable 
Document Format (PDF) version of the user guide that is on your CD.   
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Quick Start 

Taking Your First Picture 
The following sections list the basic steps for setting up your microscope and camera to immediately begin 
capturing images.  

The picture taking process consists of two multi-part steps:i 

1. Preparing the microscope, specimen, and camera.  
2. Capturing the image. 

These steps assume that you have already installed the SPOT software and connected the camera to your 
computer.  If you have not done so, refer back to the previous part of this manual, Installation Guidelines.  

Preparing the Microscope and Camera 
1. Select the specimen that you want to photograph, and set up the microscope for Koehler illumination. 
2. Ensure that the specimen is in focus. 
3. Using a daylight filter (5500° K), set the lamp voltage to the photo setting (or the rated lamp voltage).   
Keep an assortment of ND (neutral density) filters on hand to use for images that are too bright (i.e., you 
receive the Exposure time too short for Camera error message). 

Capturing the Image 
To capture an image, follow these steps: 

1. Open the SPOT 
Program . 
From  the desktop click 
on the SPOT icon.  

2. View a real-time 
preview of your image 
capture. 
Click on the Live toolbar 
button. The Live Image 
window appears.  As 
the camera computes 
the optimal auto-
exposure sequence, the 
title bar displays 
Computing Exposure.  
When the program 
finishes the exposure 
computation sequence, 
the title bar displays 
Running, as shown at 
right 

3. Use the microscope’s 
controls to focus and 
frame the image as 
needed. 
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4. Perform a White Balance on the image. 

a) Click on the White Balance toolbar button. The 
live image display pauses, and the Compute 
White Balance dialog prompts you to Move to 
Clear Area of Slide.   

b) Move the slide so that the light is going through a 
clear part of the slide.   

c) Click on Begin. The Compute White Balance 
dialog displays Computing Exposure, and the 
Live Image window restarts and computes the 
new exposure settings. 

 

 

5. Click on the Image Settings toolbar button.  
The Image Settings window appears.  Ensure that the 
settings are as follows: 

Main Window: 

• Profile – Default 
• Exposure - Auto 
• Image Type – (your type of microscopy) 
• Brightness – 1.00 
• Gamma – 1.00 
• Quality/Speed – Quality (left-most position) 
• Chip Imaging Area – Full Chip 
• Live Image Auto Brightness - Selected 
• Flatfield – unselected 
• Color Enhancement – selected 
 
More Image Settings: 
• Image Flip – as needed 
• Rotate 90°°°° – as needed 
• Minimum Exposure – unselected 
• Live Image Maximum – default (10 sec) 
• Noise Filter – selected 
 
The suggested settings are designed to give you 
quality image captures in most, but not all cases.   If 
your work involves fluorescence techniques, for 
example, you will need to adjust the Image Type, 
brightness, gamma and Quality/Speed settings 
accordingly.  For more details on selecting Image 
Settings, refer to Ch. 2 – Preparing to Take a Picture 
(see – Profile). 
 

6. Click on the Get Image toolbar button. 
The Get Image dialog box displays the status of the 
capture as it is downloaded to your screen. 

 
 Because Get Image uses the values from the live 
image view, the image capture skips the initial 
exposure computation sequence. 
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Introduction 
The following sections are an introduction to the SPOT Vision’s operating environment.  They include: 

• The Viewing and Editing Window - The primary window for all image capture and editing functions. 
• Opening and Saving Files - Standard file save and open features, as well as those that are unique to 

SPOT. 
• Setup - Initial settings to customize your software. 

The Viewing and Editing Window 
When you open or capture an image, it appears in the main viewing and editing window. All of the image 
save, view, edit, and annotation functions are accessed from this window, which consists of three areas: 

• The Menu Bar 
• The Toolbar  
• The Status  Bar  

The Menu Bar 
The Menu Bar varies according to whether an image is open. 

If you have not yet either captured a new 
image or opened an existing image, the 
following menus are available: 

File 
Camera  
Setup  
Help 

If you have either captured a new image or 
opened an existing image, the following 
menus are available: 

File 
Edit 
View 

Camera 
Setup 

Window 
Help 
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• The File menu contains file open and save options, which for the most part, are identical to the 
standard file open and save options. Refer to Opening and Saving Files (below) for details.  In 
addition, the File menu contains the report creation and viewing options.  Refer to the Ch. 5 - 
Reporting section of this chapter for more details.  

• The Camera menu contains initialization, image capture, white balance, flatfield correction, and live 
imaging options. 

• The View menu contains different options for viewing captured images.  Refer to Ch. 4  - Viewing, 
Editing, and Annotating Images (below) for details. 

• The Setup menu contains options used to define operating preferences.  Refer to Setup (below) for 
details. 

• The Edit menu contains image editing options. 

• The Window menu contains standard Windows display options. Refer to Ch. 4 - Viewing, Editing, and 
Annotating Images (below) for details. 

• The Help menu contains information about the SPOT software and enables you to access the on-line 
help system. 

The Toolbar 
The Toolbar appears underneath the Menu Bar and contains all of the image capture, editing, and 
annotation functions.  The following diagram illustrates the Toolbar, as it appears for an open image: 

 
 

 

 

Figure 3- 1: SPOT Toolbar 

The Status Bar 
The status bar at the bottom of your screen displays information about the on- screen image.  The following 
is an illustration of the status bar, as it appears for an open image:   

 
 

 

 

Figure 3- 2: Status Bar 
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Each of the above call-outs is described in the following list: 

• Image size – (Columns, rows) in pixels [e.g., (243, 257)].  

• Pixel bit depth (bits per pixel) - The pixel bit depth at which the image was captured.  This value 
reflects the pixel bit depth for the image setup that was used to capture the image.  All captured images 
are 24 bpp.   

• X Y pixel coordinates - As you move your cursor over an image, the status bar displays the x y 
coordinates of the cursor in pixels.   

• Brightness values - As you move your cursor over an image, the view status bar indicates the 
brightness values of the pixel coordinates.  The status bar displays separate red, green, and blue 
brightness values for each part of the image [e.g., RGB: (255, 34, 194)]. 

• Size Settings - In the illustration above, the view status bar displays Fit to Win (Fit to Window), the 
default image capture setting. 
− If the Fit to Window option has been deselected, this area displays the word Normal. 
− If you are in zoom mode, this area displays the magnification level percentage – e.g., 100 %,  

300 %, etc….  
• Modified Status - The section to the right of the size settings remains blank until you modify an 

image.  Once an image has been modified from the original status, the word Modified appears here. 

Opening and Saving Files 
All of the file open and save options are accessed from the File menu.  These options are described below.  

# Note: Standard Windows functions are not described in detail in this manual.  For more detail on 
these functions, refer to the Windows on-line help.  

 

Open Image 
File 

Open image files of a specified format (i.e., JPEG, TIFF, BMP, etc.).  In addition to using this menu 
option, you can open images by dragging an image file from the Windows 95/98/NT/2000 Explorer 
onto the SPOT program window.  

Show 
Image File 

Thumbnails 

Display thumbnail previews of specified files and open images from the preview screen. To show file 
thumbnails, follow these steps: 
1. From the File menu, select the Show Image File Thumbnails option.  The Thumbnail File Spec 

window displays all of the image files in the directory. 
2. Navigate to the directory for the image files that you want to display. 
3. Use the Files of type drop down box, to specify the file type. 
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Show Image File 
Thumbnails 

(cont.) 

4. Select the file or files for which you want to display thumbnails.  If you do not select a file 
or files, the program displays thumbnails for all files of the specified type in the directory.   

5. Click on Open.  The Thumbnails preview window appears.  For each thumbnail, you can: 
− Double-click (Mac and Windows) on a thumbnail to open an image for viewing or 

modification. 
− Right-click (Windows)/[ [$] Click (Mac) on a thumbnail to display a list of options. 

The right-click menu enables you to perform a variety of actions directly from the 
thumbnail window: 
♦ Select Image.  
♦ Open Image. 
♦ Delete Image. 
♦ Print Image. 
♦ Move/Rename Image File 
♦ Copy Image 
♦ Add Image to Image Sequence (see below) 
♦ Add Image to Report (see below) 
♦ Select All Images in the thumbnail view.  When you use this option, the right-

click menu expands to include the above options for multiple images 

Click and drag with the mouse to select two or more images. 

Open Image 
Sequence 

File 

Open an image sequence file.  An image sequence file is a single TIFF format file that 
contains multiple images.   

• Refer to Ch. 3 - Taking a Picture (see – Get Sequential Images) for information on 
capturing an image sequence file. 

• Refer to the Ch. 4 -  Viewing, Editing, and Annotating Images (see – Working with 
Image Sequences)  for information on viewing and editing image sequences. 

New Image 
Sequence 

Create a new image sequence file.  This option enables you to specify the first image in a 
new image sequence.  This image can come from an open image or an image on disk (from 
file). Subsequent images can be added to the sequence in one of two ways: 

• Via the Add Image to Image Sequence File menu option (see below).  This option 
allows you either to add an open, non-sequence image to a sequence or to create a new 
image sequence from the image.   

• Via the Sequence menu options.  Here you can add any image to any point in a 
sequence.  Refer to Working With Image Sequences in Ch. 4 for more details. 

New Report Create a new report.  Refer to the Creating Reports section of this chapter for more details. 

Open Report Open a report.  Refer to the Creating Reports section of this chapter for more details. 

Reload Reload the image from the hard drive (or other media).  All changes made since opening the 
image file are lost.  This option appears only when a saved image is open. 

Save Save a previously unsaved image to new file, or update the changes to an existing file.  This 
option appears only when an image is open. 

Save As Save an image to a new file and/or file location.  This option appears only when an image is 
open. 

Save All Save all open image files.  The program prompts you for the name and file location of each 
image. 

Close Close an image.  The program prompts you to specify a location to save the file.  This option 
appears only when an image is open.  

Move/Rename Move and/or rename an image file.  This option differs from the Save As option in that it does 
not retain a copy of the original file in the original location: using Move/Rename is comparable 
to cutting and pasting a file. 

Delete Delete an open image.  The program prompts you to verify the deletion. 
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Export Movie File 
(Windows) 

Export a SPOT image sequence file to AVI format.  Follow these steps: 

1. Open a SPOT image sequence.  Refer to Ch. 7 – Taking a Picture, for details on 
capturing image sequences. 

2. Select File>Export Movie File.  The Export Movie File appears. 

3. Enter the File Name for the avi file. 

4. Specify the location where you want to save the avi file. 

5. Specify which images in the sequence that you want to Export.  Select either: 

• All Images – the avi file will contain all of the images in the sequence. 

• Specified Images  - the avi file will contain only the images that you specify (i.e., 
below the radio button). 

6. Specify the Frame Rate in frames per second.    

7. Specify the Compression Settings.  When you click on the Compression Settings 
button, the Video Compression dialog displays the compression application(s) 
available on your computer.  Because each computer will have different installed 
applications, the Video Compression options will vary. 

8. After you have entered all of the desired settings, click on Save.  The program displays a 
status message as it exports the file.     

Add Image to 
Image Sequence 

Add an open, non-sequence image to an open image sequence, or create a new image 
sequence from an open image.  To use this option, the non-sequence image must be the 
active window and the image sequence must be open in the background.    

When you click on Add Image to Image Sequence, SPOT prompts you to specify either the 
Image Sequence or a new image sequence.  If more than one image sequence is open, 
select the sequence from the drop-down list. 

Add Image to 
Report  

Add a selected open image to an open SPOT report.  When you select this option, SPOT 
prompts you to select from a list of reports.  If you have not defined a report, SPOT 
automatically creates a new report for you and inserts the image as a Static Image object.  
Refer to the Creating Reports section of this chapter for more details. 

Print Print an open image.  Refer to Chapter 6 – Printing Images for information on standard 
Windows and SPOT custom printing features. 

Printer Setup Define the page setup parameters. Refer to Ch. 6 – Printing Images for information on 
SPOT’s custom printing features. 

Exit (Windows) 
Quit (Mac) 

Exit the SPOT program. 

Setup 
The Setup menu options are as follows: 

• Show Image Settings 
• Calibration Setup 
• Preferences 

Show Image Settings 
Use this option to display the Image Settings window. The Image Settings window is used to define the 
settings for both the live image view and the final image capture.  This means that you can use the Image 
Settings window in one of two ways:  
• As a stand-alone dialog to pre-define the settings that the SPOT camera uses for capture images. 
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• In conjunction with the Live Image window.  When using the Image Settings dialog to define the live 
image view, the live image settings also serve as the image capture settings.  In other words, the live 
image view can be used as a guide to how the final image will appear. 

Refer to Ch. 2 - Preparing to Take a Picture (see – Profile) for a description of the options on the Image 
Settings window. 

Calibration Setups 
With the SPOT program, you can use a stage micrometer to calibrate each  objective on your microscope.  
Once calibrated, you can use the SPOT program to perform basic measurements on an image.  Refer to Ch. 
4, Viewing, Editing, and Annotating Images for more information on using the measurement functions. 
 
To calibrate an objective, follow these steps: 

1. Place the stage micrometer under the objective. 
2. Adjust the microscope to display as much of the stage micrometer as possible.  You can use the Live 

Image option, as described in Ch. 2 – Taking a Picture (see Viewing a Live Image), to help position 
the micrometer 

3. Focus on it.  Use the Live Image option. 

4. Capture an image of the stage micrometer.  Refer to Ch. 3 – Taking a Picture for details.  

5. From the Setup menu, select Calibration Setups.  The Calibration Setups 
window appears (see right).   

6. Click on Add.  The Calibration Setup window appears.  

7. Enter the name of the calibration setup.  
Typically this corresponds to the 
magnification of the objective (e.g., 4x). 

8. Using the mouse, draw the calibration 
line along the length of the stage 
micrometer image. When you draw the 
line, keep these guidelines in mind:  

− Keep the line as straight as possible.  
− Make the line as long as possible. 
− Use the largest unit of measurement that the micrometer allows for. 

To draw the line, follow these steps: 

a. Position the crosshair cursor over the stage micrometer mark that represents the start point of your 
calibration line.  In the illustration below, this is the 20 mm mark. 

b. Left click on the mouse. 

c. Position the crosshair cursor at the stage micrometer mark that represents the end point of your 
calibration line.  In the illustration below, this is 
the 23 mm mark. 

d. Left click on the mouse again.  The length of 
the line in pixels appears on the Calibration 
Setup window.  To re-draw a line, double click 
anywhere on the image.  This clears the 
previously drawn calibration line from the 
screen. 
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9. Enter the length and units of the line that you drew (e.g., 3 mm). 
10. Click on OK.  The 4x objective is now calibrated to perform measurements.  Repeat steps one through 

ten for each objective. 

Image Auto-Save (Windows) 
Use the Image Auto-Save feature to automatically save images 
as part of the capture process.   To enable SPOT’s  auto-save 
feature, select Setup>Image Auto-Save, and check the Auto-
Save Images box, as shown at right.   You can then specify the 
auto-save options, as described in the table below. 

 

 

 

File Name Prefix This prefix appears before the number of each 
image capture in the sequence.  To enter the 
File Name Prefix, you can:  

• Type only the name (e.g., Cell) in the box.   
The program automatically saves the 
image to the last used directory.  If you 
specify the prefix only, you cannot see 
exactly where the files are being saved.  
Thus, to avoid having to search for your 
files, you should verify the location of the 
last save. 

 • Type the full path and file name (e.g., C:\Spotcam\T-cells) in the box to specify the location of 
the image.  When entering the file path and name, you can also specify a new directory simply 
by entering it in the path (e.g., C:\Spotcam\Cells\T-Cells). 

• Click on the browse button to select a new file location and file name (prefix).  All of the image 
files are saved with the prefix that you enter.  Thus, if your Suffix Begin Number (see below) is 
one, the file name for the image would be T-Cells0001. 

Format Select the file format for the sequence of images.   

• For individual files, there are six options: Windows Bitmap,  JPEG, Mac PICT, TIFF 
Uncompressed TIFF JPEG, or JPEG2000. 

• For image sequences there are two options: TIFF Uncompressed or TIFF JPEG. 

Suffix Begin 
Number 

 

Select the beginning number for image auto-save.   
The Begin Number automatically defaults to the first number that follows the previous sequence of 
images.  So, if you captured a sequence of 10 images, 11 would appear as the Begin Number when 
you next opened the Get Sequential Images window. 

The program prefaces numbers with enough zeros to create a four character suffix.  For example, if 
you have 35 images, the first image suffix will be 0001 and the last image suffix will be 0035.  This 
enables Windows to correctly order images, so that Growth_Sequence0002 appears before 
Growth_Sequence1000, and not the other way around. 

JPEG Quality  
(1-100) 

JPEG quality is the level of compression for JPEG images: this option is available only when JPEG 
or TIFF JPEG is selected as the image file format.  Enter an integer between 1 and 100 to set the 
JPEG quality for images.  A value of one is the most compressed (and lowest image quality), while 
a value of 100 is the least compressed (and highest image quality). 

Compression 
(JPEG2000) 

When the JPEG2000 file format is selected, the Image Auto-Save Setup dialog displays 
compression options: 

• Lossless – Information is not lost when the image is compressed. 

• Lossy – Information is lost according to the ratio that you enter: the higher the ratio that you 
enter, the smaller the file size and the lower the quality of the image. 
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File Name 
Conflict Action 

 

Determine how the program will respond if it finds an image file with the same name as an image 
from the current session.  Select one of the following options: 
• Overwrite Existing File – The program overwrites the existing file with the new image capture. 

• Display Warning – The program displays a warning message indicating that a file of the same 
name already exists, and stops the image capture. 

Image Display 
 

Determine how image captures will be displayed.  Select one of the following options: 

• Display Each Image in a New Window – The program opens a window for each new image 
capture.  This option works well if you plan to capture a limited number of images in the 
session.  If you plan to capture many images, however, displaying numerous windows uses up 
memory and could interfere with use of other programs. 

• Display Only Current Image – The program sequentially displays each image in the same 
window.  Each image displays only until the next image is captured.  This is useful when you 
have numerous captures where you do not want to be concerned with running out of memory. 

• Don’t Display Images – The program automatically saves all of the image files to the specified 
location without displaying them. 

Preferences 
Use the Preferences option to specify:  
• Sequential imaging memory settings  

• Specify thumbnail appearance. 

• Live image viewing settings 

• Fit to window view settings 

• File type extension setting (Macs only). 

To open the Preferences window, select Preferences from the Setup menu.  Each preference is discussed 
below. 

Image Sequences Memory Usage Limit 
Specify how much memory is allocated for image acquisition.  Note that the entry 
parameters are system dependent. 

Cache Images During Play 

When “playing” an image sequence (see Ch. 8), the SPOT program allows you to select 
how it loads the displayed images: 

• If Cache Images During Play is selected…  The program pre-loads as many 
images from the sequence as your computer’s RAM allows.  This enables a faster 
display of the image sequence.  But, if you have a sequence with many images, the 
size of the combined images could exceed the RAM, and in this case, the SPOT 
program will load as much of the sequence as possible, play that part of the 
sequence, and then pause to load the remaining images. 

• If Cache Images During Play is not selected…  The program loads each image in 
the sequence individually.  In cases where you have a large sequence with many 
files, this allows you to work without being restricted by RAM limitations.  The display 
of images will be somewhat slower than a display where images are cached 

 

Save Thumbnails Save thumbnails of each image capture.  This option is available only when JPEG, TIFF JPEG, or 
TIFF Uncompressed  is selected as the image file format.   
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Thumbnail Button 
Size 

Specify the size of thumbnails for the Show Image File Thumbnails option 

Select from one of the following options: 
• Small (60 x 60 pixels) 
• Medium (90 x 90 pixels) 
• Large (120 x 120 pixels) 
• User Defined  

Minimum width and height   =  20 pixels 
Maximum width and height  =  200 pixels   

Maximum Thumbnail 
Resolution 

Specify the resolution of image thumbnails (Show Image File Thumbnails option) 

Select from one of the following options: 
• Small (54 pixels) 
• Medium (84 pixels) 
• Large (114 pixels) 
• User Defined  

Minimum resolution   =  20 pixels 
Maximum resolution  =  200 pixels 

Always Show Full 
Chip in Live Image 

Always Show Full Chip in Live Image ensures that  you will always see the Full Chip 
view when viewing a live image.  Keep in mind that the selection that you make here 
determines how the live image displays when viewing a region of the chip.  Refer to the 
Chip Imaging Area section for more details.  

Open Images in Fit to 
Window Mode 

 

Specify whether images should open in Fit to Window mode. 
The Fit to Window option, a program default, automatically sizes images to fit the 
available screen space when you open or capture an image.  Thus, you can immediately 
see the entire image without having to zoom out.  This is especially useful with smaller 
monitors.  Open Images in Fit to Window Mode is checked as a default.   If you do not 
want images to open in the Fit to Window mode, deselect the box. 

Add Extensions to 
File Names on Save 

(Mac) 

When selected, the Add Extensions to File Names on Save option automatically 
appends the file type extension (e.g., JPG, tif, bmp, etc…) to your image file.  This 
enables cross platform file sharing, because Windows based programs require a file type 
extension, while Mac based programs do not.  Once the file type extension is added, 
Windows based programs can recognize the Mac file.     
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Introduction  
The Image Settings dialog is the central point for defining both live image 
and image capture settings.  The Image Settings window enables you to 
optimize the live image view, and then capture an image using these 
settings.  To open the Image Settings dialog, either click on the Image 
Settings toolbar button, or select Show Image Settings from the Setup 
menu.  Each image capture/live image view option is discussed in the 
sections below. 

Profile 
The Profile option allows you to create and re-use sets of live image/image 
capture settings.  When you make changes to any of the live image/image 
capture settings, these changes can be saved to a Profile – either the Default 
or one that you have defined.  For example, if you gamma adjust a live 
image and then decide that the result is ideal for the type of specimen you 
are working with, you could create a new Profile with the gamma and 
exposure values and name it for that type of specimen – i.e., “Diseased 
Cells.”   
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When you close the SPOT Camera window, the program prompts you to save changes.  Carefully 
consider the effect of your choice:     

• Clicking Yes modifies the Profile according to the adjustments that you made.  Future image captures 
taken with that Profile will reflect these changes.  For example, if you rotated a live image, and then 
clicked Yes after closing the window, all future captures taken with that Profile would be rotated in the 
same way. 

• Clicking No retains the original values of the Profile.  This allows you to maintain a unique set of 
image view and capture settings that can be re-applied to future captures of similar specimens.   

To add, edit, or delete Profiles, right-click on the Profile box.  Right clicking gives the following options:  

• Add – Add a new Profile.  When you add a new Profile, the program prompts you to name it. 
• Save – Save a Profile that you have modified. 
• Rename – Rename an existing Profile. 
• Delete – Delete a Profile.  This option appears only if there is more than one Profile.   

Exposure: Auto or Manual 
The Exposure option gives you the choice of having the camera calculate exposure time (Auto), or setting 
the exposure on your own (Manual).   The exposure options will vary according to whether you select 
Auto or Manual, as illustrated below. 

When you enter one of the above exposure settings, note that it applies both to the live image that you are 
viewing and the captured image.  

Understanding Gain and Auto-Gain Limit 
Normally an auto exposure routine in a digital camera sets the exposure time so that the brightest pixel on 
the CCD chip is completely “filled” with electrons, or is “full well”.  This simple technique works well for 
bright images, but, as an image gets dimmer, exposure times can get uncomfortably long.  With the SPOT 
camera you can shorten exposure times by filling the brightest pixel on the CCD chip to less than full well, 
and then using this lower level as full scale.  The inverse fraction of full well that the brightest pixel on the 
CCD is filled to is known as the gain. For example, filling a pixel to half of full well cuts the exposure time 
in half.  Since the exposure time is cut in half, we call this a gain of 2. 

The following table illustrates the relationship between gain, the fraction of full well that the brightest pixel 
is filled to, and the effect of gain on exposure time: 

Gain  Fraction of Full Well Exposure Time (sample) 

1 1 80 seconds 

2 ½ 40 seconds 

4 ¼ 20 seconds 

8 1/8 10 seconds 

16 1/16 5 seconds 

An 80 second exposure at a gain of one turns into a 5 second exposure at gain 16.  This is good in terms of 
the exposure time.  Unfortunately, background noise is directly proportional to gain.  It is 16 times higher at 
a gain of 16 is than at a gain of one.   

Auto-Gain Limit (see the Quality/Speed section below) allows you to set an upper limit on the gain 
options that will be available during the Auto-Exposure process.  
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# Note:  If you are using Manual exposure, you can set an exact gain for an image capture. 

For example, with an Auto-Gain Limit of 16 the camera can “choose” from the full range of gain options.  
However, if you find that gains of 8 or 16 are too noisy for your images, you can prevent the camera from 
selecting these options by setting the Auto-Gain Limit to four.  When the Auto-Gain Limit option is set to 
four, the camera is limited to the lower three gain options: 1, 2, or 4.  

Higher gain levels for dim images significantly reduce exposure time.  For each doubling of gain number, 
exposure time is halved.  Thus, an image with an exposure time of 5 minutes at full scale (a gain of 1) 
would take only 1.25 minutes at a gain of 4.  Unfortunately, background noise increases proportionally to 
the gain.  Thus, the shortened exposure time would result in an image with four times the amount of 
background noise.  The following table illustrates the relationship between gain, exposure time, and 
background noise: 

Auto-Gain 
Limit 

Possible Auto – Gain 
Settings 

Exposure Time 
(dim images) 

Background Noise 
(dim images) 

1 1 Longest Lowest 

2 1, 2 $ % 

4 1, 2, 4 $ % 

8 1, 2, 4, 8 $ % 

16 1, 2, 4, 8, 16 Shortest Highest 

Auto Exposure options 

Image Type 
An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 
available Image Types (see below) corresponds to a microscopy technique: select the Image Type that 
matches the technique you are using.  The camera will capture the image accordingly. The table below 
describes typical situations for each image type. 

Image Type Description 

Brightfield-transmitted light Stained specimens on glass slides using transmitted light microscopes. 

Darkfield-transmitted light Bright specimens on dark backgrounds using transmitted light darkfield technique. 

Fluorescence Fluorescence specimens not fluorescing in a single red, green, or blue primary color  

Nomarksi DIC/Hoffman Specimens being viewed with either Nomarski DIC or Hoffman techniques. 

Phase contrast Specimens being viewed using the phase contrast technique. 

Polarized light Specimens being viewed with polarized light techniques. 

Brightfield-reflected light Polished metallurgical specimens and semi-conductors using a microscope with a 
vertical illuminator. 

Darkfield-reflected light Bright areas of specimens being viewed with darkfield, reflected light techniques. 

Stereo/macro–no glints Matte specimens without bright glints. 

Stereo/macro–shiny glints Shiny specimens with bright glints. 

Stereo/macro-metallic glints Metallic specimens with intense glints. 
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Brightness 
Enter a Brightness value between .24 and 34.   
A brightness value of 1, the default value, gives you the correct image brightness for most images.  The 
Brightness control allows you to overexpose or underexpose (darken or lighten) the image area.  In many 
cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or 
darken the image.  When using the Brightness control, the SPOT camera uses an algorithm that combines 
gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode: 
• When overexposing images to make them brighter (i.e., entering values greater than one), the camera 

first selects the highest possible gain before lengthening the exposure time.  Because gain also 
brightens an image, less exposure time is needed. 

• When underexposing images to make them darker (i.e., entering values less then one) the camera uses 
the lowest possible exposure time before lowering the gain. 

Quality/Speed (Auto) 
Use the slider to balance speed and quality when previewing dim images.  
• Moving the slider toward the Quality side increases image quality and decreases frame rates. 
• Moving the slider toward the Speed side increases frame rates and decreases image quality. 

The Quality/Speed measurement corresponds to the Auto-Gain limit setting  which allows you to set an 
upper limit on the gain options that will be available during the Auto-Exposure process.   

• When the slider is at the left-most point, the Auto-Gain Limit is  1, which restricts the camera to a gain 
of 1, giving you higher quality pictures, but lengthier exposure times.   

• When the slider is at the right-most point, the Auto-Gain Limit is 32, which allows the camera to select 
from the all six gain options.  This shortens exposure times, but decreases image quality. 

Refer to the “Understanding Gain and Auto-Gain Limit ” section above for more details on gain and 
exposure.  

Gamma 
Enter a Gamma value between .1 and 4.    
Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or 
lightening black areas.  This is especially useful for capturing/editing images with a wide range of 
brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., 
printed circuitry).  

• Values between 1 and 4 lighten the darker areas of the image. 
• Values between .1 and 1 darken the mid-tones of the image. 
Gamma adjustments on live images are made in the RGB color space, the only color space where 
adjustments can be made quickly enough to keep up with live imaging.  Refer to Ch. 2 – Preparing to Take 
a Picture for more details on gamma adjustment. 
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Manual Exposure Options 

Exposure Time 
Use the slider-bar to specify an exposure time between .04 ms and 526.746 sec.  
When you specify an exposure time, the camera skips the automated exposure sequence that takes place 
when you open the live image view.  This is very useful in cases where exposure times are lengthy, as with 
fluorescence samples. 

Gain 
Enter the precise gain that the camera will use for an image capture.  Use the slider-bar to select one of the 
six gain options: 1, 2, 4, 8, 16, or 32.  The gain value displays to the right of the slider-bar.  Refer to the 
“Understanding Gain and Auto-Gain Limit ” section above for more details on gain and exposure.  

Gamma 
The manual Gamma adjustment is identical to the auto Gamma adjustment (see above.) 

Chip Imaging Area 
SPOT allows you to use any rectangular portion of the CCD chip for image capture.  Using a portion of the 
chip is helpful in cases where you want to: 

• Keep file sizes small. 
• Shorten download times. 
• Avoid areas of the image with optical problems (e.g., vignetting).   
There are three image area options: 
• Full Chip – Capture the entire area of the CCD chip.   

• Center – Capture a rectangular part of the CCD chip’s area that has the same height - to - width ratio 
as the full chip, and is centered on the center of the full chip.  The percentage that you enter is the 
percentage of full chip width that the new area’s width will be. 

To capture a centered proportion of an image, follow these steps: 
a) Check the Center option. 
b) Enter the percentage of the image that you want to capture.  The minimum percentage is 10 and 

the maximum is 100. 
c) Capture the image. 

• Selection –Capture a specific part of the CCD chip.   
a) Check the Selection option. 
b) Close the Image Settings window and open the Live Image dialog (click on the Live toolbar 

button). 
c) Use the mouse to select a region for capture.  Click and drag to define the selection.   
d) Capture the image.  
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When you are viewing a live image Selection, how this selection is displayed, depends on whether the 
Open Images in Fit to Window Mode and Always Show Full Chip in Live Image preferences (see the 
Preferences section above) are checked.  The following table illustrates the possibilities: 

Fit to Window 
Checked? 

Always Show Full Chip  
in Live Image Checked? 

 
Selection Display 

 Live or  
Captured Image 

YES YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle. 

LIVE 

YES NO When you select a portion of the chip the cursor 
is a zoom tool.   To zoom in on a portion of a 
live or captured image, click and drag over the 
area that you want to zoom in on.   To return to 
the non-zoomed image, click on the Full Chip 
option.  

BOTH 

NO YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle.  
However, because Fit to Window is not 
checked, you will not see the entire chip in the 
window. 

LIVE 

NO NO When you select a portion of the image, the 
cursor is a cropping tool.  If you select a portion 
of an image, the program displays only the 
selected area and discards the rest of the image. 
To return to the non-cropped image, click on the 
Full Chip option. 

BOTH 

Live Image Auto-Brightness 
Available only when you are using Auto exposure and viewing a live image, the Live Image Auto-
Brightness option enables you to maintain a consistent brightness level for changing specimens.      

Flatfield 
For all other SPOT camera lines, the Flatfield option is used to correct for display problems associated with 
uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the optical system.  
Flatfield can still be used for this purpose with SPOT Vision cameras.   But, because SPOT Vision cameras 
use a color mosaic chip, Flatfield correction serves a new primary purpose.  In the production process for 
color mosaic CCD chips, the RGB colors are applied directly to the pixels on the chip.  This process often 
results in an uneven color density around the outer 30-40 rows of the CCD chip, causing a “halo” 
appearance in some image captures, particularly those with low contrast. The Flatfield option can be used 
to correct this  problem.   

# Note:  Flatfield correction with the SPOT camera refers only to the correction of uneven 
lighting.  It should not be confused with the correction of optical field flatness. 

Flatfield correction works by taking a picture of the brightfield background without the specimen in the 
field of view.  This image lets the SPOT software know, on a pixel-by pixel basis, which areas in the field 
of view are receiving less illumination than the brightest areas. When taking a picture that contains a 
specimen, the software uses this information to accurately increase the brightness of each pixel in the dimly 
illuminated areas.  The resulting image gives the appearance of an even illumination. 
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The Flatfield correction process involves two images - the flatfield image and the final image.  To use 
Flatfield Correct, follow these steps:   
1. Ensure that the specimen is under the desired objective and in 

focus.  

2. From the Camera menu, select Get Flatfield Image.  The Get 
Flatfield dialog box appears. 

3. Remove the slide from the field of view. 

4. Click on Begin.  When the program finishes computing the exposure times and acquiring the flatfield 
file, the program prompts you to name and save the file. 

5. Name the Flatfield file.  Because flatfield image files are different for 
each objective, you might want to name the file according to the 
objective's magnification (e.g., 10x). 

6. Click on OK.  If you do not specify a directory path, the program 
automatically saves the flatfield file: 
− In Windows, the file is saved to the c:\SpotCam\Fltflds directory 
− In the Mac OS, the file is saved to System Folder>Preferences>SPOT 3.x Prefs>Flatfields. 
 

# Note:  The  default file location varies, depending on where you installed the SPOT program. 

7. Move the specimen back into the field of view. 

8. Click on the Live toolbar button. 

9. Open the Image Settings window, and select the Flatfield box.  The name of the flatfield file that you 
defined in step four should appear in the drop-down list of flatfield files. 

10. Perform the image capture.  SPOT automatically uses the flatfield image to correct the capture. 

Refer to the Taking a Picture section of this chapter for more details. 

Color Enhancement (Captured Images) 
The Color Enhancement option optimizes image captures by closely matching the final capture to the 
image as seen through the microscope.  To optimize the final image, the SPOT program processes the raw 
image data to produce a final image that matches the view seen through the microscope.  

If you want an image capture to match the live image view, you will want to leave Color Enhancement off.  
Color Enhancement applies only to captured images. 

More (Additional Orientation and Exposure Settings) 
When you click on More, the 
program displays a dialog of 
additional orientation and 
exposure settings, as shown at 
right.   
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   16.6 ms per cycle

8.3 ms
per cycle

SPOT Power Line
Frequency (60 Hz)

Fluorescent Light
Output Frequency

Exposure < 8.3 ms

Minimum Exposure > 10 ms

Figure 3- 1: Setting a Minimum Exposure to 
Accommodate Varied Light Sources 

Flip 
Specify whether images will be flipped during the image capture/live image viewing process.  

• Select Horizontal to flip the image from left to right. 
• Select Vertical to flip the image from top to bottom. 
• Select both options to flip the image from left to right and from top to bottom. 

Rotate 90° 
Specify whether images will be rotated during the image capture/live image viewing process. 

• Select None if you do not want the image to be rotated.  
• Select Right to rotate the image clockwise 90 degrees. 
• Select Left to rotate the image counterclockwise 90 degrees.     

Exposure Limits - 
Minimum 
Because SPOT Vision 
cameras are capable of 
extremely short exposure 
times, light sources with 
intensities that vary with the 
waveform of the 60 Hz line 
supply (e.g., fluorescent 
lamps, 120 volt incandescent 
bulbs, and 6 volt 20 watt 
halogen lamps) can cause the 
Live Image window to flicker 
and result in incorrect 
brightness and color balance 
readings in captured images. 
The Minimum Exposure 
option allows you to correct 
for these problems by limiting the 
camera to a minimum exposure time 
that is greater than the pulse interval 
of the light source.  Consider the 
illustration to the right. In this case, 
the pulse interval of the fluorescent light source is 8.3 ms.  Entering a Minimum Exposure of 10 ms ensures 
that the camera’s exposure time is greater than the pulse interval of the light source.  To enter a minimum 
exposure, check the Minimum Exposure box, and enter a value in milliseconds.   
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Exposure Limits – Live Image Maximum 
The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing a live 
image.  Consider the following situation: When you change from a lower resolution objective to a higher 
resolution objective, the camera detects a brief interval of blackness.  When the Auto-Brightness option 
(see above) is enabled, it compensates by modifying the exposure time to maintain a constant brightness 
level.  This results in you having to wait for the camera to compute a lengthy and incorrect exposure for the 
black interval.  Using the Live Image Maximum option, you can limit this exposure time. For most cases, 
Diagnostic Instruments recommends a value of 0.5 seconds.  Similarly, the Live Image Maximum option 
can also be used in cases where the microscope’s light path selector is incorrectly set.     

Noise Filter 
The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with 
lengthy exposure times, the noise filter acts as a “virtual cooler” for the Vision camera, eliminating “hot 
pixels.”   

The Noise Filter checks each pixel on the CCD chip as described below: 

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels. 

2. If none of the eight neighboring red pixels has a value within ±15 %  (i.e., the threshold value that the 
SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being 
checked is replaced with the average value of the eight neighboring red pixels. 

3. The program repeats this procedure for the values of the green and blue pixels being checked.  

To activate the Noise Filter, check the Noise Filter box.  The program runs the noise filter each time an 
image is captured.   
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Taking a Picture 
The actual capture of a digital image (taking the picture) is similar to traditional photographic techniques.  
In digital photography, however, it is possible to continually capture, refine, and recapture images until you 
have an optimal representation: the first image that you capture might be only one of several that you use to 
produce a publishable product.  A sample image capture process, from start to finish might proceed as 
follows: 

1. Adjust the Preferences as needed (see above). 

2. Open the Live Image window. 

3. Frame and focus the image as needed. 

4. Click on the Image Settings toolbar button to access the Image Settings window and adjust the live 
image view settings. 

5. Click on the Get Image toolbar button to capture the final image. 

Image captures and live image view settings are defined from the same source - the Image Settings 
window. This gives you the convenience of being able to view a live image, adjust the settings in real-time, 
and then capture the image with the live image view settings. 

# Note: Except for the Captured Image Bit Depth, which is defined on the Preferences window, all 
image capture/live image settings are defined from the Image Settings window. 

Initialize Camera 
If you turned on the SPOT power supply after you opened the program, you need to initialize the camera in 
order to activate all of the capture and editing options.  To do so, select the Initialize option from the 
Camera menu. 
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Viewing a Live Image 
The Live Image option enables you to see a real time 
preview of your specimen/image capture. For instance, 
you can use the Live Image window to: 

• Scan the image for an area of interest. 

• Zoom in on an area of interest. 

• Focus on an area of interest. 

• Frame an area of interest. 

• Define image capture settings – see Ch. 2 -
Preparing to Take a Picture for more details 

# Note: With some video cards, you might experience system crashes or display problems when 
working with live images.  To correct these problems, lower the Graphics Acceleration setting in 
Windows, as described in the Video Card Related Problems section of the Installation Guidelines 
chapter. 

To open the Live Image window, either click on the Live Image toolbar button, or select the Live Image 
option from the Camera menu.   

# Note: Occasionally, when viewing a dim live image, you might notice that the right half of the 
image is brighter or dimmer than the left half.  To display images in real time,  the camera uses 
two separate amplifiers to simultaneously read the right and left halves of the CCD chip.  With 
some images, particularly dimmer samples, the brightness of the two halves may not match.  This 
results in a “split” appearance.   To avoid this problem with captured images, the camera reads 
the whole CCD through a single amplifier.  A “split” Live Image view is not indicative of what 
your image capture will look like.   Refer to Appendix A: Electronic Imaging Theory and SPOT 
Cameras for more details.  

• The title bar at the top of the Live Image window displays the status of the live image view -  
Running, Computing Exposure, or Paused.   Double-click on the title bar to “roll up” the live image 
display. This pauses the live image display.  Double-click again to display the whole window and 
resume the live image display. 

• When the Fit to Window option is checked, the live image window  cursor becomes a zoom tool.  To 
zoom in on a portion of a live image, click and drag over the area that you want to zoom in on.   To 
return to the non-zoomed image, click on the Reset Area button on the bottom of the window.  

• When the Fit to Window option is not checked, the cursor is a cropping tool.  If you select a portion 
of an image, the program displays only the selected area and discards the rest of the image. To return 
to the non-cropped image, click on the Reset Area button on the bottom of the window. 

# Note: Due to a flaw in the Windows operating system, monitors that are set to higher resolutions 
cannot zoom to very high magnification levels.  If zoomed in to a high magnification, the monitor 
displays white instead of the zoomed image. 

• The Full Screen option (accessed via the View menu or [F 7]) can be used with live images.  This 
option allows you to use the entire screen to view a live image, without the SPOT menus/toolbar and 
the Windows navigation bar.   
− To access live image viewing options in the full screen view, right click on the live image.   
− To exit the full screen view, either press [F 7], or move the cursor to the top of the screen and click 

on the Exit Full Screen Mode button that appears.  
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• There are six view/exposure options at the bottom of the Live Image window: 

Restart Resample the brightness of the image, compute new exposure times, and restart the live image 
display.  This is useful for updating exposure times when specimen brightness has changed. 

Pause/Resume Freeze the live image window.  This is useful when you are changing a specimen and want to 
preserve the last view.  In addition, to use the Transfer option (see below), you must first Pause 
the live image view.  Click on Resume to restart  the live image view 

Close Close the Live Image window. 

Fit to Window Size images to automatically fit the resizable display window. 

Reset Area Return to the non-zoomed view of the live image. 

Faster Readout Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases 
where you are willing to sacrifice some resolution for a higher frame rate. 

Computing White Balance Values (Vision Color) 
White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for 
an image.  Many factors impact the coloration of an image capture, including lamp voltage, the coloration 
of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s 
objectives.  To minimize the impact of these factors, use the Compute White Balance feature.   When you 
perform a white balance calculation, SPOT samples the color of the light from your light source after it has 
passed through the slide and the objective, and then calculates the red, green, and blue gains needed to 
produce images where the white areas are white and the color areas are true.   

You should perform a new white balance calculation when: 

• Starting a new image capture session. 
• Changing the lamp voltage. 
• Switching to a different objective on the microscope.  

To compute new white balance values, follow these steps: 
1. Set the illumination and the objective that you will use for the image capture. 

2. If you have not done so, select your Image Type (see above).  Each Image Type has its own set of 
white balance values.  Any white balance values that you compute for an image type remain linked to 
that image type until you compute new values.  When selecting a new image type, remember that you 
will be using the white balance values linked to that image type. 

3. Click on the White Balance button. 

4. Show the camera a sample of white light.  This step varies according to microscopy technique and 
Image Type (sample), as shown in the table below: 

Image Type White Balance Technique 

Brightfield-
transmitted light 

Position the slide so that the specimen is not in the field of view, but light is going through the slide 
near the specimen. 

Darkfield-
transmitted light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield –
transmitted light above. 

Fluorescence Use the Match Color feature (see above) 

Nomarksi 
DIC/Hoffman 

For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the 
“gray scale” view. 

For Hoffman: Perform the white balance directly on the Hoffman image. 
Phase contrast Position the slide so that the specimen is not in the field of view, but light is going through the slide 

near the specimen. 



Taking a Picture Ch. 3 - Taking a Picture  

46 User Guide to the SPOT Vision Camera   

Polarized light Pull all polarizers and compensators out of the light path and then position the slide so that the 
specimen is not in the field of view, but light is going through the slide near the specimen.  

Brightfield-
reflected light 

Replace your sample with a mirror. 

Darkfield-
reflected light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield – 
reflected light above. 

Stereo (all three 
options) 

Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace 
your sample with a white sheet of paper. 

Click on Begin to start the calculation.  The camera computes the white balance values, and they are 
automatically saved to the image settings for the image type that you selected.  

Capturing the Final Image 
Get Image captures an image according to the Image Settings that you defined  
(see previous sections).  To capture an image, either click on the Get Image button,  
or press [F 9]. 

The Get Image status dialog box appears. Status messages display as the camera computes the gain and 
exposure times.  If the live image window is open, the image capture uses the gain and exposure times 
calculated for the live image and skips the exposure computation (step 1 below).  The status messages are 
as follows:  

1. Computing Exposure – The camera is sampling brightness levels in the image in order to determine 
proper gain and exposure time.   

2. Getting Image – The camera is downloading the image to the computer. 

3. Shutter open 0:07 – A countdown clock displays when the exposure will last longer than 2 seconds.  
This informs the user that the electronic shutter is open and counts down the minutes:seconds 
remaining until it closes. 

4. Processing – The camera is preparing to display the image. 

The newly captured image appears on screen. 
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Capturing a Sequence of Images (Get Sequential 
Images) 
The Get Sequential Images option allows you to capture a sequence of images.  SPOT’s sequential image 
capture process enables you to save an image sequence in two different ways:  

• You can save a sequence as a group of individual image files. 
• You can save a sequence as a single (TIF format), “sequence image file” that is composed of multiple 

images.  Refer to Ch. 4 – Viewing, Editing, and Annotating Images for details on viewing and 
modifying image sequence files. 

The available file name and save options on the Get Sequential Images window vary according to whether 
you save the sequential images individually or as a sequence, as shown on the following page: 

 
Save and name options – individual files Save and name options – image sequence 

 

To use the Get Sequential Images option, follow these steps:   

1. Select the image setup that you want to use for the sequential image captures.  Either define a new 
image setup, or select an existing setup from the drop down list on the status bar (bottom right corner). 

2. From the Camera menu, select the Get Sequential Images option.  The Get Sequential Images window 
appears.  The table on the following page explains each option. 
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Number/Timing Options 

Number of 
Images 

Enter the number of images in the sequence of captures.  This number can be set up to 2,000. 

Time Interval Enter the time interval between the start of one image capture to the start of the next image capture in 
hours, minutes, and seconds. 

Compute 
Exposure 

Before 

Select either First Image or Each Image: 

• First Image – The program computes the exposure value for the first capture only. 

• Each Image - The program computes a new exposure value for each image capture in the 
sequence. 

Storage Options 

Store Images Select either Individually or  In an Image Sequence 

• Individually –  Store each image as a separate file. 

• In an Image Sequence – Store all images in a single TIF format file.    

The available save and name options depend on your selection here. 

Save and Name Options  

Save Images 
to Disk 

The Save Images to Disk box is checked as a default for the Get Sequential Images window. 

• If you do not want to save the sequential images/image sequence to file, deselect the box.  
Deselecting the box makes the remaining save and display options unavailable.  You can define 
the process/display option (Don’t Process or Display Images until Done), and then click on 
Begin to start the sequence. 

• If you want to save the sequential images/image sequence, leave the box selected, and enter the 
remaining file save and display options, as described below.  

The file name of each image (individual images only) in the sequence is made up of two components:   
− A File Name Prefix that you designate. 

− An automatically indexed Suffix Number that starts with the Suffix Begin Number that you designate. 
File Name 

Prefix 
(individual 

images)  
File Name  

(image 
sequences) 

This prefix appears before the number of each image capture in the sequence.  To enter the File 
Name Prefix/File Name, you can:  

• Type only the name (e.g., Growth Sequence) in the box.   The program automatically saves the 
image sequence to the last used directory.  If you specify the prefix only, you cannot see exactly 
where the files are being saved.  Thus, to avoid having to search for your files, you should verify 
the location of the last save. 

• Type the full path and file name (e.g., C:\Spotcam\Growth_Sequence) in the box to specify the 
location of the image sequence.  When entering the file path and name, you can also specify a 
new directory simply by entering it in the path (e.g., C:\Spotcam\Flowers\Growth_Sequence). 

• Click on the browse button to select a new file location and file name (prefix).  All of the image 
files are saved with the prefix that you enter.  Thus, if your Suffix Begin Number (see below) is 
one, the file name for the first image in the sequence would be Growth_Sequence0001. 
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Save and Name Options (cont.) 

Format Select the file format for the sequence of images.   

• For individual files, there are five options: Windows Bitmap,  JPEG, Mac PICT, TIFF 
Uncompressed or TIFF JPEG. 

• For image sequences there are two options: TIFF Uncompressed or TIFF JPEG. 

Suffix Begin Number 
(individual images) 

Select the beginning number for the sequence of images.   
The Begin Number automatically defaults to the first number that follows the previous 
sequence of images.  So, if you captured a sequence of 10 images, 11 would appear as the 
Begin Number when you next opened the Get Sequential Images window. 

The program prefaces numbers with enough zeros to create a four character suffix.  For 
example, if you have 35 images, the first image suffix will be 0001 and the last image suffix 
will be 0035.  This enables Windows to correctly order images, so that 
Growth_Sequence0002 appears before Growth_Sequence1000, and not the other way 
around. 

JPEG Quality  
(1-100) 

JPEG quality is the level of compression for JPEG images: this option is available only when 
JPEG or TIFF JPEG (for image sequences) is selected as the image file format.  Enter an 
integer between 1 and 100 to set the JPEG quality for images.  A value of one is the most 
compressed (and lowest image quality), while a value of 100 is the least compressed (and 
highest image quality). 

Compression 
(JPEG2000) 

When the JPEG2000 file format is selected, the Get Sequential Images dialog displays 
compression options: 

• Lossless – Information is not lost when the image is compressed. 

• Lossy – Information is lost according to the ratio that you enter: the higher the ratio that 
you enter, the smaller the file size and the lower the quality of the image. 

Save Thumbnails Save thumbnails of each image in the sequence.  This option is available only when JPEG 
or TIFF JPEG is selected as the image file format.   

File Name Conflict 
Action 

(individual images) 

Determine how the program will respond if it finds an image file with the same name as an 
image in the current sequence.  Select one of the following options: 
• Overwrite Existing File – The program overwrites the existing file with the image from 

the sequence you are capturing. 

• Display Warning – The program displays a warning message indicating that a file of 
the same name already exists, and stops the sequential image capture. 

Image Display 
(individual images) 

Determine how the sequence of images will be displayed.  Select one of the following 
options: 

• Display Each Image in a New Window – The program opens a window for each 
image in the sequence.  This option works well if you have a short sequence; if you 
have a long sequence, however, displaying numerous images uses up memory and 
could interfere with your use of other programs. 

• Display Only Current Image – The program sequentially displays each image in the 
same window.  Each image displays only until the next image is captured.  This is 
useful for lengthy sequences where you do not want to be concerned with running out 
of memory. 

• Don’t Display Images – The program automatically saves all of the sequential image 
files to the specified location without displaying them. 

Display Images 
(image sequences) 

Select this box to open an image sequence immediately after the capture.  To save the 
image sequence to file without opening it, deselect the box. 

Defer Image 
Processing/Display  

until Done 

Wait until the entire sequence is completed before displaying or saving the images. 

After you have entered all of the options, click on Begin to start the image capture sequence.   Refer to  
Ch. 4 – Viewing, Editing, and Annotating Images for details on viewing and modifying image sequence 
files
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Introduction 
After capturing an image, you can choose from a variety of viewing, editing, and annotation options that 
allow you to customize the appearance of the final image.  These features are described in the following 
sections:  

• Viewing Captured Images 
• Working with Image Sequences 
• Editing Captured Images 

# Note:  These menus are available only when an image is on-screen. 

Viewing Captured Images 
All of the image viewing options are accessible from two menus: 
• View – Contains options specifically designed for viewing microscopic specimens 
• Window – Contains standard Windows options that enable you to work with and view multiple 

images. 

# Note:  The Window menu options include Cascade, Arrange Horizontally, Arrange Vertically, 
Arrange Icons, and Close All.  For descriptions of these features, refer to the standard 
Windows help.   

To help you view and analyze your image captures, the View menu contains five options – Fit to Window, 
Zoom In/Out, Zoom Level, Show Grid Lines, Show Pan Window, Image Date/Time, and Full Screen. 

# Note:  The Show Grid Lines option is  available only when you zoom in on an image.   

Fit to Window 
Fit to Window allows you to view the whole image, regardless of the window size.  Typically, reducing the 
size of a window also cuts off part of the image.  The Fit to Window option solves this problem by resizing 
the image so that it is always the same size as the window.   

Zoom In/Out 
1. Either select Zoom In/Out From the View menu, or click on the Zoom toolbar button: 

2. The cursor changes to a magnifying glass, and the Zoom toolbar button becomes 
active.  The precise reference point for the zoom location is indicated by the white dot in the center of 
the magnifying glass.  The row and column numbers at the bottom of the screen indicate the exact 
position of the white dot as you move the magnifying glass over the image. 

3. Use the mouse to zoom in or zoom out: 
a) Position the mouse over the center of the area that you want to zoom in on. 

b) Either left click to zoom in 2x, or right click to zoom out 2x. 

c) To return to the normal view mode, de-select the Zoom option. 

The Zoom feature works in conjunction with the pan window (see Show Pan Window below), which 
allows you to see where you are in relation to the larger image while zoomed in. 
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# Note: All of the standard save, view, and edit options, with three  exceptions – Add Calibration 
Mark, Add Measurement, and Annotate – can be used while the program is in zoom mode.  If you 
need to annotate a zoomed image, use the Zoom Level option (see below). 

 

# Note: With some video cards, you might experience display problems when zooming in on captured 
images.  To correct these problems, lower the Graphics Acceleration setting in Windows, as 
described in the Video Card Related Problems section of the Installation Guidelines chapter. 

Zoom Level 
The Zoom Level option, like the Zoom In/Out option enables you to view zoomed images.  However, 
unlike the Zoom In/Out option, you have the option to add annotations, including text, calibration marks, 
and measurements, to the zoomed image.  To use the Zoom Level option , select Zoom Level from the 
View menu and select a percentage option from the list.   

Like the Zoom In/Out option, the The Zoom Level option can be used in conjunction with the pan window 
(see Show Pan Window below), which allows you to see where you are in relation to the larger image 
while zoomed in. 

# Note: With some video cards, you might experience display problems when zooming in on captured 
images.  To correct these problems, lower the Graphics Acceleration setting in Windows, as 
described in the Video Card Related Problems section of the Installation Guidelines chapter. 

Show Grid Lines 
Show Grid Lines clearly defines pixel borders, which are often invisible in low contrast areas of an image.  
Clearly defined borders help in positioning the cursor at an exact row and column location (i.e., using the 
readouts at the bottom of the screen), which then allows you to view the brightness value for the individual 
pixel. 

To show the grid lines on an image, follow these steps: 

1. Position the magnifying glass in the center of the area that you want to zoom in on. 
2. Zoom to either 8x or 16x.  If you are using the Zoom Level option,  select a percentage of 800 or 

greater.  
3. From the View menu, select the Show Grid Lines option.  Grid lines appear around each pixel. 

Show Pan Window 
Show Pan Window enables you to navigate around an image while zoomed in at high magnifications.  
When you select the Show Pan Window option, the program highlights your location in relation to the 
whole image, and, by dragging the highlighted area around the pan window, you can explore the image, 
piece by piece.  Without the Show Pan Window option, the process of moving to a new point while in high 
magnification would involve several steps: 

1. Zooming in to the first area of interest. 
2. Zooming out to determine where you are. 
3. Determining a new area of interest. 
4. Re-zooming in to the new area of interest. 

This tedious process is replaced by the pan window.  When you select Show Pan Window, a smaller 
version of the image appears with a color negative over the zoomed area of the image.   
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To use the pan window, follow these steps: 

1. Either select Show Pan Window from the View menu, 
or click on the Show Pan Window toolbar button.  

The pan window appears, superimposed upon the image. 

2. Position the cursor on the image in the pan window: it changes 
from a magnifying glass to a four arrow pointer.   

3. To move to a different area of the image, either left click on the rectangle and drag it to the new 
location, or left click on the new location. 

Image Date/Time 
The Image Date/Time feature pulls up the date and time associated with the capture of an image. When you 
capture an image, the SPOT software remembers the date and time of the image capture.  When you save 
the image, even if this is many hours later, the program sets the Created date and time of the image file to 
the date and time of the original image capture.   

When image files are transferred over networks, the Created date and time is sometimes reset to the date 
and time of the transfer, making it an unreliable indicator of the image capture time.  Because TIFF and 
JPEG format images have tags both for the Created date and the original capture date and time, they are not 
affected by network transfers.  If reliable image capture date and time information is important to your 
work, you should save images in either TIFF or JPEG format. 

When you select the Image Date/Time option from the View menu, a dialog box displays the date and time 
associated with the capture. 
• For non-TIFF, non-JPEG format image files, this is the Created date/time, as explained above.   

• For TIFF and JPEG format image files, this is the TIFF/JPEG  tag date and time.   

• For SPOT Database images (PCs only) this is the original date and time that was stored in the database 
file. 

Full Screen  
View a full screen version of an image – i.e., without the SPOT menus or toolbars or the Windows 
navigation bar.  This option allows you to utilize the entire window for previewing images.  Press [F 7] to 
view a full screen image or click on the Full Screen toolbar button.  Press [F 7] again to exit the full screen 
view.  Alternatively, you can exit the full screen view by moving the cursor to the top of the window and 
clicking on the Exit Full Screen Mode button that appears.   

While working in Full Screen mode, Windows users can access SPOT menu options using standard 
keystroke combinations, as  illustrated in the table below: 

[Alt] + A   = Attributes (Report mode) [Alt] + O = Object (Report mode) 

[Alt] + C = Camera [Alt] + Q = Sequence 

[Alt] + E = Edit [Alt] + S = Setup 

[Alt] + F = File [Alt] + V = View 

[Alt] + H = Help [Alt] + W = Window 

# Note:  The pan window can be opened at any 
level of magnification. 
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Working with Image Sequences 
There are three places from which you can edit and play image sequence files: 

• The Sequence menu – Rearrange the order of a sequence, add and/or remove images to and from the 
sequence, extract images from the sequence, and play the sequence. 

• The Sequence Controls (Image Sequence) dialog – Set view options and play the sequence. 

• The Edit menu - Modify/enhance image sequences using the options on SPOT’s Edit menu.  Refer to 
Editing Images in a Sequence (below) for more information.  

Refer to the sections below for details.  

Sequence Menu Options 
Image sequences are editable.  The Sequence menu, which is available only when an image sequence is 
open, displays the available options.  They are as follows: 

Extract Images 

 

Extract an image or images from a sequence file.  Extracting creates new 
image(s), leaving the original sequence intact.  Click on Extract Images 
and enter the number(s) of the image(s) that you want to extract.  To 
extract multiple images from a sequence, separate numbers with commas 
and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9. 

Insert Image 

 

Add an image to the sequence.  Using Insert Image, you can add an 
image to a sequence from one of three sources: 
• Currently Open Document – Add an image from the currently open 

sequence file.  Make sure to specify the Sequence Index – i.e., the 
number of the image in the sequence.   

• File – Add an image from disk.  If the image comes from a sequence 
file, make sure to specify the Sequence Index. 

When you click on OK, a dialog prompts you to specify the point in the 
sequence where you want to insert the image.   

Append Image 

 

Add an image to the end of the sequence.  Using Append Image, you can 
add an image to a sequence from one of three sources: 
• Currently Open Document – Add an image from the currently open 

sequence file.  Make sure to specify the Sequence Index – i.e., the 
number of the image in the sequence.   

• File – Add an image from disk.  If the image comes from a sequence 
file, make sure to specify the Sequence Index. 
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Go to the first
image in the

sequence

Step Backward

Stop
Play Backward

Play Forward

Step Forward

Go to the last
image in the

sequence

Remove Images 

 

Remove an image or images from a sequence file.  Removing an image 
deletes the image from the sequence, which is automatically reordered.  
Click on Remove Images and enter the number of the image(s) that you 
want to extract.  To extract multiple images from a sequence, separate 
numbers with commas and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9. 

Move Image 

 

Move an image or image(s) to a different point in the sequence.    Click 
on Move Image and enter the number(s) of the image(s) that you want to 
move.  To move multiple images from a sequence, separate numbers 
with commas and/or dashes - i.e., 5, 6, 7 or 5-7 or 1 – 5, 6, 9.   

Play Forward Continuously play the image sequence forward. 
Play Reverse Continuously play the image sequence backward. 
Stop Play/Resume Play Stop play if the sequence is running; resume play when it is stopped. 
Step Forward Move forward one image. 
Step Reverse Move backward one image. 

Image Sequence Controls 
The Sequence Controls (Image Sequence)  
dialog enables you to play image sequences  
and to set the play options.   

Image Index 
Use the Image Index options to specify the view 
parameters of the sequence. 
• First - Enter the number of the image that should be 

first in the sequence. 
• Current – This field displays the number of the image 

you are currently viewing.   Enter a new number to 
view a different image. 

• Last – Enter the number of the image that should be 
last in the sequence 

 

Play Options 
Use the Play Options to control how the image sequence displays when playing. 
• Interval – The time interval between each image when the sequence is playing.  Enter a number in 

milliseconds or seconds.   

• At End – The action that takes place when the sequence finishes playing. 
− Stop:   The sequence stops at the last image in the sequence. 
− Restart:   The sequence begins playing from the beginning. 
− Reverse: The sequence reverses play when it reaches the end. 
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Editing Images in a Sequence 
Images from a sequential image file can be edited using the Edit 
menu options.  This allows you to specify the individual image or 
images (including the entire sequence) to which the edits are applied.   
• In some cases – e.g., Combine Images – the dialog prompts you 

to specify the Sequence Index – i.e., the number of the image 
within the sequence. 

• In other cases, as with the Adjust RGB options, SPOT prompts you 
to specify whether the edit applies only to the current image in the 
sequence, all of the images in the sequence, or a specific subset of 
images in the sequence.  For example, when editing an image 
sequence, if you select Edit >Adjust RGB > Adjust Brightness 
(additive), the Additive Brightness Adjust dialog appears.  After 
you make your edits and click on OK, the Edit Images window 
prompts you to specify the image or images that the edit will apply 
to, as shown at right.   
− No Other Images – The edit applies only to the current image – i.e., the on-screen image. 
− All Other Images in Sequence – The edit applies to all of the images in the sequence. 
− Specified Images – The edit applies to the images that you specify.  Enter the number(s) of the 

image(s) in the box at the bottom of the dialog.  To specify multiple images, separate numbers 
with commas and/or dashes - e.g., 5, 6, 7; or 5-7; or 1 – 5, 6, 9. 

Edit 
All of the editing options are accessed via the Edit menu.  There are five editing categories: 

• Basic editing 
• Image position 
• Image quality 
• Calibration and Measurement 
• Annotation 
• Memos 

The options associated with each category are described below.   
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Basic Editing 
The Edit menu contains several functions that are common to most operating systems. 

Undo Undo the last edit that you made.  The Undo option only allows for one level of edits: in 
other words, you can only undo the immediately preceding edit.  To Undo an action, 
select Undo from the Edit menu. 

Cut (Mac) Cut text fields within the SPOT program. 

Copy to Clipboard 
(PC)/Copy (Mac) 

 

Copy all or part of an image onto the clipboard for insertion into another program.  These 
options are identical to the Windows [Ctrl C] command and the Mac [$ C] command. 

1. Press and hold the left mouse button (PC)/mouse button (Mac). 
2. Drag the cursor over the image until the dotted rectangle covers the area of the 

image that you want to copy.  If you copy without  "cutting out" a specific portion of 
the image, SPOT selects the entire image. 

3. Either select the Copy to Clipboard/Copy option from the Edit menu, or press 
 [Ctrl C] (PC)/[$ C] (Mac).  The image is now ready to be pasted into another 
application. 

4. Open the application that you want to paste the image into, and select from the 
available pasting options. 

Paste (Mac) Paste text fields in the SPOT program.  The Paste field is grayed when editing images. 

Clear (Mac) Clear a text field in the SPOT program. The Clear field is grayed when editing images. 

Select All (Mac) Select an image for copying into another application.  

Image Position 
From the Edit menu, you can: 
• Re-position images 
• Match the on-screen orientation of a specimen to the microscopic view 
• Crop an image to better reflect the area of interest 

Rotate Right Rotate an image clockwise in 90 degree increments. 

Rotate Left Rotate an image counter-clockwise in 90 degree increments. 

Flip Horizontal Flip an image from right to left 

Flip Vertical Flip an image from top to bottom. 

 



Ch. 4 – Viewing, Editing, and Annotating Images Edit 

User Guide to the SPOT Vision Camera 59 

Crop Cut out a portion of an image.  To crop an image, follow these steps: 
1. Press and hold the left mouse button. 
2. Drag the cursor over the image until the dotted rectangle covers the area of the image that 

you want to crop.   

3. From the Edit menu, select Crop.  The Crop Area window displays the pixel coordinates of 
the rectangle that you selected. 

  
From this window you can fine tune the crop area by modifying the pixel coordinates.   If 
you select the Crop option directly from the menu (i.e., without specifying a crop area), the 
Crop Area window displays the values for the entire image. 

4. Click on OK to crop the image.  The cropped image appears on-screen. 

5. When you crop an unsaved image, the program automatically discards the area of the 
image outside the crop.  To give yourself the opportunity to change the crop area, you 
should save the image before you crop it. 

Image Quality (Adjust Image) 
The Adjust Image options allow you to correct 
images that are overly bright or dark, or to 
modify areas of interest that are too light or 
too dark to see important details.   To access 
these editing options, select Adjust Image  
from the Edit menu. The Adjust Image 
window appears, as shown at right. Adjust 
images either by entering a value in the box or 
by moving the slider bar.   

The Adjust Image window provides three 
adjustment parameters: 
• Color Space – This option enables you to 

select the color space that is best suited to the type of image that you are editing: 

− RGB (Red Green Blue) – Use for monochrome images 

− HSL (Hue Saturation Luminance) – Use for all color images except fluorescence 

− HSV (Hue Saturation Value) – Use for fluorescence images 

• Modify Main Image -  When this box is checked (the default), both the thumbnail image and the main 
image change as you are adjusting the image.  If you want the main image to change after you have 
made the adjustments – and thereby speed the editing process - deselect the Modify Main Image box.   

• Reset – Click on the Reset button to return the image to its pre-adjustment appearance. 

The following sections describe the effect of each of the four adjustments. 
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Dark Level 

 

The Dark Level adjustment lightens or darkens an entire image by adding the value that you specify 
to all of the pixels in the image.  

To adjust Dark Level, enter a number between  -100 and 100. 
• Numbers between zero and –100 darken the image. 
• Numbers between zero and 100 lighten the image. 

Brightness The Brightness adjustment lightens or darkens the bright areas in an image.  For example, if you 
used the Dark Level adjustment to modify an image, but the new bright areas are either too dark or 
too light to see the details, you can you use the Brightness feature to correct this.  Because the 
Brightness adjustment is multiplicative (as opposed to the Dark Level adjustment which is additive), 
it multiplies the pixel values in the image by the value that you specify.   A multiplicative process 
affects bright areas more than dark areas.  Before adjustment an image’s Brightness value is 
always one. 

To adjust Brightness, enter a number between 0 and 5. 

• Numbers between zero and one darken the image. 
• Numbers between one and five lighten the image. 

Gamma 

 

The Gamma adjustment lightens the darker (mid-tone) areas of an image without burning out bright 
areas or lightening black areas.  This is useful when modifying images with a wide dynamic range, 
(i.e., the range of brightness values recorded by the CCD chip.  Before adjustment, the Gamma 
value is always one. 

To adjust Gamma, enter a number between .1 and 4. 

• Numbers above one lighten the mid-tone areas in the image. 
• Numbers below one darken the mid-tone areas in the image. 

Contrast 

 

The Contrast adjustment exaggerates or subdues the difference between the bright and dark areas 
in an image.  Before adjustment, the Contrast value is always one. 

To adjust Contrast, enter a number between 0 and 5. 

• Numbers above one exaggerate the contrast between bright and dark areas. 
• Numbers below one subdue the contrast between bright and dark areas. 

Match Color 
The Match Color feature is typically used in two situations: 
• You want to change the colors of an image on the screen to match the way that you think the specimen 

looks. 
• You want to set the white balance for pictures taken with a microscopic technique that never has white 

in its images.  A prime example of this situation is fluorescence microscopy.  

To use the Match Color feature, follow these steps: 
1. From the Edit menu, select Match Color.  The cursor becomes an eye-dropper.   

2. Use the mouse to move the eye-dropper to the pixel location of the color that you want to match.  
Refer to the status bar at the bottom of 
the window to ensure that each of the 
R, G, and B values are less than 255. 

3. Click on the pixel.   The Match Color 
window appears.  

# Note: The Set White 
Balance button appears 
only for image captures 
that have not yet been 
saved and closed. 
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The window displays information about the pixel that you selected: 
− Hue – The actual color, as distinguished from others in the color spectrum.  Hue is derived 

from a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees). 

− Saturation - The proportion of perceived pure hue in the color.  Saturation (in the SPOT 
software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 
equals pure hue (e.g., “day glow”). 

− Original Color – A sample “swatch” of the color that you selected.  The cross hairs on the 
color wheel (e.g., in the center of the window) indicate the relative position of the selected 
color. 

− The Modify Main Image box is checked as a default. 

4. Set the new color.  This can be done in one of two ways, depending on whether the image should 
contain white: 
− If you are trying to make the selected pixel in your image appear as white (or gray if the 

pixel is darker), click on the Make White/Gray button. 
− If you are working with an image that does not have any white, modify the Hue and 

Saturation values so that the New Color “swatch” shows up as the color that you want.  You 
can do this either by entering specific Hue and Saturation values, or dragging the cross-hairs 
on the color wheel to the desired location. 

Annotation – Calibration and Measurement 
The Add Calibration Mark and Add Measurement options enable you to add calibration and measurement 
references to SPOT images. 

Add Calibration Mark 
The Add Calibration Mark feature allows you to insert a 
calibration mark into an image capture.  To add a 
calibration mark, follow these steps: 
1. If you have not already calibrated the objectives on 

your microscope, do so.  Refer to Ch. 1 – Navigating 
the Program for details. 

2. From the Edit menu, select Add Calibration Mark.  
The Calibration Mark window appears.  

3. Select a Calibration Setup (e.g., 15x) for the 
objective that you are using. 

4. Move the cursor to the point in the image where you 
want to insert the calibration mark and click at that 
point.  The calibration mark appears with the default 
appearance settings.  

5. Using the on-screen mark as a reference, modify the Appearance options: 

# Note: If you are not satisfied with the 
placement of the calibration mark, you can 
click on and drag the mark to a new position.  
Clicking on and dragging the bar moves both 
the bar and the number.  Clicking on and 
dragging the number moves only the number. 
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a) Orientation – Check the appropriate box to select either a horizontal or vertical display for the 
calibration mark. 

b) Line Thickness – Select a line thickness between 1 (thinnest) and 5 (thickest).   

c) Show Text – Check this option to display the calibration number in the mark.  If this option is 
deselected, the calibration mark is simply a line. 

d) Decimals – Select the number of decimals that appear in the calibration mark number.  Choose 
from a range of zero decimals (1)  to five decimals (1.00000) 

e) Color – Click on the Color button to define the color of the calibration mark.  You can either 
choose from a palette of basic colors or define a custom color to provide the best display. 

f) Font – Define the font, point size, and appearance. 

6. Enter the size of the calibration mark.  You can modify the size either by entering the number in the 
Size box, or by using the cursor to stretch the on-screen calibration bar.  To adjust the size of the 
calibration mark, move the cursor to the end of the calibration bar line.  The standard cursor changes to 
a two-headed arrow.  Drag the end of the bar to adjust the length.  The calibration mark number 
changes to reflect the new length. 

7. Click on Stamp to incorporate the calibration mark into the image. 

Add Measurement 
The Add Measurement option enables you to incorporate measurements into an image capture, including 
line, area, and angle measurements.  

To add a measurement, follow these steps: 

1. If you have not already calibrated the objectives on your microscope, 
do so.  Refer to Ch. 1 – Navigating the Program for details. 

2. From the Edit menu, select Add Measurement.  The Measurement 
window appears. 

3. From the Calibration Setup drop-down list, select the setup 
(e.g.,15x) for the objective that you are using. 

4. Select the type of measurement that you want.   
− Straight Line Length – Point to point distance measurement 
− Curve Length– Length of a freehand line 
− Rectangle Perimeter – Perimeter length of a rectangle 
− Ellipse Perimeter – Perimeter length of an ellipse 
− Region Area -  Area of a freehand outline 
− Rectangle Area – Area of a rectangle 
− Ellipse Area – Area of an ellipse 
− Angle – Angle measurement 

5. Move the cross-hair cursor to the point in the image capture where 
you want to begin the measurement. 
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6. Single click to activate the drawing function.  Do not hold the mouse button down between the 
measurement points. 

− For a Straight Line Length, move the cross-hair cursor to the end point of the measurement.  
Single click to deactivate the drawing function and display the length of the line. 

− For a Curve Length, use the cross-hair cursor to trace a freehand line on an image. Single click to 
deactivate the drawing function and display the length of the freehand line.  

− For an Angle, use the cross-hair cursor to specify the three points that define the angle.  Single 
click to mark the end point of the first side.  Move the cross-hairs to the vertex, and single click 
again.  Move the cross-hairs to the end point of the second side, and single click.  This last click 
deactivates the drawing function and displays the angle measurement. 

− For the area and perimeter type measurements, use the cross-hair cursor to trace an outline 
around the area that you want to measure.  Single click to deactivate the drawing function and 
display the measurement. If the area is not completely enclosed by the outline (for the Region 
Area option), the SPOT program automatically completes the path by connecting the end point to 
the starting point with a straight line. 

When you complete a measurement, the drawing function is deactivated, and the cursor changes back 
to a standard arrow.  At this point you can: 

− Re-position the measurement number.  When you position the cursor over the number, it changes 
to a four point arrow.  Click and drag on the number to move it to a new location. 

− Erase the last measurement.  Double-click anywhere on the image to erase the previous 
measurement. The cross-hair cursor re-appears for you to draw another measurement 

After you have completed steps one through six, you can modify the measurement as needed, using the 
Appearance options: 
− Line Thickness – Select a line thickness between 1 (thinnest) and 5 (thickest).   

− Decimals – Select the number of decimals that appear in the measurement.  Choose from a range 
of zero decimals (1)  to five decimals (1.00000) 

− Color – Click on the Color button to define the color of the measurement.  You can either choose 
from a palette of basic colors or define a custom color to provide the best display.  If you are 
editing a monochrome image, you can select either black or white. 

− Font – Define the font, point size, and appearance. 

7. Click on Stamp to incorporate the measurement into the image.  The cross-hair cursor reappears for 
you to add additional measurements to the image. 

Annotation – Custom Image Annotation 
Image annotation is useful when you want to prepare captures for formal presentation, or inclusion in an 
article or reference work.  Using SPOT’s  image annotation features, you can: 

• Add text to an image. 
• Use an arrow, line, rectangle, or ellipse to emphasize a particular area in an image. 
• Add a graphic stamp such as a company logo to an image. 
• Add freehand lines to an image. 

To annotate an image, select Annotation from the Edit menu.  Several changes take place in the SPOT 
image editing environment: 
• The Edit menu options change to reflect annotation editing.   
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• The Object menu appears with options for inserting drawing objects, text, images, and image related 
information onto an image. Cursor functionality in SPOT reports varies according to which Object 
menu option is selected.    
− If None is selected, the cursor is a an editing tool for selecting, sizing, and positioning objects.   

When creating new reports, None is the default option. 
− If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects 

on the grid.  Refer to Adding Annotation Objects to SPOT Images.   
• The View menu changes to reflect annotation mode:  

− The two zoom options and the Show Grid Lines options are no longer displayed.. 

− The Show Tools option is present – this option displays the Tools dialog box, which contains 
shortcuts for inserting annotation drawing objects.   
Refer to Adding Annotation Objects to SPOT Images  

• The Attributes menu appears with options for specifying annotation qualities. 
Refer to Defining Annotation Attributes.  

• The Done! menu (Windows)/Mode menu (Mac) allows you to switch back to the image capture/edit 
mode.   
− Windows – The Done! menu has only one option, End Annotation Mode.  When you select this 

option the SPOTprogram prompts you to merge the changes into the image. 
− Mac – The Mode menu has only one option, Exit Annotation Mode.  When you select this 

option, the SPOT program prompts you to merge the changes into the image. 

CAUTION! 
If you select Yes after clicking on Done! The annotations become a permanent part of the image.  If 
you want to preserve the original image, save the original image to a file.  After annotating it, use 
Save As to save the annotated version to a different file. 

Adding Annotation Objects to SPOT Images 
Annotation objects can be added to images in one of two ways:  
• Through the Object menu. 
• Through the Tools dialog box.  To access the Tools dialog box, 

select the Show Tools option on the View menu.  The Tools 
dialog box, as illustrated at right, displays shortcut buttons 
to the eleven drawing objects on the Object menu:   

Before discussing the individual objects, review the following 
general procedure for inserting an annotation object into an image: 

 

1. From the Object menu, select the type of item (i.e., Lines, 
Connected Lines, etc…) that you want to add to the image. The cursor’s 
functionality varies according to whether a report object type (i.e., line, text) is selected:.   
− If a report object type is selected, the cursor changers to a cross-hair icon that is used to add new 

report objects to the grid.   
− If None is selected, the cursor is a an editing tool that is used to select and position objects.  

2. Use the mouse to drag the cross-hair to the location where you want to insert the object. 

3. Left-click at the insertion point.   

# Note:  In some cases, the procedure varies to fit 
the object’s characteristics.  The specifics are 
noted in the descriptions of the individual objects. 
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− If you selected a line, box, or other shape, hold down the mouse button and drag the object to the 
desired size. 

− If you selected any of the other objects, the object will either appear (e.g., Image Time) or the 
program will prompt you to enter the associated information (e.g., Text, Image Memo,  etc…). 

4. After you have added the object, there are three options: 
− Add another object of the same type, as described in step 3. 
− Add a different type of object  -  select from the Object menu options. 
− Resize, reposition, or edit an object.  To do so, select None from the Object menu. 

♦ Resize - Select (click on) the object and drag the handles in the direction of the resize.   

♦ Reposition – Left click and drag the object the new area. 

♦ Edit – Select the object and choose an option from either the Edit menu or the Attributes 
menu.  You can also edit an object by right clicking on it. 

The following sections describe each of the annotation objects.  

None Select None when you want to use the cursor to edit and position the objects. 

Lines Unconstrained Line - Add a straight line annotation to the image 

Horizontal Line - Add a horizontal line annotation to the image.   

Vertical Line - Add a vertical line annotation to the image. 

Arrow – Add an arrow to the image.  Either select Lines>Arrow from the Object menu, or click on 
the Tools box button.  Left click on the image and drag toward the area that the arrow head will point 
to. 

Connected 
Lines 

Polygon – Add a closed polygon to an image. Either select Polygon from the Object menu,  or click 
on the Tools box button.  Left click and release, and then drag the mouse to create a side.  Left click 
again to start a new side.  Double click to finish the polygon.  The program automatically adds any 
additional lines needed to close the figure. 

Polyline – Add an open polygon to an image.  Either select Polyline from the Object menu,  or click 
on the Tools box button.  Left click and release, and then drag the mouse to create a side.  Left click 
again to start a new side.  Double click to finish the polyline. 

Freehand -  Add a freehand line to the image 

Shapes Rectangular Box – Add a square cornered box to the image.   

Rounded Box - Add a round cornered box to the image. 

Ellipse – Add an elliptical object to the image.  Ellipses are drawn inside of the rectangular area that 
you define.  Ellipses touch the top, bottom, right and left sides of this rectangle.  
 
Either select Ellipse from the Object menu, or click on the Tools box button.  To draw an ellipse, left 
click at the point where you want to position one vertex of the rectangle and drag the cursor to the 
point of the opposite vertex. 
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Images Stamp – Insert a selected bitmap image onto the image capture.  From the Object menu, select 
Stamp.  The last selected bitmap appears on your image.  To select a new bitmap image to insert, 
choose the Stamp Bitmap option from the Attributes menu.    

Image – Add an image. 

1. From the Object menu, select Image.   
2. Left click at the point on the display grid where you want to insert the Image box, and holding 

down the mouse button, drag the cursor to create the desired shape and size for the  image (it 
can also be resized/re-positioned at a later point). When you release the mouse button, the 
Select Image dialog box appears. 

3. Specify the file source for the image: 

− Currently Open Image – Add a currently open image .  If you have one or more open 
images, SPOT lists the file name(s) and path(s) in the drop-down box.  Select from the 
list. 

− Image File – Add an image from disk.  Specify the file name and location either by 
entering the path in the Name box, or clicking on the selection box to the right. 

Click on OK.  The image appears on your report grid. 

Text Text  - Add text to the image.  

1. Either select Text>Text from the Object menu, or click on the Tools box button. 
2. Left click at the point where you want to insert the text.  The Text window appears. 
3. Enter the text. 
4. Click on OK.  The text box appears. 
5. Resize the box as needed to display the text. 

Image Date - Add a date to the image.  This date defaults to the date that the image was captured.   
To change the date, double click on the box, and enter the desired date. 

Image Time  - Add the image capture time to the image.  This time defaults to the time that the 
image was captured. To change the time, double click on the box, and enter a new time. The time 
that appears here varies according to whether the file was transferred across a network.  Refer to 
the Image Date/Time section of this chapter for more details. 

Image Title - Add a title to the image.  The title automatically defaults to the file name and location 
of the open image, e.g., C:\images\cells\fluor1.   To change the title, double click on the box and 
enter a new title. 

Image Memo – Add a previously defined TIFF image memo.  Click at the point where you want to 
insert the text box.  To change the memo, double click on the box and modify the text as needed.  
Changing the text in the memo annotation does not affect a memo that is attached to the image file. 

Image Sequence Index (sequence images) - Add the Sequence Index (number) to the image.  
This is the number of the image within the sequence – i.e., the Sequence Index for the first image in 
the sequence is “1,” the second image “2,” etc… 

Image Sequence Elapsed Time (sequence images) – Add the elapsed time between the image 
being annotated and an image that you specify.  After selecting Object>Text>Image Sequence 
Elapsed Time, the program prompts you to enter the Reference Image Index Number.   If you 
specify a number that comes after the image being annotated, the elapsed time will be negative.  
For instance, if you are annotating image number five in a sequence of 10, and you specify a 
Reference Image… of eight, the elapsed time will be a negative value. 

User Name – Add the user’s name to the image.  This defaults to the user who is logged on the 
computer.  
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Defining Annotation Attributes 
All of the general style and appearance options can be accessed from the Attributes menu.  Annotation 
attributes can be defined for an entire report or on an object by object basis (see the Adding Annotation 
Objects to SPOT Images section above).   

• When an annotation object is selected, the attribute is defined for the selected object(s) only.  In 
addition, when you right click on an object, the menu displays the attribute options for that object. 

• When nothing is selected, the attribute is defined for all future, relevant objects.  

The following table details each of the annotation attributes and the report objects that they affect. 

Line Thickness 

 

Determine line thickness for the following objects: Line, Horizontal Line, Vertical 
Line, Arrow, Box, Rounded Box, Ellipse, Freehand, Polygon, and Polyline. 

1. From the Attributes menu, select Line Thickness. 
2. Enter a Thickness value between 1 and 5 pixels. 
3. Click on OK. 

Colors 

 

 

Define the foreground and background colors for all objects. Follow these steps: 

1. From the Attributes menu, select Colors.  

2. Define the Text/Lines color.  This is the color of the text, the line, or the 
border around a text/image box.  The default foreground color is black.  To 
select a color click on Color.   

3. The next window varies, depending on whether you are using a Windows or a 
Mac system. 
− Windows allows you to select from a palette of colors or enter specific 

HSL or RGB color values. 
− Mac OS allows you to select from a palette of colors, enter specific RGB, 

CMYK, HLS,  or HSV values, and enter Internet specific colors. 

4. Define the Background/Fill color.  This is the color that appears behind text 
and in boxes.  Lines and images do not display a background color. 

# Note: In order to define a background/fill color for a Box or a Rounded Box, a fill must be selected.  Similarly, in 
order to define a background/fill color for a text box, the background (see Text Border, Justification, and 
Background below)  must be set to Opaque. 

Arrow Size and Direction 

 

Specify the size of the arrow head and define the direction that the arrow 
points. 

1. To specify the size of the arrow head, enter a value between 1 and 10. 

2. Specify the direction of the arrow: 
− To draw an arrow starting tail first and finishing with the point 

(head), select Tail to Head. 
− To draw an arrow starting point (head) first and finishing with the 

tail, select Head to Tail. 
3. Click on OK. 

The Arrow Size and Direction attribute is not available for Mac users.  For 
Mac users, arrows are always drawn Tail to Head. 
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Image Border 

 

 

Determine the line thickness for image borders.  This option applies only to 
the Stamp and Image  objects. 

1. Select the object. 
2. To create a border around the image, click on the Border box, and 

enter a Thickness value between 1 and 5 pixels.. 
3. Click on OK. 

Box/Ellipse Fill 

 

Define the appearance of the Box, Rounded Box, and Ellipse objects. 

1. Specify whether you want a fill for the object.   
− If you do not want the box to be filled (i.e., you want a transparent 

box), click on OK.  
− If you want to specify a fill pattern for the box, check the Fill 

Box/Ellipse.  The Pattern options appear. 
2. Specify a pattern by clicking on one of the seven options. 

3. Click on OK.   

Text Font 

 

Define the appearance of the text for the Text, Image Date, Image Time, 
Image Title, Image Memo objects. 

1. Select a Font, a Font Style, and a point Size.  The Sample box 
displays a preview of the font. 

2. Define any Strikeout or Underline effects. 

3. Click on OK. 

 

Text Border, Justification, and 
Background 

 

Define the appearance of the text boxes for the Text, Image Date, Image 
Time, Image Title, Image Memo objects. 
1. Specify whether the text box should have a border.  To add a border, 

click on the Border box, and enter a Thickness value between .05 and 
10. 

2. Define the Justification of the text.  This justification applies to the 
position of the text in the box, not the position of the text on the page. 

3. Define the Background.  Select either Transparent or Opaque. 

4. Click on OK.  

Stamp Image 

 

Use the Stamp Image option to select the image that you want to use for 
the Stamp option.  To select the image, choose Stamp Image.  The Stamp 
Image dialog box prompts you to enter a file name and path: 
• If you know the name and location of the image file, enter it in the File 

box. 
• If you do not know the name and location, of the image, click on the 

browse button to search for the file. 
After you have selected the image file, click on OK. 
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Editing Annotation Objects 
Once you have annotated an image, you can edit the annotation objects as needed.  There are three ways to 
edit objects: 

• Use the Attributes menu - The Attributes menu, as noted in the Defining Annotation Attributes 
section of this chapter, allows you to either set the attributes for adding specific types of objects, or to 
select existing objects and modify them as needed.  Refer to the Defining Annotation Attributes section 
for more details.  

• Use the Edit menu - The Edit menu contains general editing features such as Undo, Copy, Cut, Send 
to Back, etc…  

• Right-click on the report object - Right clicking on a report object brings up a customized editing 
menu that contains both general editing commands and the attributes that can be edited for that object.   

You can also move and size annotation objects: 
• To move an object, left click on it and drag the item to a new location.  When you drag the item, the 

cursor becomes a four pointed arrow. 

• To size an object, left click on it and drag the handles to resize the object as needed. 

The following sections describe the available editing options. 

Undo Undo the last action.  Unlike the image capture/editing Undo feature, the annotation Undo 
undoes up to ten changes.   

Bring to Front Bring the selected annotation in front of all other annotations. 

Move Forward Bring the selected annotation one layer forward. 

Move Backward  Send the selected annotation one layer back. 

Send to Back Send the selected annotation behind all other annotations. 

Cut Remove the selected annotation and place it on the clipboard. 

Copy Copy the selected annotation clipboard. 

Paste Place the cut or copied annotation from the clipboard into the image. 

Clear 
(Mac) 

Delete the selected annotation object(s). 

Select All Select all annotation objects. 

Duplicate Create additional copies of the annotation object.  The program prompts you to enter the 
number of copies.  When you click on OK, the duplicates appear at the top of the window. 

Delete 
(Windows) 

Delete the selected annotation object(s). 

Delete All  Delete all of the annotations on the image. 
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Set Position, 
Alignment, 

and Size 

The Set Position, Alignment, and Size option allows 
you to specify precise sizing and position values for 
single or multiple selected report and annotation objects.   

The Position options enable you to: 

• Align top/bottom edges of multiple objects. 

• Align left/right edges of multiple objects. 

• Align the centers of multiple objects. 

• Center an object(s) on the page. 

• Enter exact pixel values position the object. 

The Size options enable you to enter: 

• Exact width/height in pixels for one or more 
objects. 

• Set the width/height dimension for multiple objects 
the to smallest or largest object’s in pixels. 

 

Duplicate Image 
Click on the Duplicate Image option to create a copy of the active (on-screen) image.       

Memos 
In the SPOT software, you can attach a memo to TIFF or JPEG format image files.   To use the Memo 
option, follow these steps. 
1. From the Edit menu, select Memo.   The Image Memo window appears for you to enter a new memo 

or edit an existing memo. 
2. Enter the message. 
3. Click on OK to attach the memo to the image. 

# Note: If you attach a memo to an image that is not in either TIFF or JPEG format  and then 
attempt to save the memo (i.e., when you close the image file), the SPOT program displays a 
warning message that asks you if you want to save the image without the memo.  If you want to 
retain the memo, click on Cancel and use the Save As option to save the image in either TIFF or 
JPEG format. 
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Introduction 
The SPOT software includes a built-in reporting functionality that can be used collect, organize, and 
present information related to your image captures.  This chapter discusses the process of creating and 
running reports.  It is divided into the following sections: 

• Creating a Report  
• Saving a Report 
• Printing and Distributing Reports  

Creating a Report 
To create a new SPOT report, select New Report from the File menu.  The following changes take place in 
the main window: 

• The report definition window appears as a separate window.  If an image or image(s) were open, they 
remain open. 

• The Object menu appears.  Use these options to specify the fields, text, and images that appear in the 
report. 

• The Attributes menu appears.  Use these options to define the appearance and style of the report. 

• The View menu options change to reflect report definition function.  

• The Edit menu options change to reflect report editing functions.  These options are available only 
after one or more report objects has been added to the New Report window. 

# Note: When you move between an image window and the report definition window, the menu 
options change accordingly. 
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This section is divided as follows: 
• Working in Report Mode– general reporting features and functionality 
• Defining View Options– the view of the report definition screen 
• Defining Report Attributes – the style and appearance of the report 
• Defining Report Objects – the text, field, and image information that appears in the report  
• Editing Report Objects – edit options for the report objects 

Working in Report Mode 
The report mode contains functionality that differs from the image capture and editing functionality.  The 
following is a brief overview of these features. 

Cursor Functionality 
Cursor functionality in SPOT reports varies according to which Object menu option is selected.    

• If None is selected, the cursor is a an editing tool for selecting, sizing, and positioning objects.   When 
creating new reports, None is the default option. 

• If a report object is selected, the cursor changes to a cross-hair icon for placing new report objects to 
the grid.   

Sizing and Positioning Report Objects 
When sizing and positioning a report object in the report window, you must first select the object by single 
clicking on it.  When an object has been selected, handles appear at the corners; for line objects, the handles 
appear at each end.  You can select multiple report objects by holding the mouse button down and dragging 
the cursor around both objects.  Handles appear around both objects.  When selected, report objects can be 
sized or positioned as needed. 

• To size objects, move the cursor either to a point on the object’s border or to one of the handles.  The 
cursor changes to a two pointed arrow 
− To resize one dimension of a box, position the cursor on a vertical or horizontal line; click and 

drag the side to the new size. 
− To proportionally resize a box, position the cursor on a handle; click and drag the box to the new 

size. 
• To position objects, move the cursor over the selected object.  The cursor changes to a four point 

arrow.  Click and drag the object to a new location.  In addition, if an object is selected, you can use 
the arrow keys to fine tune its position.  

# Note: When multiple objects are selected, they can be sized and positioned as a single object. 
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Using Right-click and Double-click Functionality 
When creating a report, you can use the right-
click and double-click  mouse functions as 
editing shortcuts.   

• Double clicking on a report object enables 
you to edit the object’s attributes – e.g., the 
thickness of a line. 

• Right clicking (Windows)/[Ctrl] clicking 
(Mac) on a report object calls an object 
specific edit menu that contains both general 
editing options and attribute editing options 
specific to that object.   Right clicking on an 
Image object, for example, gives you a  list 
of editing options, as shown at right. 

• Right clicking (Windows)\[Ctrl] clicking 
(Mac) on the report grid gives you three 
options: Select All objects,  Paste an object 
that you copied or cut; or Delete All of the 
objects on the grid. 

Refer to the Defining Report Attributes and Editing Report Objects sections for more details. 

Defining View Options 
The View menu provides you with eight options:  

Zoom Zoom in or out to six different sizes. From the View menu, select Zoom and enter the desired 
percentage. 

First Page Go to the first page in the report. 

Previous 
Page 

Go back one page in the report. 

Next Page Go forward one page in the report. 

Last Page Go to the last page in the report. 

 

General
Edits

General
Edits

Object
Specific

Edits
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First Page
Previous Page Next Page

Last Page

Image

Polyline

Text

Ellipse

Arrow
Vertical Line

Polygon

Freehand

Box

Rounded Box

Horizontal Line
object select
mode (None)

Set 
Display 

Grid Size 

The report definition window includes an adjustable grid 
(i.e., the dots on the screen) to assist you in placing and 
aligning report objects on the report page.  By default, the 
grid is turned on.  To turn off or modify the grid, follow 
these steps: 

1. From the View menu, select Set Display Grid Size.   

− To turn off the display grid, deselect the Show 
Grid box. 

− To modify the spacing follow steps two through 
four. 

2. Select either inches or millimeters. 

3. Enter the spacing for the display grid.  The number 
that you enter represents the space in inches or 
millimeters between the dots on the grid. 

− If the measurement is inches, enter a number 
between .04 and 10. 

− If the measurement is in millimeters, enter a 
number between 1 and 25. 

4. Click on OK.  The display grid appears. 

 

Set Object 
Grid Size 

In addition to the display grid, you can define a second grid specific to report objects.  The object 
grid controls the movement of objects as you work with them on the display grid.  When you select 
a report object and move it, the object automatically “snaps” to the nearest line in the object grid, 
allowing you to more precisely align and arrange the objects on your report page.   
1. From the View menu, select Set Object Grid Size.   
2. If desired, check the Snap to Grid option. 

3. Define the spacing for the object grid.  In many cases, the object grid and the display grid will 
have the same spacing.  In other cases, you might not want the display grid to be as finely 
spaced as the object grid (i.e., so the dots do not interfere with the view of the report definition 
window). 

− If the measurement is inches, enter a number between .04 and 10. 
− If the measurement is in millimeters, enter a number between 1 and 25. 

The default spacing value for the Object Grid is the last entered value. 

4. Click on OK.   

Show Tools 

Click on the Show Tools option to display 
a floating palette of navigation buttons and 
report objects, as shown..  Refer to the Defining 
Report Objects section of this chapter for 
more details. 

Defining Report Attributes  
All of the general style and appearance options 
(report attributes) can be accessed from the Attributes 
menu.  Report attributes can be defined for an entire 
report or on an object by object basis (see the 
Defining Report Objects section below).   

• When a report object is selected, the attribute is defined for the selected object(s) only. 

• When nothing is selected, the attribute is defined for all future, relevant objects.  

The following sections detail each of the report attributes and the report objects that they affect. 
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Colors 

 

 

 

Define the foreground and background colors for all objects. Follow these steps: 

1. From the Attributes menu, select Colors.  

2. Define the Text/Lines color.  This is the color of the text, the line, or the 
border around a text/image box.  The default foreground color is black.  To 
select a color click on Color.   

3. The next window varies, depending on whether you are using a Windows or a 
Mac system. 
− Windows allows you to select from a palette of colors or enter specific 

HSL or RGB color values. 
− Mac OS allows you to select from a palette of colors, enter specific RGB, 

CMYK, HLS,  or HSV values, and enter Internet specific colors. 

Define the Background/Fill color.  This is the color that appears behind text 
and in boxes.  Lines and images do not display a background color. 

Line Thickness 

 

Determine line thickness for the following report objects: Line, Horizontal Line, 
Vertical Line, Arrow, Box, Rounded Box, Ellipse, Freehand, Polygon, and 
Polyline. 

1. From the Attributes menu, select Line Thickness. 
2. Enter a Thickness value between .05 and 10 points. 
3. Click on OK. 

 

# Note: In order to define a background/fill color for a Box or a Rounded Box, a fill must be 
selected.  Similarly, in order to define a background/fill color for a text box, the Text Style must be 
set to Opaque. 

Defining Report Objects 
All of the components of your report, including the formatting, text, images, and fields are known as 
objects.  Using the objects, you can specify the information that your report will contain.  Before discussing 
the individual report objects, review the following general procedure for inserting an object into a report: 

1. From the Object menu, select the type of item (i.e., Lines, Connected Lines, etc…) that you want to 
add to the image. The cursor’s functionality varies according to whether a report object type (i.e., line, 
text) is selected:.   
− If a report object type is selected, the cursor changers to a cross-hair icon that is used to add new 

report objects to the grid.   
− If None is selected, the cursor is a an editing tool that is used to select and position objects.  

2. Use the mouse to drag the cross-hair to the location where you want to insert the object. 

3. Left-click at the insertion point.   
− If you selected a line or a box, hold down the mouse button and drag  the line/box to the desired 

size. 
− If you selected any of the other report objects, the object will appear and you will be prompted to 

enter the associated information (e.g., static text, the location of an image file, etc…). 
4. Once it appears on screen, you can resize, reposition, and edit an object as needed. 

− Resize - Select (click on) the object and drag the handles in the direction of the resize.   
− Reposition – Left click and drag the object the new area. 
− Edit – Select the object and choose an option from either the Edit menu or the Attributes menu.  

You can also edit an object by right clicking (Windows)/[Ctrl] clicking (Mac) on it. 
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The following table describes the report objects: 

None Select None when you want to use the cursor to edit and position the objects. 
Lines Unconstrained Line – Add a straight line annotation to the report. 

Horizontal Line - Add a horizontal line annotation to the report.   

Vertical Line – Add a vertical line annotation to the report. 

Arrow - Add an arrow to the report.  Either select Arrow from the Object menu, or click on the Tools 
box button.  Left click on the report and drag toward the area that the arrow head will point to. 

Connected 
Lines 

Polygon – Add a closed polygon to the report. Either select Connected Lines>Polygon from the 
Object menu, or click on the Tools box button.  Left click and release, and then drag the mouse to 
create a side.  Left click again to start a new side.  Double click to finish the polygon.  The program 
automatically adds any additional lines needed to close the figure. 

Polyline – Add an open polygon to the report.  Either select Connected Lines>Polyline from the 
Object menu, or click on the Tools box button.  Left click and release, and then drag the mouse to 
create a side.  Left click again to start a new side.  Double click to finish the polyline. 

Freehand -  Add a freehand line to the report. 

Shapes Rectangular Box – Add a square cornered box to the report.   

Rounded Box – Add a round cornered box to the report. 

Ellipse - Add an elliptical object to the report.  Ellipses are drawn inside of the rectangular area that 
you define.  Ellipses touch the top, bottom, right and left sides of this rectangle.  
 
Either select Shapes>Ellipse from the Object menu, or click on the Tools box button.  To draw an 
ellipse, left click at the point where you want to position one vertex of the rectangle and drag the 
cursor to the point of the opposite vertex. 

Image Add an image to the report.  

1. From the Object menu, select Image.   
2. Left click at the point on the display grid where you 

want to insert the Image box, and holding down the 
mouse button, drag the cursor to create the desired 
shape and size for the  image (it can also be 
resized/re-positioned at a later point). When you 
release the mouse button, the Image dialog box 
appears. 

3. Specify the file source for the image: 
− Currently Open Image – Add a currently open 

image to the report.  If you have one or more 
open images, SPOT lists the file name(s) and 
path(s) in the drop-down box.  Select from the 
list. 

− Image File – Add an image from disk to the 
report.  Specify the file name and location 
either by entering the path in the Name box, or 
clicking on the selection box to the right. 

4. Click on OK.  The image appears on your report 
grid. 
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Text Text 

Add text to the report.    

 Date 

Add a date text box to the report.  The current date is the default. 

 Time 

Add a time text box to the report.  The current time is the default. 

 User Name 

Add a user name to the report.  The user currently logged on to the computer appears as the default. 

Editing Report Objects 
Once you have created a report, you can edit the report objects as needed.  There are three ways to edit a 
report object: 

• Use the Attributes menu - The Attributes menu, as noted in the Defining Report Attributes section of 
this chapter, allows you to either set the attributes for adding specific types of objects, or to select 
existing objects and modify them as needed.  Refer to the Defining Report Attributes section (above) 
for more details.  

• Use the Edit menu - The Edit menu contains general editing features such as Undo, Copy, Cut, Send 
to Back, etc…  

• Right-click (Windows)/[Ctrl] click (Mac) on the report object – Right/[Ctrl] clicking on a report 
object brings up a customized editing menu that contains both general editing commands and the 
attributes that can be edited for that object.  Refer to the Working in the Report Mode section for more 
information on the right click function. 

The Edit Menu 
The Edit menu provides general editing features for arranging, copying, and sizing report objects.  Edit 
menu options are active only when a report object is selected. 

Undo Undo the last action.  The Undo feature allows you to undo up to ten actions. 

Bring to 
Front 

Bring a selected object in front of all other objects.   

Move 
Forward 

Bring a selected object one layer forward. 

Move 
Backward 

Send the selected object one layer back. 

Send to Back Send a selected object behind all other objects. 

Select All Select all of the objects in the report. 

Delete Delete the selected object(s). 

Delete All Delete all of the objects in the report.  
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Copy to 
Clipboard 

Copy the selected object(s) to the Windows clipboard.  You can then paste the object(s) into: 

• A new SPOT report 
• A different location in the same report 
This feature is particularly useful when you are creating a new report and want to use objects 
from an existing report. 

Cut Cut the selected object(s) for pasting into a new report or to a new location in the existing 
report. 

Paste Paste the object that you cut or copied to its new location. 

Duplicate Create additional copies of a report object.  To duplicate a report object, follow these steps: 

1. Select the object(s) that you want to duplicate. 

2. Select Duplicate from the Edit menu.  The program prompts you to enter the number of 
duplicate copies.  

3. Enter the number of copies, and click on OK. 

4. The duplicate object(s) appear at the top of report window. 

Set Position, 
Alignment, and 

Size 

The Set Position, Alignment, and Size 
option allows you to specify precise 
sizing and position values for single or 
multiple selected report and annotation 
objects.    

The Position options enable you to: 

• Align top/bottom edges of multiple 
objects. 

• Align left/right edges of multiple 
objects. 

• Align the centers of multiple 
objects. 

• Center an object(s) on the page. 

• Enter exact values in inches or 
millimeters to position the object. 

The Size options enable you to enter: 

• Exact width/height in inches or 
millimeters for one or more 
objects. 

• Set the width/height dimension for 
multiple objects the to smallest or 
largest object’s  value in inches or 
millimeters. 

 

Add Page Add a page to your report.  When you 
add a page, the program prompts you 
with the Add Page dialog box: 

1. Specify whether the page that you 
want to add will be inserted Before 
or After a specified page. 

2. Specify the Page Number that the 
additional page will precede or 
follow. 

3. Click on OK. 

SPOT reports can have a maximum of 
ten pages. 
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Delete Page Delete a page from your report.  When you select the Delete Page option, the program 
prompts you to specify the page number.  

Add Images Add a static image to your report. 

Saving a Report 
1. To save a newly created report, select the Save option from the File menu.   

2. When saving  a new report (.rpb file type), SPOT prompts you 
with the default file location – i.e., C:SpotCam\Reports folder 
(Windows) or Users\Shared\SPOT Files\Reports (Mac) .   
Either save to the default location or specify a new location.  If 
you plan to save many reports without compressing the image 
files, you should save them to a Jaz drive or to a network drive.  

# Note: Mac users will see the .rpb file type extension 
only if the Add Extensions to File Names on Save 
option is selected on the Preferences window . 

3. Enter a file name for the report. 

4. Define the JPEG Compression for the image(s) in the report.  The Use JPEG Compression for 
Images box is checked as a default.  To turn off JPEG compression, deselect the box.  If you are using 
JPEG Compression, enter a number between one and 100. 
− A value of 1 is the most compressed.  File size and image resolution are decreased to the 

maximum extent. 
− A value of 100 is non-compressed.  File size remains large and the image resolution remains high. 

5. Click on Save.  You can now use the SPOT program to open and view the report at a later time. 



Printing and Distributing Reports Ch. 5  - Reporting 

80 User Guide to the SPOT Vision Camera 

Printing and Distributing Reports 
To print a report, follow these steps: 

1. Open the report. 

2. Select the printer.  If you have Adobe Acrobat, you 
can create a PDF version of your report by 
selecting Acrobat PDFWriter as the printer of 
choice: select the Printer from the Page Setup 
dialog – i.e.,  File>Printer Setup>Printer.  PDF 
files can be distributed to anyone with the Acrobat Reader software, which, as described below, is 
available from Adobe as a free download.  

3. Click on Properties to define the printer’s properties, if needed. 

4. Specify the page range if you are not printing an entire report. 

5. Specify the number of copies. 

6. Click on OK. 

If you intend to distribute SPOT image reports to people who do not have the SPOT program, we 
recommend that you purchase Adobe Acrobat.  Using Acrobat, you can convert the SPOT report (.rpb) files 
to PDF files, which can be distributed to users who do not have the SPOT software.  They can view the 
reports with the free Acrobat Reader software, which is included on the SPOT software CD.  The latest 
version of the Acrobat Reader can also be downloaded from the Adobe’s web site www.Adobe.com. 
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Introduction 
The printing features in the SPOT program fall into two categories: 
• Printer Setup - The standard Windows dialog boxes that are used to specify: 

− Printer and setup 
− Page setup 
− Orientation 
− Paper size and source. 

• Print - The SPOT printing options allow you to print one or multiple diagrams on a page. 

Printer Setup 
After you have installed and setup your printer, the procedure for setting up and configuring a printer in 
SPOT is the same as in any other Windows program.  

# Note:  Because the information contained in this section is standard Windows functionality, the 
options are not discussed in detail.  For more information on Windows printing features, refer to the 
Windows on-line help.   

To choose and configure a printer, follow these steps: 

1. Choose a printer.  From the File menu, select Printer Setup.  The Page Setup window appears.  To 
select the printer you want to use, click on the Printer button at the bottom of the window.  The 
program prompts you to select a printer.  

2. Modify the default settings of the printer, if necessary.   
Click on Properties.  From this point you can modify printer specific options such as color settings, 
fonts, graphic settings, etc… The printer properties window and the available options will vary 
according to the printer that you are using. Refer to the on-line help or your printer’s manual for more 
information.  When you finish entering the property settings, click on OK.   

3. Click on OK.  The program returns you to the original Page Setup window. 

4. Define the page setup that you want to use for the image(s).   
This includes the page orientation (portrait or landscape), paper size, paper source, and margins.  
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5. Save the page layout specifications that you entered. 
Click on OK. 

# Note:  You can also access the Page Setup screen from the Print screen (i.e., From the File menu, 
select Print, and click on the Setup button.  

Print 
After you have defined the printer and page layout, you are ready to print.  With the SPOT software, you 
can print a single image to a page or you can print multiple images on a page for comparison or display.   

Printing a Single Image 
To print a single image from the SPOT software, follow these steps: 

1. Either select Print from the File 
menu, or click on the Print toolbar 
button.  The Print window 
appears with a preview of the 
active image. 

The Print window displays the 
following information:  

− Printable Area: The 
printable dimensions of the 
page. 

− Top Image:  The position 
and size of the top-most 
image (if more than one 
image will be printed on the 
page). They are: 
♦ Left - The distance 

between the left side of 
the printable area and the 
left side of the image. 

♦ Top - The distance between the top of the printable area and the top of the image. 

♦ Width - The width of the image. 

♦ Height - The height of the image. 

2. Check either Inches or Millimeters to specify the units of measurement. 

3. Adjust the size of the image: 
a) Position your cursor on a side or a corner of the image.  The cursor turns into a two-ended arrow. 

b) Using the two-ended arrow cursor, drag a side or corner to enlarge or reduce the image.  The 
resized image maintains the height to width ratio of the original image. 

4. Adjust the position of the image.  
a) Position the cursor on the image.  When on the image, it appears as a four pointed arrow. 

b) Left click and drag the image to the desired location. 



Ch. 6 - Printing Images Print 

User Guide to the SPOT Vision Camera 83 

5. Click on the Print button.  The Printing dialog box displays the job.  To stop the print job, click on the 
Abort button. 

Printing Multiple Images on a Page 
The SPOT program also enables you to print multiple images on a single page.  The additional images do 
not need to be open; you can add additional images from a file directory. 

To add and arrange multiple images for printing, follow these steps: 

1. From the File menu, select the Print option.  The currently open, selected image appears in the Print 
window. 

2. Add an image to the page for printing.  Follow these steps: 

a) Click on the Add button.  The Add Image window appears.  

b) Select the image that you want to add.  Images can be added from one of two places: 

♦ From a Currently Open Image 
– Add one or all of the currently 
open images.  Select either the 
desired image or <All Images> 
from the Title drop-down list.  
Ensure that you enter the 
Sequence Index (i.e., the 
number of the image in the 
sequence) if you are adding an 
image from a sequence file.  

♦ From an Image File – Add a file 
from disk.  Check the Image 
File option, and click on the 
square next to the box.  Browse 
for the desired image, and click 
on Select.  Ensure that you enter 
the Sequence Index (i.e., the number of the image in the sequence) if you are adding an 
image from a sequence file.  

c) Set the auto-arrange option.   If you check the Auto-Arrange Images box, the SPOT program 
automatically sizes and positions the images to fit on the print page.   

d) Click on OK.   The program adds the images to the print page and returns to the Print window.  
The images appear in the preview box. 

♦ If you selected the Auto-Arrange Images option, the images will be arranged in a print-
ready format.  Click on Print to print the page. 

♦ If you did not use the Auto-Arrange Images option, the images will be stacked on top of 
each other for you to arrange.  Go to step 3 for details on manually arranging the images. 

To add additional images, repeat step 2. 
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3. Arrange how multiple images will appear on the page.  Follow these 
steps:  
a) Click on the Arrange button.  The  Arrange Images window appears.  

b) Select the number of row(s) and column(s).   

c) Enter the Spacing between the images on the print-out in inches or 
millimeters. 

d) Select Apply to all pages to make the arrangement applicable to 
every page of a multi-page report.  

e) Click on OK.  The Print screen reappears 
with a preview of your print arrange-
ment.  The screen capture at right 
illustrates four images arranged in a two 
row, two column format. 

The SPOT program automatically resizes 
images to fit on the page, so you can add 
multiple images without having to resize 
them.  For example, if you add five images, 
the preview will show six images (the 
original and five added) of equal size, 
distributed proportionally across the page.   

4. From the print screen, you can: 
− Click on Print to print the page. 

− Add an image as described in step two. 

− Delete an image by selecting it and clicking on Remove. 

− Reposition and/or resize the images as described in the previous section. 

− Use the Page drop-down list to navigate to a different page view (when printing multiple pages. 

Printing Image Sequences 
The procedures for printing sequential images in the SPOT software are 
identical to those described in the Printing Multiple Images on a Page 
section (see above)., with one exception.   When you select the Print 
option for a sequential image file, the program prompts you to specify the 
image(s) in the sequence that you want to print, as shown at right. 

• If you select All Images in Sequence and click on OK, the program 
prompts you to specify the number of images per page.  

• If you select Specified Images, you can select either a single image or multiple 
images.  Separate multiple images with commas and/or dashes – e.g., 1, 2, 3;  
1-3; or 1, 2, 3-6. 

 

# Note:  You can reposition and resize 
multiple images on the preview page, 
just as you can with a single image. 
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Introduction 
The SPOT software is TWAIN compliant.  The TWAIN interface, as an alternative to the stand-alone 
SPOT software, allows Windows users to use other imaging programs (e.g., Photoshop or Image Pro) to 
view, and edit images that were captured using the SPOT camera and software.   For example, using the  
TWAIN interface and the SPOT camera, you can capture an image from within Photoshop and then 
transfer the image into Photoshop to be edited and saved. 

Establishing the TWAIN Interface 
To use the SPOT camera and software via a TWAIN compliant imaging application (e.g., Photoshop, 
Image-Pro, etc…), you must first set the SPOT software as the default TWAIN source.   

Follow these steps: 

1. Open the TWAIN compliant application e.g., Photoshop, Image-Pro, etc… 

2. Specify the source of the program that you want to interface with (i.e., the SPOT software).  The 
procedure for this step will vary according to the software you are using, but you  should see a list of 
TWAIN devices.  In many cases, the application asks you to specify a scanning device. 

3. Choose SPOT Vision camera.  This establishes the SPOT software as the default TWAIN source.  

4. Open the TWAIN interface.  
Again, this step varies 
according to the software you 
are using.  The SPOT Camera 
window appears within the 
application, as shown at right.  

Refer to the next sections for 
descriptions of the available 
options on the TWAIN interface. 
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Working in the TWAIN Interface 
The TWAIN interface is a one-stop point for previewing and capturing images.  For example, using the  
TWAIN interface, a typical image capture session  might involve the following steps, as illustrated below: 

Preview your specimen 

Use the live image as a point 
of reference to focus and 
position the image and to scan 
for areas of interest. 

 

Create a Profile 

Profiles allow you to create, 
modify, and reuse specific 
exposures settings that are 
tailored to your image capture 
needs.  To create a new 
profile, right click on the  
Profile box. 

 

 

 

 

A Live Image preview
of your specimen

displays here when
you first open the

Basic TWAIN interface.

Right-clicking on the Profile box
gives you options to create and
modify Profiles.  When you select
"Add," you are prompted to name the
new Profile.  And, as you modify view
and capture settings, they are saved
to that Profile.
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Define Settings 

Define exposure 
settings for live and 
captured images.  Each 
of these settings are 
discussed later in this 
chapter. 

 

 

 

 

 

 

 

 

 

Capture an Image 

All of the image 
capture options are 
located on the bottom 
portion of the window, 
as illustrated here 
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Defining Preferences 
In the TWAIN Interface, you can define  the following view preferences.   Click on the Prefs button to 
open the Preferences window.  Each option is described below: 

Keep TWAIN Window on Top  
Checking this option ensures that the TWAIN window remains the top-most window when working in 
multiple applications.  This allows you to preview and transfer or acquire multiple images without having 
to re-open the SPOT window.  If the Keep This Window on Top box is checked, the SPOT Camera 
window remains open.  If the box is not checked, the window automatically closes after each image is 
transferred or acquired. 

Always Show Full Chip in Live Mode 
Checking this option ensures that  you will always see the Full Chip view when viewing a live image.  
Keep in mind that the selection that you make here determines how the live image displays when viewing a 
region of the chip.  Refer to the Chip Imaging Area section below for more details.  

F-Keys 
The following function keys are available as shortcuts in the TWAIN interface: 

Function Key Action TWAIN Interface Option 

[F 4] Restart the live image view. Live 

[Alt] + [F 4] Close the SPOT Camera window. Close 

[F 9] Capture an image and automatically transfer it to the 
imaging application. 

Acquire 

[Ctrl] + [F 10] Compute white balance values. White Balance 

[Alt] + [F 10] Compute white balance values without displaying the 
informational dialog. 

Not available from the window 

Using the Live Image to Define Image Capture Settings 
When you open the TWAIN Interface, the Live Image window is, by default, running, as  indicated by the 
Live Mode Running message in the status bar.  The settings options in the TWAIN interface window 
enable you to optimize the live image view, and then capture an image using these settings.  In the TWAIN 
interface, you can: 

• Create profiles to use as pre-defined image capture settings. 

• Modify exposure settings 

• Define a specific portion of the chip to be used in the image capture. 

• Modify the screen orientation of the specimen. 

The following sections describe all of the Live Image/Image Capture Settings. 
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Profile 
The Profile option allows you to create and re-use sets of live image/image capture settings.  When you 
open the TWAIN interface, the Default Profile is selected.  When you make changes to any of the live 
image/image capture settings, these changes can be saved to a Profile – either the Default or one that you 
have defined.  For example, if you gamma adjust a live image and then decide that the result is ideal for the 
type of specimen you are working with, you could create a new Profile with the gamma and exposure 
values and name it for that type of specimen – i.e., “Diseased Cells.”   

When you close the SPOT Camera window, the program prompts you to save changes.  Carefully 
consider the effect of your choice:     

• Clicking Yes modifies the Profile according to the adjustments that you made.  Future image captures 
taken with that Profile will reflect these changes.  For example, if you rotated a live image, and then 
clicked Yes after closing the window, all future captures taken with that Profile would be rotated in the 
same way. 

• Clicking No retains the original values of the Profile.  This allows you to maintain a unique set of 
image view and capture settings that can be re-applied to future captures of similar specimens.   

To add, edit, or delete Profiles, right-click on the Profile box.  Right clicking gives the following options:  

• Add – Add a new Profile.  When you add a new Profile, the program prompts you to name it. 
• Save – Save a Profile that you have modified. 
• Rename – Rename an existing Profile. 
• Delete - Deletea Profile.  This option appears only after you have defined a second Profile in addition 

to the Default Profile.   

Exposure: Auto or Manual 
The Exposure option gives you the choice of having the camera calculate exposure time (Auto), or setting 
the exposure on your own (Manual).   The exposure options will vary according to whether you select 
Auto or Manual, as illustrated below. 

Auto Manual 

  
When you enter one of the above exposure settings, note that it applies both to the live image that you are 
viewing and the captured image.  
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Understanding Gain and Auto-Gain Limit 
Normally an auto exposure routine in a digital camera sets the exposure time so that the brightest pixel on 
the CCD chip is completely “filled” with electrons, or is “full well”.  This simple technique works well for 
bright images, but, as an image gets dimmer, exposure times can get uncomfortably long.  With the SPOT 
camera you can shorten exposure times by filling the brightest pixel on the CCD chip to less than full well, 
and then using this lower level as full scale.  The inverse fraction of full well that the brightest pixel on the 
CCD is filled to is known as the gain. For example, filling a pixel to half of full well cuts the exposure time 
in half.  Since the exposure time is cut in half, we call this a gain of 2. 

The following table illustrates the relationship between gain, the fraction of full well that the brightest pixel 
is filled to, and the effect of gain on exposure time: 

Gain  Fraction of Full Well Exposure Time (sample) 

1 1 80 seconds 

2 ½ 40 seconds 

4 ¼ 20 seconds 

8 1/8 10 seconds 

16 1/16 5 seconds 

An 80 second exposure at a gain of one turns into a 5 second exposure at gain 16.  This is good in terms of 
the exposure time.  Unfortunately, background noise is directly proportional to gain.  It is 16 times higher at 
a gain of 16 is than at a gain of one.   

Auto-Gain Limit (see the Quality/Speed section below) allows you to set an upper limit on the gain 
options that will be available during the Auto-Exposure process.   

# Note:  If you are using Manual exposure, you can set an exact gain for an image capture. 

For example, with an Auto-Gain Limit of 16 the camera can “choose” from the full range of gain options.  
However, if you find that gains of 8 or 16 are too noisy for your images, you can prevent the camera from 
selecting these options by setting the Auto-Gain Limit to four.  When the Auto-Gain Limit option is set to 
four, the camera is limited to the lower three gain options: 1, 2, or 4.  

Higher gain levels for dim images significantly reduce exposure time.  For each doubling of gain number, 
exposure time is halved.  Thus, an image with an exposure time of 5 minutes at full scale (a gain of 1) 
would take only 1.25 minutes at a gain of 4.  Unfortunately, background noise increases proportionally to 
the gain.  Thus, the shortened exposure time would result in an image with four times the amount of 
background noise.  The following table illustrates the relationship between gain, exposure time, and 
background noise: 

Auto-Gain 
Limit 

Possible Auto – Gain 
Settings 

Exposure Time 
(dim images) 

Background Noise 
(dim images) 

1 1 Longest Lowest 

2 1, 2 $ % 

4 1, 2, 4 $ % 

8 1, 2, 4, 8 $ % 

16 1, 2, 4, 8, 16 Shortest Highest 
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Auto Exposure options 

Image Type 
An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 
available Image Types (see below) corresponds to a microscopy technique: select the Image Type that 
matches the technique you are using.  The camera will capture the image accordingly. The table below 
describes typical situations for each image type. 

Image Type Description 

Brightfield-transmitted light Stained specimens on glass slides using transmitted light microscopes. 

Darkfield-transmitted light Bright specimens on dark backgrounds using transmitted light darkfield technique. 

Fluorescence Fluorescence specimens not fluorescing in a single red, green, or blue primary color  

Nomarksi DIC/Hoffman Specimens being viewed with either Nomarski DIC or Hoffman techniques. 

Phase contrast Specimens being viewed using the phase contrast technique. 

Polarized light Specimens being viewed with polarized light techniques. 

Brightfield-reflected light Polished metallurgical specimens and semi-conductors using a microscope with a 
vertical illuminator. 

Darkfield-reflected light Bright areas of specimens being viewed with darkfield, reflected light techniques. 

Stereo/macro–no glints Matte specimens without bright glints. 

Stereo/macro–shiny glints Shiny specimens with bright glints. 

Stereo/macro-metallic glints Metallic specimens with intense glints. 

Brightness 
Enter a Brightness value between .25 and 32.   
A brightness value of 1, the default value, gives you the correct image brightness for most images.  The 
Brightness control allows you to overexpose or underexpose (darken or lighten) the image area.  In many 
cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or 
darken the image.  When using the Brightness control, the SPOT camera uses an algorithm that combines 
gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode: 
• When overexposing images to make them brighter (i.e., entering values greater than one), the camera 

first selects the highest possible gain before lengthening the exposure time.  Because gain also 
brightens an image, less exposure time is needed. 

• When underexposing images to make them darker (i.e., entering values less then one) the camera uses 
the lowest possible exposure time before lowering the gain. 

Quality/Speed (Auto) 
Gamma adjustment Use the slider to balance speed and quality when previewing dim images.  
• Moving the slider toward the Quality side increases image quality and decreases frame rates. 
• Moving the slider toward the Speed side increases frame rates and decreases image quality. 
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The Quality/Speed measurement corresponds to the Auto-Gain limit setting, which allows you to set an 
upper limit on the gain options that will be available during the Auto-Exposure process.   

• When the slider is at the left-most point, the Auto-Gain Limit is  1, which restricts the camera to a gain 
of 1, giving you higher quality pictures, but lengthier exposure times.   

• When the slider is at the right-most point, the Auto-Gain Limit is 32, which allows the camera to select 
from all six gain options.  This shortens exposure times, but decreases image quality. 

Refer to the “Understanding Gain and Auto-Gain Limit ” section above for more details on gain and 
exposure.  

Gamma 
Enter a Gamma value between .1 and 4.    
Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or 
lightening black areas.  This is especially useful for capturing/editing images with a wide range of 
brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., 
printed circuitry).  

• Values between 1 and 4 lighten the darker areas of the image. 
• Values between .1 and 1 darken the mid-tones of the image. 
Gamma adjustments on live images are made in the RGB color space, the only color space where 
adjustments can be made quickly enough to keep up with live imaging.  Refer to Ch. 2 – Preparing to Take 
a Picture for more details on gamma adjustment. 

Manual Exposure Options 

Exposure Time 
Use the slider-bar to specify an exposure time between .04 ms and 526.746 sec.  
Gamma adjustment When you specify an exposure time, the camera skips the automated exposure 
sequence that takes place when you open the live image view – i.e., the TWAIN interface.  This is very 
useful in cases where exposure times are lengthy, as with fluorescence samples. 

Gain 
Gamma adjustment Enter the precise gain that the camera will use for an image capture.  Use the slider-bar 
to select one of the six gain options: 1, 2, 4, 8, 16, or 32.  The gain value displays to the right of the slider-
bar.  Refer to the “Understanding Gain and Auto-Gain Limit ” section above for more details on gain 
and exposure.  

Gamma 
The manual Gamma adjustment is identical to the auto Gamma adjustment (see above.) 
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White Balance 
White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for 
an image.  Many factors impact the coloration of an image capture, including lamp voltage, the coloration 
of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s 
objectives.  To minimize the impact of these factors, use the White Balance feature.   When you perform a 
white balance calculation, SPOT samples the color of the light from your light source after it has passed 
through the slide and the objective, and then calculates the red, green, and blue gains needed to produce 
images where the white areas are white and the color areas are true.   

You should perform a new white balance calculation when: 

• Starting a new image capture session. 
• Changing the lamp voltage. 
• Switching to a different objective on the microscope.  

To perform a white balance, follow these steps: 

1. Set the illumination and the objective that you will use for the image capture. 

2. If you have not done so, select your Image Type (see above).  Each Image Type has its own set of 
white balance values.  Any white balance values that you compute for an image type remain linked to 
that image type until you compute new values.  When selecting a new image type, remember that you 
will be using the white balance values linked to that image type. 

3. Click on the White Balance button. 

4. Show the camera a sample of white light.  This step varies according to microscopy technique and 
Image Type (sample), as shown in the table below: 

Image Type White Balance Technique 

Brightfield-
transmitted light 

Position the slide so that the specimen is not in the field of view, but light is going through the slide 
near the specimen. 

Darkfield-
transmitted light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield –
transmitted light above. 

Fluorescence Use the Match Color feature (see above) 

Nomarksi 
DIC/Hoffman 

For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the 
“gray scale” view. 

For Hoffman: Perform the white balance directly on the Hoffman image. 
Phase contrast Position the slide so that the specimen is not in the field of view, but light is going through the slide 

near the specimen. 

Polarized light Pull all polarizers and compensators out of the light path and then position the slide so that the 
specimen is not in the field of view, but light is going through the slide near the specimen.  

Brightfield-
reflected light 

Replace your sample with a mirror. 

Darkfield-
reflected light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield – 
reflected light above. 

Stereo (all three 
options) 

Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace 
your sample with a white sheet of paper. 

5. Click on Begin to start the calculation.  The camera computes the white balance values, and they are 
automatically saved to the image settings for the image type that you selected. 
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Match Color 
The Match Color feature is typically used in two situations: 
• You want to change the colors of an image on the screen to match the way that you think the specimen 

looks. 
• You want to set the white balance for pictures taken with a microscopic technique that never has white 

in its images.  A prime example of this situation is fluorescence microscopy.  

To use the Match Color feature, follow these steps: 
1. Click on the Preview button to capture an image.  The Match Color option remains inactive until a 

preview image is captured. 
2. From the Edit menu, select Match Color.  The cursor becomes an eye-dropper.   

3. Using the mouse to move the eye-dropper, position it on the pixel location of the color that you want to 
match.  The R, G, and B values of the pixel that you select must all be less than 255. 

4. Click on the pixel.  The Match Color dialog appears with information about the pixel that you 
selected: 
− Hue – The actual color, as distinguished from others in the color spectrum.  Hue is derived from 

a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees). 
− Saturation - The proportion of perceived pure hue in the color.  Saturation (in the SPOT 

software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 
equals pure hue (e.g., “day glow”). 

5. Move the cross-hairs to the desired color either by clicking on the new location or clicking and 
dragging.   As you move the cross-hairs, the color in the image changes accordingly, allowing you to 
preview the color before you save the image.  Alternatively, you can click on the Make White/Grey 
button to automatically white balance the image. 

6.   Click on Ok. 

Chip Imaging Area 
SPOT allows you to use any rectangular portion of the CCD chip for image capture.  Using a portion of the 
chip is helpful in cases where you want to: 

• Keep file sizes small. 
• Shorten download times. 
• Avoid areas of the image with optical problems (e.g., vignetting).   
There are three image area options: 
• Full Chip – Capture the entire area of the CCD chip.   

• Center – Capture a rectangular part of the CCD chip’s area that has the same height - to - width ratio 
as the full chip, and is centered on the center of the full chip.  The percentage that you enter is the 
percentage of full chip width that the new area’s width will be. 

To capture a centered proportion of an image, follow these steps: 
a) Check the Center option. 
b) Enter the percentage of the image that you want to capture.  The minimum percentage is 10 and 

the maximum is 100. 
c) Capture the image. 

• Selection –Capture a specific part of the CCD chip.   
a) Check the Selection option. 
b) Use the mouse to select a region for capture.  Click and drag to define the selection.  Note that the 

new pixel dimensions display in the status bar. 
c) Capture the image.  
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When you are viewing a live image Selection, how this selection is displayed, depends on two other 
settings: the Fit to Window option (see below) and the Always Show Full Chip in Live Mode preference 
(see above).  The following table illustrates the possibilities: 

Fit to Window 
Checked? 

Always Show Full Chip  
in Live Mode Checked? 

 
Selection Display 

 Live or  
Captured Image 

YES YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle. 

LIVE 

YES NO When you select a portion of the chip the cursor 
is a zoom tool.   To zoom in on a portion of a 
live or captured image, click and drag over the 
area that you want to zoom in on.   To return to 
the non-zoomed image, click on the Full Chip 
option.  

BOTH 

NO YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle.  
However, because Fit to Window is not 
checked, you will not see the entire chip in the 
window. 

LIVE 

NO NO When you select a portion of the image, the 
cursor is a cropping tool.  If you select a portion 
of an image, the program displays only the 
selected area and discards the rest of the image. 
To return to the non-cropped image, click on the 
Full Chip option. 

BOTH 

Auto-Brightness (Auto, Live Images) 
Available only when you are using Auto exposure and viewing a live image, the Auto-Brightness option 
enables you to maintain a consistent brightness level for changing specimens.      

Faster Readout (Live Images) 
Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you 
are willing to sacrifice some resolution for a higher frame rate.  

Flatfield (Captured Images) 
For all other SPOT camera lines, the Flatfield Correct option is used to correct for display problems 
associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the 
optical system.  Flatfield can still be used for this purpose with SPOT Vision cameras.   But, because SPOT 
Vision cameras use a color mosaic chip, Flatfield correction serves a new primary purpose.  In the 
production process for color mosaic CCD chips, the RGB colors are applied directly to the pixels on the 
chip.  This process often results in an uneven color density around the outer 30-40 rows of the CCD chip, 
causing a “halo” appearance in some image captures, particularly those with low contrast.  The Flatfield 
option can be used to correct this  problem.   

# Note:  Flatfield correction with the SPOT camera refers only to the correction of uneven 
lighting.  It should not be confused with the correction of optical field flatness. 
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Flatfield correction works by taking a picture of the brightfield background without the specimen in the 
field of view.  This image lets the SPOT software know, on a pixel-by pixel basis, which areas in the field 
of view are receiving less illumination than the brightest areas. When taking a picture that contains a 
specimen, the software uses this information to accurately increase the brightness of each pixel in the dimly 
illuminated areas.  The resulting image gives the appearance of an even illumination. 

To use the Flatfield option, follow these steps: 

1. Ensure that the specimen is under the desired objective and 
in focus.  

2. Right click on the Flatfield drop-down list and click on the 
Add option.  The Get Flatfield dialog appears as shown at 
right. 

3. Remove the slide from the field of view. 

4. Click on Begin.  When the program finishes computing the exposure times and acquiring the flatfield 
file, the Flatfield dialog prompts you to name the file: 

a) Enter a name.  Because flatfield image files are different for each objective, you might want to 
name the file according to the objective's magnification (e.g., 10x).  

b) Click on OK.  If you do not specify a location, the program automatically saves the flatfield file to 
the c:\SpotCam\Fltflds directory. 

# Note:  The default file location varies, depending on where you installed the SPOT program. 

5. Move the specimen back into the field of view, and perform the image capture, using either the 
Preview or the Acquire option. 

Color Enhancement (Captured Images) 
The Color Enhancement option optimizes image captures by closely matching the final capture to the 
image as seen through the microscope.  To optimize the final image, the SPOT program processes the raw 
image data to produce a final image that matches the view seen through the microscope.  

If you want an image capture to match the live image view, you will want to leave Color Enhancement off.  
Color Enhancement applies only to captured images. 

Fit to Window 
In addition to automatically resizing images to fit within the live image window, the Fit to Window option 
also determines cursor behavior in the live image view. 

• When the Fit to Window option is checked, the live image window cursor becomes a zoom tool.  To 
zoom in on a portion of a live image, click and drag over the area that you want to zoom in on.   To 
return to the non-zoomed image, click on the Full Chip option. 

• When the Fit to Window option is not checked, the cursor is a cropping tool.  If you select a portion of 
an image, the program displays only the selected area and discards the rest of the image. To return to 
the non-cropped image, click on the Full Chip option. 

These points apply only when the Always Show Full Chip in Live Mode (see Defining Preferences 
above) is not selected.  For more details, refer back to the Chip Imaging Area section (see above). 
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   16.6 ms per cycle

8.3 ms
per cycle

SPOT Power Line
Frequency (60 Hz)

Fluorescent Light
Output Frequency

Exposure < 8.3 ms

Minimum Exposure > 10 ms

 Setting a Minimum Exposure to  
Accommodate Varied Light Sources  

# Note: Due to a flaw in the Windows operating system, monitors that are set to higher resolutions 
cannot zoom to very high magnification levels.  If zoomed in to a high magnification, the monitor 
displays white instead of the zoomed image.  

More (Additional Orientation and Exposure Settings) 
When you click on More, the program displays a 
dialog of additional orientation and exposure settings 
for the TWAIN interface, as shown at right.   

Flip 
Specify whether images will be flipped in the live 
image view and during the image capture process.  

• Select Horizontal to flip the image from left to right. 
• Select Vertical to flip the image from top to bottom. 
• Select both options to flip the image from left to right and from top to bottom. 

Rotate 90°°°° 
Specify whether images will be rotated in the live image view and during the image capture process. 

• Select None if you do not want the image to be rotated.  
• Select Right to rotate the image clockwise 90 degrees. 
• Select Left to rotate the image counterclockwise 90 degrees.    

Exposure Limits – 
Minimum 
Because SPOT Vision cameras are 
capable of extremely short exposure 
times, light sources with intensities 
that vary with the waveform of the 
60 Hz line supply (e.g., fluorescent 
lamps, 120 volt incandescent bulbs, 
and 6 volt 20 watt halogen lamps) 
can cause the Live Image window to 
flicker and result in incorrect 
brightness and color balance 
readings in captured images. This 
option allows you to correct for 
these problems by limiting the 
camera to a minimum exposure time 
that is greater than the pulse interval 
of the light source.  Consider the 
illustration to the right. In this case, the pulse interval of the fluorescent light source is 8.3 ms.  Entering a 
Minimum Exposure of 10 ms ensures that the camera’s exposure time is greater than the pulse interval of 
the light source.  To enter a minimum 
exposure, check the Minimum box, and enter 
a value in milliseconds.   



Ch. 7 – Using Other Windows Imaging Applications Taking a Picture 

User Guide to the SPOT Vision Camera 99 

Exposure Limits – Live Image Maximum 
Because The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing 
a live image.  Consider the following situation: When you change from a lower resolution objective to a 
higher resolution objective, the camera detects a brief interval of blackness.  When the Auto-Brightness 
option (see above) is enabled, it compensates by modifying the exposure time to maintain a constant 
brightness level.  This results in you having to wait for the camera to compute a lengthy and incorrect 
exposure for the black interval.  Using the Live Image Maximum option, you can limit this exposure time. 
For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. 

Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path 
selector is incorrectly set.     

Noise Filter 
The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with 
lengthy exposure times, the noise filter acts as a “virtual cooler” for the Vision camera, eliminating “hot 
pixels.”   

The Noise Filter checks each pixel on the CCD chip as described below: 

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels. 

2. If none of the eight neighboring red pixels has a value within ±15 %  (i.e., the threshold value that the 
SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being 
checked is replaced with the average value of the eight neighboring red pixels.  

3. The program repeats this procedure for the values of the green and blue pixels being checked.  

To activate the Noise Filter, check the Noise Filter box.  The program runs the noise filter each time an 
image is captured using the Preview or Acquire options. 

Taking a Picture 
From the SPOT TWAIN Interface, you can capture images in different ways: 

• Preview - You can capture a Preview image.  Preview images remain available in the TWAIN 
window for basic editing and serve as the basis for the final image capture.  When you click on the 
Preview button, the Get Image dialog displays the capture status as it is captured, and the captured 
image then replaces in the Live Image in the window.  Note that the status bar indicated that you are 
viewing a Preview image.     

• Transfer - If you like the Preview image, you can Transfer it image directly to the third party 
application that you are using.  The Transfer button is active only for Preview image captures.    

• Acquire - Capture an  image and have it automatically transfer to (open in) the third party imaging 
application.   
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Introduction 
The SPOT 3rd Party Interface is a stand-alone mini-application that is designed for Mac users who want to 
use the SPOT camera to capture images, and then edit the images in a third party imaging application (e.g., 
Photoshop, Image-Pro).  Using the 3rd Party Interface, you can: 

• View a live image preview  
• Create and/or modify a SPOT image setup  
• Capture an image and have it automatically open in another application 
• Capture an image and save it to file (i.e., the image is not associated with a specific application) 
• Transfer captured images into the image editing software  

You cannot, however, use the 3rd Party Interface to open images from file. 

Working in the 3rd Party Interface 
The 3rd Party interface is a one-stop point for previewing and capturing images.  For example, using the  
3rd Party interface, a typical image capture session  might involve the following steps, as illustrated below: 

Preview your 
specimen 

Use the live image 
as a point of 
reference to focus 
and position the 
image and to scan 
for areas of interest. 

 

Create a Profile 

Profiles allow you to 
create, modify, and 
reuse specific 
exposures settings 
that are tailored to 
your image capture 
needs.  To create a 
new profile, 
control-click on the  
Profile box. 
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Define Settings 

Define exposure settings for 
live and captured images.  Each 
of these settings are discussed 
later in this chapter. 

 

Capture an Image 

All of the image capture options 
are located on the bottom 
portion of the window, as 
illustrated here 
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Defining Preferences 
In the 3rd Party Interface, you can define three 
capture/view preferences.   Click on the Prefs button to 
open the Preferences window (see right).  Each option 
is described below: 

Captured Image Bit Depth  
This option enables you to specify a different image bit 
depth when saving an image  captured in the SPOT 
program.   
• 8 Bits per Channel – The 8 bits per channel option 

provides 256 gray levels per color:   
− With Vision B/W cameras, captured images 

are 8 bits per pixel monochrome. 
− With Vision Color cameras, captured images are 24 bits per pixel RGB color.  

This option results in smaller, more manageable image sizes, and is best for images that do not require 
extensive modification. 

• 12 Bits per Channel – The 12 Bits per channel option provides 4,096 gray levels per color.   
− With Vision B/W cameras, captured images are 12 bits per pixel monochrome. 
− With Vision Color cameras, captured images are 36 bits per pixel RGB color.  

This option reduces banding problems that can result with modified images,  but also results in larger 
file sizes.   

When saving 12 bit per channel images, SPOT prompts you to select either 12 bits per channel or 16 
bits per channel.  If you use Adobe’s Photoshop for image editing, you should select the 16 bit per 
channel option because  Photoshop cannot read 12 bit per channel images.  

# Note: The SPOT Vision camera captures all images using 10 bits per channel (color).  The SPOT 
software immediately converts the captured image to either 8 bits per channel (color) or 12 bits per 
channel (color), depending on the Captured Image Bit Depth that you select. 

Always Show Full Chip in Live Mode 
Checking this option ensures that  you will always see the Full Chip view when viewing a live image.  
Keep in mind that the selection that you make here determines how the live image displays when viewing a 
region of the chip.  Refer to the Chip Imaging Area section for more details.  

F-Keys 
The following function keys are available as shortcuts in the 3rd Party interface: 

Function Key Action 3rd Party Interface Option 

[F 4] Restart the live image view. Live 

[Alt] + [F 4] Close the SPOT Camera window. Close 

[F 9] Capture an image and automatically transfer it to the 
imaging application. 

Acquire 

[Ctrl] + [F 10] Compute white balance values. White Balance 

[Alt] + [F 10] Compute white balance values without displaying the 
informational dialog. 

Not available from the window 
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Using the Live Image to Define Image Capture Settings 
When you open the 3rd Party Interface, the Live Image window is, by default, running, as  indicated by the 
Live Mode Running message in the status bar.  The settings options in the 3rd Party interface window 
enable you to optimize the live image view, and then capture an image using these settings.  In the 3rd 
Party Interface, you can: 

• Create profiles to use as pre-defined image capture settings. 

• Modify exposure settings 

• Define a specific portion of the chip to be used in the image capture. 

• Modify the screen orientation of the specimen. 

The following sections describe all of the Live Image/Image Capture Settings. 

Profile 
The Profile option allows you to create and re-use sets of live image/image capture settings.  When you 
open the 3rd Party interface, the Default Profile is selected.  When you make changes to any of the live 
image/image capture settings, these changes can be saved to a Profile – either the Default or one that you 
have defined.  For example, if you gamma adjust a live image and then decide that the result is ideal for the 
type of specimen you are working with, you could create a new Profile with the gamma and exposure 
values and name it for that type of specimen – i.e., “Diseased Cells.”   

When you close the SPOT Camera window, the program prompts you to save changes.  Carefully 
consider the effect of your choice:     

• Clicking Yes modifies the Profile according to the adjustments that you made.  Future image captures 
taken with that Profile will reflect these changes.  For example, if you rotated a live image, and then 
clicked Yes after closing the window, all future captures taken with that Profile would be rotated in the 
same way. 

• Clicking No retains the original values of the Profile.  This allows you to maintain a unique set of 
image view and capture settings that can be re-applied to future captures of similar specimens.   

To add, edit, or delete Profiles, right-click on the Profile box.  Right clicking gives the following options:  

• Add – Add a new Profile.  When you add a new Profile, the program prompts you to name it. 
• Save – Save a Profile that you have modified. 
• Rename – Rename an existing Profile. 
• Delete - Deletea Profile.  This option appears only after you have defined a second Profile in addition 

to the Default Profile.   
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Exposure: Auto or Manual 
The Exposure option gives you the choice of having the camera calculate exposure time (Auto), or setting 
the exposure on your own (Manual).   The exposure options will vary according to whether you select 
Auto or Manual, as illustrated below. 

Auto Manual 

  

When you enter one of the above exposure settings, note that it applies both to the live image that you are 
viewing and the captured image.  

Auto Exposure options 

Image Type 
An Image Type tells the SPOT program how to expose and process image captures. Each of the 11 
available Image Types (see below) corresponds to a microscopy technique: select the Image Type that 
matches the technique you are using.  The camera will capture the image accordingly. The table below 
describes typical situations for each image type. 

Image Type Description 

Brightfield-transmitted light Stained specimens on glass slides using transmitted light microscopes. 

Darkfield-transmitted light Bright specimens on dark backgrounds using transmitted light darkfield technique. 

Fluorescence Fluorescence specimens not fluorescing in a single red, green, or blue primary color  

Nomarksi DIC/Hoffman Specimens being viewed with either Nomarski DIC or Hoffman techniques. 

Phase contrast Specimens being viewed using the phase contrast technique. 

Polarized light Specimens being viewed with polarized light techniques. 

Brightfield-reflected light Polished metallurgical specimens and semi-conductors using a microscope with a 
vertical illuminator. 

Darkfield-reflected light Bright areas of specimens being viewed with darkfield, reflected light techniques. 
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(cont.) 

Image Type Description 

Stereo/macro–no glints Matte specimens without bright glints. 

Stereo/macro–shiny glints Shiny specimens with bright glints. 

Stereo/macro-metallic glints Metallic specimens with intense glints. 

Brightness 
Enter a Brightness value between .25 and 32.   
A brightness value of 1, the default value, gives you the correct image brightness for most images.  The 
Brightness control allows you to overexpose or underexpose (darken or lighten) the image area.  In many 
cases, an image has varying levels of brightness; to see a specific area better you might want to lighten or 
darken the image.  When using the Brightness control, the SPOT camera uses an algorithm that combines 
gain and exposure time to provide the fastest possible image update rate (shutter speed) in live mode: 
• When overexposing images to make them brighter (i.e., entering values greater than one), the camera 

first selects the highest possible gain before lengthening the exposure time.  Because gain also 
brightens an image, less exposure time is needed. 

• When underexposing images to make them darker (i.e., entering values less then one) the camera uses 
the lowest possible exposure time before lowering the gain. 

Quality/Speed (Auto) 
Use the slider to balance speed and quality when previewing dim images.  
• Moving the slider toward the Quality side increases image quality and decreases frame rates. 
• Moving the slider toward the Speed side increases frame rates and decreases image quality. 

The Quality/Speed measurement corresponds to the Auto-Gain limit setting, which allows you to set an 
upper limit on the gain options that will be available during the Auto-Exposure process.   

• When the slider is at the left-most point, the Auto-Gain Limit is  1, which restricts the camera to a gain 
of 1, giving you higher quality pictures, but lengthier exposure times.   

• When the slider is at the right-most point, the Auto-Gain Limit is 32, which allows the camera to select 
from the all six gain options.  This shortens exposure times, but decreases image quality. 

Refer to the “Understanding Gain and Auto-Gain Limit” section in Ch. 2 – Preparing to Take a Picture for 
a detailed explanation of gain and exposure.  

Gamma 
Enter a Gamma value between .1 and 4.    
Gamma adjustment smoothly lightens darker areas of an image without burning out bright areas or 
lightening black areas.  This is especially useful for capturing/editing images with a wide range of 
brightness values (dynamic range) such as fluorescence specimens or macroscopic objects with glints, (e.g., 
printed circuitry).  

• Values between 1 and 4 lighten the darker areas of the image. 
• Values between .1 and 1 darken the mid-tones of the image. 
Gamma adjustments on live images are made in the RGB color space, the only color space where 
adjustments can be made quickly enough to keep up with live imaging.  Refer to Ch. 2 – Preparing to Take 
a Picture for more details on gamma adjustment and color spaces. 
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Manual Exposure Options 

Exposure Time 
Use the slider-bar to specify an exposure time between .04 ms and 526.746 sec.  
When you specify an exposure time, the camera skips the automated exposure sequence that takes place 
when you open the live image view – i.e., the 3rd Party interface.  This is very useful in cases where 
exposure times are lengthy, as with fluorescence samples. 

Gain 
Enter the precise gain that the camera will use for an image capture.  Use the slider-bar to select one of the 
six gain options: 1, 2, 4, 8, 16, or 32.  The gain value displays to the right of the slider-bar.  Refer to the 
“Understanding Gain and Auto-Gain Limit ” section of Ch. 2 – Preparing to Take a Picture for details on 
gain and exposure.  

Gamma 
The manual Gamma adjustment is identical to the auto Gamma adjustment (see above.) 

White Balance 
White balance is the ratio of red, green, and blue gains necessary to achieve the proper color rendition for 
an image.  Many factors impact the coloration of an image capture, including lamp voltage, the coloration 
of the glass used in the slide, and the coloration of the glass used in the lenses of the microscope’s 
objectives.  To minimize the impact of these factors, use the White Balance feature.   When you perform a 
white balance calculation, SPOT samples the color of the light from your light source after it has passed 
through the slide and the objective, and then calculates the red, green, and blue gains needed to produce 
images where the white areas are white and the color areas are true.   

You should perform a new white balance calculation when: 

• Starting a new image capture session. 
• Changing the lamp voltage. 
• Switching to a different objective on the microscope.  

To perform a white balance, follow these steps: 

1. Set the illumination and the objective that you will use for the image capture. 

2. If you have not done so, select your Image Type (see above).  Each Image Type has its own set of 
white balance values.  Any white balance values that you compute for an image type remain linked to 
that image type until you compute new values.  When selecting a new image type, remember that you 
will be using the white balance values linked to that image type. 

3. Click on the White Balance button. 

4. Show the camera a sample of white light.  This step varies according to microscopy technique and 
Image Type (sample), as shown in the table below: 
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Image Type White Balance Technique 

Brightfield-
transmitted light 

Position the slide so that the specimen is not in the field of view, but light is going through the slide 
near the specimen. 

Darkfield-
transmitted light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield –
transmitted light above. 

Fluorescence Use the Match Color feature (see above) 

Nomarksi 
DIC/Hoffman 

For Nomarski DIC: Adjust the Nomarski prism until the image is in either the “brightfield” or the 
“gray scale” view. 

For Hoffman: Perform the white balance directly on the Hoffman image. 
Phase contrast Position the slide so that the specimen is not in the field of view, but light is going through the slide 

near the specimen. 

Polarized light Pull all polarizers and compensators out of the light path and then position the slide so that the 
specimen is not in the field of view, but light is going through the slide near the specimen.  

Brightfield-
reflected light 

Replace your sample with a mirror. 

Darkfield-
reflected light 

Perform the white balance using the brightfield mode on your microscope.  See Brightfield – 
reflected light above. 

Stereo (all three 
options) 

Using an EPI-illuminator (shining a light on the top of your specimen from off to one side), replace 
your sample with a white sheet of paper. 

5. Click on Begin to start the calculation.  The camera computes the white balance values, and they are 
automatically saved to the image settings for the image type that you selected. 

Match Color 
The Match Color feature is typically used in two situations: 
• You want to change the colors of an image on the screen to match the way that you think the specimen 

looks. 
• You want to set the white balance for pictures taken with a microscopic technique that never has white 

in its images.  A prime example of this situation is fluorescence microscopy.  

To use the Match Color feature, follow these steps: 
1. Click on the Preview button to capture an image.  The Match Color option remains inactive until a 

preview image is captured. 
2. Select Match Color.  The cursor becomes an eye-dropper.   

3. Using the mouse to move the eye-dropper, position it on the pixel location of the color that you want to 
match.  The R, G, and B values of the pixel that you select must all be less than 255. 

4. Click on the pixel.  The Match Color dialog appears with information about the pixel that you 
selected: 
− Hue – The actual color, as distinguished from others in the color spectrum.  Hue is derived from 

a color wheel and is expressed in the color's angular location (e.g., 0 to 360 degrees). 
− Saturation - The proportion of perceived pure hue in the color.  Saturation (in the SPOT 

software) is measured on a numerical scale of 0 to 100, where zero equals pure gray and 100 
equals pure hue (e.g., “day glow”). 

5. Move the cross-hairs to the desired color either by clicking on the new location or clicking and 
dragging.   As you move the cross-hairs, the color in the image changes accordingly, allowing you to 
preview the color before you save the image.  Alternatively, you can click on the Make White/Grey 
button to automatically white balance the image. 

6.   Click on Ok. 
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Chip Imaging Area 
SPOT allows you to use any rectangular portion of the CCD chip for image capture.  Using a portion of the 
chip is helpful in cases where you want to: 

• Keep file sizes small. 
• Shorten download times. 
• Avoid areas of the image with optical problems (e.g., vignetting).   
There are three image area options: 
• Full Chip – Capture the entire area of the CCD chip.   

• Center – Capture a rectangular part of the CCD chip’s area that has the same height - to - width ratio 
as the full chip, and is centered on the center of the full chip.  The percentage that you enter is the 
percentage of full chip width that the new area’s width will be. 

To capture a centered proportion of an image, follow these steps: 
a) Check the Center option. 
b) Enter the percentage of the image that you want to capture.  The minimum percentage is 10 and 

the maximum is 100. 
c) Capture the image. 

• Selection –Capture a specific part of the CCD chip.   
a) Check the Selection option. 
b) Use the mouse to select a region for capture.  Click and drag to define the selection.  Note that the 

new pixel dimensions display in the status bar. 
c) Capture the image.  

When you are viewing a live image Selection, how this selection is displayed, depends on two other 
settings: the Fit to Window option (see below) and the Always Show Full Chip in Live Mode preference 
(see above).  The following table illustrates the possibilities: 

Fit to Window 
Checked? 

Always Show Full Chip  
in Live Mode Checked? 

 
Selection Display 

 Live or  
Captured Image 

YES YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle. 

LIVE 

YES NO When you select a portion of the chip the cursor 
is a zoom tool.   To zoom in on a portion of a 
live or captured image, click and drag over the 
area that you want to zoom in on.   To return to 
the non-zoomed image, click on the Full Chip 
option.  

BOTH 

NO YES When you select a portion of the chip, the 
selection is outlined with a yellow rectangle.  
However, because Fit to Window is not 
checked, you will not see the entire chip in the 
window. 

LIVE 

NO NO When you select a portion of the image, the 
cursor is a cropping tool.  If you select a portion 
of an image, the program displays only the 
selected area and discards the rest of the image. 
To return to the non-cropped image, click on the 
Full Chip option. 

BOTH 
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Auto-Brightness (Auto, Live Images) 
Available only when you are using Auto exposure and viewing a live image, the Auto-Brightness option 
enables you to maintain a consistent brightness level for changing specimens.      

Faster Readout (Live Images) 
Faster Readout enables you to “speed up” the live image display (higher frame rates) in cases where you 
are willing to sacrifice some resolution for a higher frame rate.  

Flatfield (Captured Images) 
For all other SPOT camera lines, the Flatfield Correct option is used to correct for display problems 
associated with uneven intensity or coloration in illumination, or to correct for artifacts (e.g., dust) in the 
optical system.  Flatfield can still be used for this purpose with SPOT Vision cameras.   But, because SPOT 
Vision cameras use a color mosaic chip, Flatfield correction serves a new primary purpose.  In the 
production process for color mosaic CCD chips, the RGB colors are applied directly to the pixels on the 
chip.  This process often results in an uneven color density around the outer 30-40 rows of the CCD chip, 
causing a “halo” appearance in some image captures, particularly those with low contrast.  The Flatfield 
option can be used to correct this  problem.   

# Note:  Flatfield correction with the SPOT camera refers only to the correction of uneven 
lighting.  It should not be confused with the correction of optical field flatness. 

Flatfield correction works by taking a picture of the brightfield background without the specimen in the 
field of view.  This image lets the SPOT software know, on a pixel-by pixel basis, which areas in the field 
of view are receiving less illumination than the brightest areas. When taking a picture that contains a 
specimen, the software uses this information to accurately increase the brightness of each pixel in the dimly 
illuminated areas.  The resulting image gives the appearance of an even illumination. 

To use the Flatfield option, follow these steps: 

1. Ensure that the specimen is under the desired objective and in focus.  

2. Control-click on the Flatfield drop-down list and click on the Add option.  The Get Flatfield dialog 
appears. 

3. Remove the slide from the field of view. 

4. Click on Begin.  When the program finishes computing the exposure times and acquiring the flatfield 
file, the Flatfield dialog prompts you to name the file: 

a) Enter a name.  Because flatfield image files are different for each objective, you might want to 
name the file according to the objective's magnification (e.g., 10x).  

b) Click on OK.  If you do not specify a location, the program automatically saves the flatfield file to 
the c:\SpotCam\Fltflds directory. 

# Note:  The default file location varies, depending on where you installed the SPOT program. 

5. Move the specimen back into the field of view, and perform the image capture, using either the 
Preview or the Acquire option. 
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Color Enhancement (Captured Images) 
The Color Enhancement option optimizes image captures by closely matching the final capture to the 
image as seen through the microscope.  To optimize the final image, the SPOT program processes the raw 
image data to produce a final image that matches the view seen through the microscope.  

If you want an image capture to match the live image view, you will want to leave Color Enhancement off.  
Color Enhancement applies only to captured images. 

Fit to Window 
In addition to automatically resizing images to fit within the live image window, the Fit to Window option 
also determines cursor behavior in the live image view. 

• When the Fit to Window option is checked, the live image window cursor becomes a zoom tool.  To 
zoom in on a portion of a live image, click and drag over the area that you want to zoom in on.   To 
return to the non-zoomed image, click on the Full Chip option. 

• When the Fit to Window option is not checked, the cursor is a cropping tool.  If you select a portion of 
an image, the program displays only the selected area and discards the rest of the image. To return to 
the non-cropped image, click on the Full Chip option. 

These points apply only when the Always Show Full Chip in Live Mode (see above) is not selected.  For 
more details, refer back to the Chip Imaging Area section (see above). 

More (Additional Orientation and Exposure Settings) 
When you click on More, the 
program displays a dialog of 
additional orientation and 
exposure settings for the 3rd 
Party Interface, as shown at 
right.   

Flip 
Specify whether images will be flipped in the live image view and during the image capture process.  

• Select Horizontal to flip the image from left to right. 
• Select Vertical to flip the image from top to bottom. 
• Select both options to flip the image from left to right and from top to bottom. 

Rotate 90°°°° 
Specify whether images will be rotated in the live image view and during the image capture process. 

• Select None if you do not want the image to be rotated.  
• Select Right to rotate the image clockwise 90 degrees. 
• Select Left to rotate the image counterclockwise 90 degrees.    
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   16.6 ms per cycle

8.3 ms
per cycle

SPOT Power Line
Frequency (60 Hz)

Fluorescent Light
Output Frequency

Exposure < 8.3 ms

Minimum Exposure > 10 ms

 Setting a Minimum Exposure to  
Accommodate Varied Light Sources  

Exposure Limits – Minimum 
Because SPOT Vision cameras are 
capable of extremely short exposure 
times, light sources with intensities 
that vary with the waveform of the 
60 Hz line supply (e.g., fluorescent 
lamps, 120 volt incandescent bulbs, 
and 6 volt 20 watt halogen lamps) 
can cause the Live Image window to 
flicker and result in incorrect 
brightness and color balance 
readings in captured images. This 
option allows you to correct for 
these problems by limiting the 
camera to a minimum exposure time 
that is greater than the pulse interval 
of the light source.  Consider the 
illustration to the right. In this case, 
the pulse interval of the fluorescent 
light source is 8.3 ms.  Entering a 
Minimum Exposure of 10 ms ensures that the 
camera’s exposure time is greater than the 
pulse interval of the light source.  To enter a 
minimum exposure, check the Minimum box, and enter a value in milliseconds.   

Exposure Limits – Live Image Maximum 
Because The Live Image Maximum option helps you to avoid unnecessarily long exposures when viewing 
a live image.  Consider the following situation: When you change from a lower resolution objective to a 
higher resolution objective, the camera detects a brief interval of blackness.  When the Auto-Brightness 
option (see above) is enabled, it compensates by modifying the exposure time to maintain a constant 
brightness level.  This results in you having to wait for the camera to compute a lengthy and incorrect 
exposure for the black interval.  Using the Live Image Maximum option, you can limit this exposure time. 
For most cases, Diagnostic Instruments recommends a value of 0.5 seconds. 

Similarly, the Live Image Maximum option can also be used in cases where the microscope’s light path 
selector is incorrectly set.     

Noise Filter 
The Noise Filter corrects for the effects of electrical or thermal noise. When capturing dim images with 
lengthy exposure times, the noise filter acts as a “virtual cooler” for the Vision camera, eliminating “hot 
pixels.”   

The Noise Filter checks each pixel on the CCD chip as described below: 

1. The program compares the value of each red pixel with the values of the eight neighboring red pixels. 

2. If none of the eight neighboring red pixels has a value within ±15 %  (i.e., the threshold value that the 
SPOT program uses) of the value for the red pixel being checked, the value for the red pixel being 
checked is replaced with the average value of the eight neighboring red pixels.
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3. The program repeats this procedure for the values of the green and blue pixels being checked.  

To activate the Noise Filter, check the Noise Filter box.  The program runs the noise filter each time an 
image is captured using the Preview or Acquire options. 

Taking a Picture 
From the SPOT 3rd Party Interface, you can capture images in different ways: 

• Preview - You can capture a Preview image.  Preview images remain available in the 3rd Party 
window for basic editing and serve as the basis for the final image capture.  When you click on the 
Preview button, the Get Image dialog displays the capture status as it is captured, and the captured 
image then replaces in the Live Image in the window.  Note that the status bar indicated that you are 
viewing a Preview image.     

• Transfer - If you like the Preview image, you can Transfer it image directly to the third party 
application that you are using.  The Transfer button is active only for Preview image captures.    

• Acquire - Capture an  image and have it automatically transfer to (open in) the third party imaging 
application.   
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Introduction 
This appendix is a brief overview of the operational theory behind SPOT digital cameras. The next two 
sections, Digital Photography and Color Images, provide a short introduction to electronic imaging theory; 
the following section describes how this theory applies to the SPOT cameras. 

Digital Photography 
Modern electronic imaging is based on the charged coupled device (CCD).  All of today’s digital cameras 
have a CCD chip or chips.  In digital cameras, the CCD chip/sensor replaces the film of traditional cameras 
as the means by which the camera records the image. The surface of the CCD chip is composed of light-
sensitive cells arranged in a checkerboard pattern.  Each cell of the checkerboard is known as a picture 
element, or more commonly, a pixel.  The following is a simplified description of what happens when you 
take a picture with a digital camera:   

1. The camera’s optical system forms images on the “checkerboard” of pixels. 
2. The CCD is exposed to the image for a period of time.   

During this period, each photo-sensitive cell receives photons of light, converts the photons to 
electrons, and then stores the electrons in the cell.  The process by which each cell accumulates 
electrons can be compared to a well filling with water.  As more light hits a cell, the electron level in 
the well rises.  The more electrons that are in the cell, the more voltage it will have when read by the 
digital camera. 

3. Following the exposure, a digital camera does three things: 
a. It measures the voltage of each cell. 
b. It converts the voltage to a binary number. 
c. It transmits this number down a cable to your computer.  

4. The computer reconstructs the image by assigning a brightness value to each pixel in the final image.  
Each brightness value is proportional to the voltage of the corresponding cell on the CCD chip. 
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Color Images 
Because a CCD chip is inherently monochromatic (black and white), color filters must be used to extract 
the color information from the image. There are three basic design methodologies.    

• Single CCD design using color masked pixels (SPOT Insight and Vision cameras) 
Digital cameras designed in this manner have one CCD chip with color filters physically bonded to 
each pixel on the chip.  Some pixels get red filters, some pixels get green filters and some pixels get 
blue filters.  Since each pixel is only able to measure the intensity of one color, the intensity of the 
missing two colors for this pixel must be estimated, based on nearby pixels that have precise 
measurements of the missing colors.  For example, a pixel that has a green filter will have an exact 
measurement of the green color value, but the red and blue values must be estimated, based on the 
nearest red and blue pixels.  This estimation is known as interpolation.   

Pros and Cons: A digital camera designed in this way is inexpensive and can freeze moving images 
with a single exposure.  However, because they interpolate brightness values, such cameras cannot 
provide as high of a resolution as that provided from a non-filtered CCD chip.  

• Three CCD design using color beamsplitter  
This design uses  three CCD chips. The incoming image first goes through a color beam splitter which 
directs the red light to one chip, the green light to a second chip and the blue light to a third chip.  The 
chips are very accurately aligned so as to achieve near perfect registration between the three chips. The 
red, green, and blue values for each point on an image are measured by the corresponding pixel on 
each of the three chips.   

Pros and Cons: This design produces an image that retains the high resolution of the individual chips.  
This type of camera can also freeze moving images with a single exposure.  However, because most of 
the cost in a high resolution CCD camera is in the CCD chip itself, three chip cameras are far more 
costly than their single chip counterparts. 

• Single CCD design that takes three pictures (three pass method) (SPOT and SPOT RT cameras) 
Cameras designed in this way expose a single CCD chip three times, once to red light, once to green 
light, and once to blue light.  One variant in this type of camera is how the chip is exposed to the 
different colors of light.  Some cameras switch individual red, green and blue glass filters in front of 
the chip for each exposure.  Others use a liquid crystal filter that changes from red to green to blue as 
different voltages are applied to it.  By exposing the chip three times, each cell on the CCD is able to 
measure all three color values.   

Pros and Cons: This technique attains the high resolution of the three CCD design without the high 
cost associated with using three chips.  However, because these  cameras require three exposures, they 
cannot freeze moving images. 
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SPOT Digital Cameras 
In order to provide you with an understanding of what happens when you take a picture, the following 
sections highlight some of the basic operating principles of SPOT cameras.   

Pixel Digitization 
Following each exposure, SPOT reads the CCD chip and digitizes each pixel as it comes  off of the CCD 
chip, and before it is sent through the cable into the computer.  This technique minimizes noise and 
maintains the lack of distortion that is inherent with CCD chip geometry.   The SPOT Insight cameras use 
two methods of pixel digitization, one for live imaging, and one for image capture: 

• Live imaging (Insight, RT, and Vision) 
To provide the fastest possible frame rate, SPOT Insight, RT, and Vision cameras use two separate 
circuits to digitize the left and right halves of the CCD simultaneously.      
Pros and Cons:  This method provides an extremely fast display when using SPOT’s Live Image 
feature.  The challenge comes in achieving a good brightness match between the two image halves.  
Our current algorithm achieves a good match with  bright images.  However, with dim images, 
mismatches can occur, resulting in a “split” appearance, where one half of the image is brighter that 
the other half.  A “split” Live Image view is not indicative of what your image capture will look like. 

• Image capture (all SPOT models) 
To provide the most accurate image captures,  SPOT cameras use a single circuit to digitize the entire 
CCD chip. 
Pros and Cons:  Because a single circuit is used to digitize the entire CCD chip, all pixels are 
inherently matched.  However, this method provides a slower download than the two circuit method 
used for live imaging.   

Gain  
Normally an auto exposure routine in a digital camera sets the exposure time so that the brightest pixel on 
the CCD chip is completely “filled” with electrons, or is “full well” (see the Digital Photography section).  
This simple technique works well for bright images, but, as an image gets dimmer, exposure times can get 
uncomfortably long. 

With the SPOT camera you can shorten exposure times by filling the brightest pixel on the CCD chip to 
less than full well, and then using this lower level as full scale.  The inverse fraction of full well that the 
brightest pixel on the CCD is filled to is known as the gain. For example, filling a pixel to half of full well 
cuts the exposure time in half.  Since the exposure time is cut in half, we call this a gain of 2. 

The following table illustrates the relationship between gain, the fraction of full well that the brightest pixel 
is filled to, and the effect of gain on exposure time: 

Gain  Fraction of Full Well Exposure Time (sample) 

1 1 80 seconds 

2 ½ 40 seconds 

4 ¼ 20 seconds 

8 1/8 10 seconds 

16 1/16 5 seconds 
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An 80 second exposure at a gain of one turns into a 5 second exposure at gain 16.  This is good in terms of 
the exposure time.  Unfortunately, background noise is directly proportional to gain.  It is 16 times higher at 
a gain of 16 is than at a gain of one. 

An Automated Exposure Process 
Normally, for any given image, trial and error would have to be used to determine the optimal 
combinations of gain and exposure time.  In order to eliminate the need for trial and error experimentation, 
the SPOT camera automatically determines this information by sampling light levels before each exposure.  
Based on the light levels and the user-determined Auto-Gain Limit, SPOT determines the optimal gain 
setting and exposure time for the image.  For details on using the Auto-Gain Limit feature, refer to Ch. 2 – 
Preparing to Take a Picture. 



Appendix B Specifications 

 

User Guide to the SPOT Vision Camera 119 

Appendix B: Specifications 
Camera and Filter 
Vision Color – Color 
Vision B/W – Monochrome 

CCD Information 
Vision Color – KAI 2000 Color Mosaic 
Vision B/W – KAI 2000 Monochrome 
Imaging Area – 11.8mm x 8.9mm 
Active Pixels – 1600 x 1200 (1.92 million) 
7.4 µm square pixels 
Full well charge capacity - 31,500e 

Vision Color Image Resolution 
Live image – 800 x 600 
Captured image – 1600 x1200 

Vision B/W Image Resolution 
Live image – 1600 x 1200 
Captured image – 1600 x1200 

Bit Depth – Vision Color 
Sampled at 30 bit RGB 
Saved file formats: 24 bit (RGB) 

Bit Depth – Vision B/W 
Sampled at 10 bit monochrome 
Saved file formats: 8 bit (mono) 

Pixel Readout Rate 
Live images – 36 Mhz (2 channel x 18 Mhz) 
Captured images – 18 Mhz (1 channel x 18 Mhz) 

Live Image Frame Rate 
733 PIII w/810e Graphics 
Vision Color - 15 frames/s 
Vision B/W – 15 frames/s 

Acquisition Time to Monitor 
(processor dependent) 
Vision Color < 6 seconds 
Vision B/W < 1 second 

A/D Converter Full Scale Setting 
31,500e (when gain = 1) 

Signal to Noise Ratio 
58 dB 

Anti – Blooming Factor 
300 times (nominal); 100 times (minimum) 

Exposure 
Automatic and User-Defined 
Range – 1 ms – 536 seconds 
(1 saturated hot pixel @ 5 sec. typical) 

Lens Mount 
“C” Mount 
Flange to rear lens clearance - 0.46” (11.7 mm) max. 

Computer Interface 
PCI bus card (supplied) 

External Shutter Control 
BNC, TTL level output 

Power Requirements 
100 –240 VAC, 47 – 63 Hz 

Weight 
Camera - 1.5 lbs. 
Power supply - 0.5 lbs. 

Certifications 
CE, FCC, Class A 

Computer Requirements 
PC - Pentium 166 or greater  Mac – Power PC w/PCI bus 
 Windows 95/98/00/NT/ME/XP   Mac OS 8.6 or greater 
RAM – 64 Mb RAM required, 256 Mb recommended. 
Video card – Support of 24 bit RGB at the desired monitor 
resolution. 

Software Features 
• Color live image window 
• Image capture window 
• Pre-defined image types 
• Auto exposure 
• Auto white balance 
• Flatfield correction 
• Zoom and pan window 
• Image enhancement tools 
• Annotation 
• Calibration mark 
• Measurement – length, perimeter area, angle 
• Print layout dialog 
• On-line help menu 
• Report generator 
• Sequential imaging 

Image File Formats 
TIFF, TIFF-JPEG, JPEG, JPEG 2000, BMP, PICT 

File Size 
 Vision Color   Vision B/W 
24 bit - 5.49 MB   8 bit    -  1.83 MB 
Drivers  
TWAIN for Windows  

Couplers   
D10XXC – 1x C-Mount Coupler (Diagnostic Instruments) 
Alternatives made by Diagnostic Instruments: 
• HRU060-CMT coupler (0.60x) and the appropriate bottom 

clamp. 
• HRD100-CMT coupler (1x) and the appropriate bottom 

clamp. 

Lens 
C- Mount lens for 1” format CCD 
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Camera Dimensions 

 

2.79"

 

5.11"

.65"

.30"  

Power Supply Dimensions 

3.350"

1.970"

 

1.300"
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Vision Series Catalog Information 
There are two cameras in the SPOT Vision series of cameras: Vision Color and B/W (monochrome).   The 
following table shows each camera with the standard and special order options: 

Catalog Part 
Numbers 

Model 
Number 

 
Description 

Stock/Special 
Order 

IN820 8.2 SPOT Vision Color “C” mount camera 
with IR filter 

Stock 

IN810 8.0 SPOT Vision B/W  (monochrome)  
“C” mount camera  

with IR filter 

Stock 

IN800 8.0 SPOT Vision B/W (monochrome)  
“C” mount camera  

without IR filter  

Special Order 

 

FCC “Class A” Product Warning  
All SPOT cameras fall into the Class A category of the FCC (Federal Communications Commission) 
emission standard EN55022/CISPR22.  The following is the FCC’s standard warning for this type of 
device:    

WARNING: 
This is a Class A Product.  In a domestic environment this product may cause radio interference 
in which case the user may be required to take adequate measures.



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

INTENTIONALLY BLANK 



Appendix C Keyboard and Toolbar Button Commands 

User Guide to the SPOT Vision Camera 123 

Appendix C: Keyboard and Toolbar Button 
Commands 

 
Command 

Keystroke or 
F-key 

Toolbar 
Button 

Windows and/or Mac 

 

Open Image File [F3] 

�������������������������������
������������������������������� 

�����
�����

������
�������������������������������������������� Both 

Show Image File Thumbnails [F5] 

�������������������������������
�������������������������������
������������������������������� 

�����
�����
�����

������
������
������ Both 

Save [F2]  Both 

Save As [Ctrl] + [A]  Windows 

Save All [Ctrl] + [F3]  

�������������������������������
�������������������������������
������������������������������� 

�����
�����
�����

������
������
������ Windows 

Close [Ctrl] + [F4] 
! + W  

�������������������������������
������������������������������� 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Print [Ctrl] + [P] 
! + P  

 

Both 

Exit 
Quit 

[Alt] + [F4] 
! + Q 

�������������������������������
�������������������������������

 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Edit menu 

Undo [Alt] + Bksp 
! + Z 

�������������������������������
������������������������������� 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Copy to Clipboard [Ctrl] + [C]  
! + C 

�������������������������������
������������������������������� 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Add Measurement [Alt] + [M] 
! + M 

�������������������������������
������������������������������� 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Sequence menu 

Play Forward [Ctrl] + [Space]  
! + [Space] 

�������������������������������
�������������������������������
������������������������������� 

�����
�����
�����

������
������
��������������������������������������������

��������������������������������������
Both 

Play Reverse [Ctrl] + [Bksp]  
! + [Bksp] 

�������������������������������
������������������������������� 

�����
�����

������
��������������������������������������������

��������������������������������������
Both 

Stop Play/Resume Play [Enter] 
�������������������������������
������������������������������� 

�����
�����

������
������ Both 

Step Forward [Space] 

�������������������������������
�������������������������������

 

�����
�����

������
������

Both 

Step Back [Backspace] 
�������������������������������
������������������������������� 

�����
�����

������
������ Both 



Keyboard and Toolbar Button Commands Appendix C 

124 User Guide to the SPOT Vision Camera 

(cont.) 
 

Command 
Keystroke or 

F-key 
Toolbar 
 Button 

 
Windows and/or Mac 

View menu 

Fit to Window [Ctrl] + [F] 
! + F  

���������������������������������������
��������������������������������������� 

�������
�������

������
����������������������������������������������������

����������������������������������������������
Both 

����������������������������������������������

Zoom [Ctrl] + [Z]  

 

Both  
(Macs – button only) 

Show Gridlines [Ctrl] + [G] 
! + M 

���������������������������������������
���������������������������������������
��������������������������������������� 

�������
�������
�������

������
������
���������������������������������������������������� Both 

Show Pan Window [Ctrl] + [W]  

 

Both  
(Macs – button only) 

Image Date/Tme [Ctrl] + [T] 
! + T  

���������������������������������������
��������������������������������������� 

�������
�������

������
����������������������������������������������������

����������������������������������������������
Both 

Full Screen [F 7] 

 

Both 

 
���������������������������������������������������������
��������������������������������������������������������� 
����
����

����
����������������������������������������������������������������   

Camera menu 

Live Image [F11] 

 

Both 

 Get Image [F9] 

 

Both 

Compute White Balance Values [Ctrl] + [F10] 

 

Both 

Setup menu 

Show Image Settings 
���������������������������������������������������������
��������������������������������������������������������� 
����
����

����
����������������������������������������������������������������

������������������������������������������������������������
������������������������������������������������������������  

Both 
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Appendix D: Selected Error Messages 
In the following table, unless indicated, the error messages apply to all SPOT camera models and to both 
Windows and Mac operating systems. 

Error Message Cause(s) and Solution(s) 

A file could not be found 
(Mac) 

Something went wrong in a file operation, usually due to a disk error.  
Reboot the computer. 

At Least One Exposure 
time must be specified 

You defined your image setup as “User-Defined” (see Ch. 5), but did not 
enter exposure times. 
Enter the exposure times or use the Compute Exposure option to have the 
camera compute exposure values for you.  If you have captured an image 
previously, you can use the Recall Previous Exposure option. 

Camera Error There is damage to the camera head or the shutter is malfunctioning.  
Contact Diagnostic Instruments. 

Error deleting file 
(Mac) 

Something went wrong in a file operation, usually due to a disk error.  

Reboot the computer. 

Error modifying registry Same as above 

Error reading camera 
information  
(RT cameras only) 

There is damage to the camera head, problems with the interface card, or a 
bad connection cable 

Contact Diagnostic Instruments. 

Error reading file 
(Mac) 

Something went wrong in a file operation, usually due to a disk error.  

Reboot the computer. 

Error writing file 
(Mac) 

Something went wrong in a file operation, usually due to a disk error.  

Reboot the computer. 

Exposure time too short 
for camera 

The brightness of the image requires an exposure time that is too short for 
the camera.   

Add a neutral density filter to dim the image without changing the color 
balance. 

Flatfield file is 
incompatible with image 
setup 

The pixel bit depth (bpp) of your image setup does not match the pixel bit 
depth of the flatfield file (e.g., the image setup is 8 bpp and the flatfield file is 
24 bpp).  
Modify either the image setup or the flatfield file so that the two match. 

Images have different bit 
depths 

The images that you are trying to merge, add, or subtract have different 
pixel bit depths. 
Change one of the images so that their pixel bit depths are the same. 
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Images must have the 
same dimensions 

The images that you are trying to merge, add, or subtract are two different 
sizes.  This may be because you cropped or binned an image for viewing 
purposes. 
Ensure that the two images have the same dimensions. You might simply 
use un-cropped/non-binned versions of the images. 

Image too dim There is not enough light to capture the image.   
This error message appears for various reasons, so you might have to 
experiment to increase the light.  Possible solutions include: 
• Adjusting the microscope settings to let in more light 
• Binning the image (see Ch. 5) to increase camera sensitivity 
• For RT Slider users, sliding the color filter to the B/W position 

JPEG Quality value must 
be between 1 and 100. 

When saving an image, or defining database (Ch. 9) or sequential image 
(Ch. 6) preferences, you entered a value less than one or greater than 100 
(for a JPEG or TIFF JPEG format image). 

Re-enter a value between one (highest compression, lowest quality) and 
100 (lowest compression, highest quality). 

Memory is getting full. 
Please try to alleviate the 
problem by closing some 
documents. (Mac) 

The system is running low on memory. 

Increase the memory allocation for the SPOT program. 

No response from the 
camera.  Make sure the 
camera is connected and 
the power is on  

(when you first try to open 
the SPOT program) 

This message appears for various reasons.  The most typical are: 

• The power supply is not turned on. 

• The PCI board is not seated properly. 

• A cable is loose. 

Turn on the power supply, ensure that the PCI card is properly seated, or 
ensure that  the cables are firmly connected to the camera/computer/power 
supply.  Refer to the Installation Guidelines section of the manual for details 
on installing the PCI card and connecting the camera to the microscope and 
computer. 

Not a supported bit depth 
image 

You tried to open an image with a pixel bit depth that is not supported by the 
SPOT software. 

Using another imaging program change the pixel bit depth of the image to 
one of the four depths that the SPOT program supports: 8, 12, 16, 24, 36, or 
48.  Note that while 16 and 48 bit per pixel images can be opened by the 
SPOT program, they are treated as 12 bit per channel images. 

Out of Memory (Mac) The system is running low on memory. 

Increase the memory allocation for the SPOT program. 
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Place the color filter in the 
‘Color’ position 

Place the color filter in the 
‘B/W’ position 

(RT Slider only) 

These messages appear when you are trying to capture an image and the 
position of the sliding color filter does not match the image setup filter 
definitions.  For example, you will see this message if  you selected the Use 
Color Filter option for the image setup, but the sliding filter is out (in the B/W 
position).  Note that you will see this message only if the Monitor Camera 
Color Filter Preferences option is selected on the Preferences window.The 
camera will not allow you to capture an image without correcting this 
discrepancy. 

Either move the filter to the correct position, or change the image setup 
definition to match the position of the color filter.  Alternatively, you can 
deselect the Monitor Camera Color Filter Preferences option and the 
program will not prompt you with error messages. 

Printer Error The printer software is not installed.  
In order for the SPOT program to work correctly, you must have a print 
driver installed on your system.  The printer does not necessarily need to be 
attached to the computer, but the drivers need to be installed.   

Install a printer driver – follow the manufacturer’s instructions for installing 
the printer that you plan to use. 

Software is incompatible 
with camera hardware 

The causes of and solutions to this error message, which appears when you 
try to run the SPOT program for the first time, vary according to the camera 
model: 

• For both RT and non-RT cameras, this message appears if, during the 
installation process, you specified the wrong interface card for the 
camera.   
Reinstall the SPOT software and specify the correct interface card. 
Refer to the Installing the Software section of the Installation Guidelines 
chapter for more details. 

• For non-RT cameras, this error message indicates that the chipinfo.dat 
file is from an earlier version of the SPOT program.   
Contact Diagnostic Instruments and request an updated chipinfo.dat 
file. 

Spot cannot be launched 
due to a disk or 
permissions error  
(Mac) 

The launcher failed to write a necessary file in the preferences folder.  

Reboot the computer. If the problem persists, run Disk First Aid, located in 
the Utilities folder of the boot drive. 

Spot cannot be launched, 
because the application 
cannot be located. (Mac) 

The SPOT application must be in the same folder as the copy of SPOT the 
user is trying to start. 

Move the application file (SPOT 3_5) into the proper folder file.  

Spot cannot run in the 
Classic environment under 
OS X. (Mac) 

This message appears if you try to run the OS 9 version of the SPOT v3.5 
software (either the full application or the 3rd Party Interface) in the Mac OS 
X environment.  SPOT closes immediately following the display of this error 
message. 

Re-open the SPOT software in Mac OS 9. 

The Spot Prefs folder is 
missing. (Mac) 

The folder, which is needed to run the program, is missing.  

Run the SPOT 3.5 application (i.e., double-click on it) to create the folder. 
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This version of Spot only 
runs on OS X.  (Mac) 

 

This message appears when you try to open the Carbon (OS X) version of 
the SPOT v3.5 software (either the full application or the 3rd Party Interface) 
in Mac OS 9.  SPOT closes immediately following the display of this error 
message. 

Re-open the SPOT software in Mac OS X. 

Video driver is not set to 
true color mode (millions 
of colors).  Displayed 
images may not appear 
with the correct colors. 

The video driver for your graphics card is not set to True Color mode. 

From the Windows Control Panel, change the graphics card settings to True 
Color (24 bit) or True Color (32 bit): Select  
 Start>Settings>Control Panel>Display>Settings> 
 Color Palette (Win 95/NT) or Colors (Win 98) 
and choose True Color (Win NT only), True Color (24 bit) or True Color 
(32 bit) from the drop-down list.  
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Add Measurement, 62 
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file type extensions to file name for Mac users, 31 
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Dark Level, 60 
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Add Calibration Mark, 61 
adding to zoomed images, 53 
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images, 63 
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Connected Lines, 65 
editing, 69 
Images, 66 
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Shapes, 65 
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defining for an image capture, 37, 95, 110 

artifacts in optical system, 38, 96, 111 
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annotation, 67 
report, 74 

Auto-Arrange Images, 83 
Auto-Gain Limit 

relation between gain, exposure time, and 
background noise, 35, 91 

Auto-Save Images, 29 
avi file format 

exporting SPOT sequence files to, 27 
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pixels, 53 
brightness 

adjusting for captured images, 60 
Brightness 

Image Setting, 92 
Image Setting for 3rd Party Interface, 107 

Brightness Image Setting, 36 
Bring to Front 

annotation mode, 69 

C 
Cache Images During Play (image sequences), 30 
calibration and measurement, 61 
calibration mark, 61 

calibration of microscope objectives, 28 
camera 

connecting to a microscope, xix 
connecting to your computer, xix 
initializing, 43 
using more than one on a single computer, xx 

capturing images 
Get Image, 46 
Get Sequential Images, 47 

catalog/ordering information - Vision series, 121 
CCD chip, 115 

design methodologies, 116 
charged coupled device (CCD), 115 
Chip Imaging Area, 37, 95, 110 
Close 

image file, 26 
color matching, 60 

3rd Party Interface, 109 
TWAIN mode, 95 

compression 
JPEG, 79 

computing white balance values, 45 
configuring 

printer, 81 
connecting the camera to a microscope, xix 
connecting the camera to your computer, xix 
contents 

shipping box, xiv 
contrast 

adjusting, 60 
conventions 

document, v 
copying 

images to another program, 58 
cropping images, 59 
Cut 

annotation mode, 69 

D 
Dark Level brightness adjustment, 60 
date and time 

associating with an image, 54 
Delete 

annotation mode, 69 
image file, 26 

Delete All 
annotation mode, 69 

Delete Page (report mode), 79 
digital photography, 115 
directory 

software installation, xv 
distributing reports, 80 
document conventions, v 
documentation 

on-line, xx 
Duplicate 
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annotation mode, 69 

E 
edit 

report objects, 77 
Edit 

image memo, 70 
images, 57 

Edit menu 
options, 57 

Editing options for image sequences, 57 
error messages (selected), 125 
errors, installation 

Windows 95, xvi 
exporting SPOT sequence files to avi movie format, 

27 
Exposure options 

Quality/Speed, 36 
exposure settings 

White Balance, 45, 94 
White Balance (3rd Party Interface), 108 

exposure time 
limiting for live image, 41, 99, 113 

Exposure Time, 93 
live image exposure option, 37, 108 

extensions (file type) 
adding to Mac file names, 31 

F 
File menu options, 25 
files 

.rpb report), 79 
flatfield, 39, 97, 111 

Fit to Window, 52 
flatfield correction, 38 

3rd Party Interface, 111 
TWAIN Mode, 96 

flipping image display, 58 
fluorescence images 

adjusting, 59 
focusing images in real-time, 44 
framing images in real-time, 44 
Full Screen view option, 54 
full well 

concept of, 34, 91, 117 

G 
gain 

defined, 34, 91, 117 
Gain, 93 

live image exposure option, 37, 108 
gamma 

adjusting, 60 
Gamma, 36, 93 

3rd Party Interface, 107 
Get Image, 46 
Get Sequential Images, 47 
Graphics Acceleration setting in Windows, xv 
guidelines 

installation, x 

H 
halo effect 

correcting on low contrast image captures, 38 
hardware 

installation, xviii 

I 
illumination 

correcting for uneven, 38, 96, 111 
image 

zooming, 52, 53 
image capture, 46 
image capture status messages, 46 
Image Date/Time, 54 
image editing 

basic functions, 58 
copy, 58 
cropping, 59 
sizing and position, 58 

image files 
closing, 26 
deleting, 26 
opening, 25 
printing, 27 
saving, 26 
saving in different formats or locations, 26 

Image Index (image sequences), 56 
image memo, 70 
image sequence files 

adding an open, non-sequence image to, 27 
creating new, 26 
opening, 26 

image sequences 
caching preferences, 30 
controls for playing, 56 

Image Index, 56 
Play Options, 56 

editing, 57 
Memory Usage Limit preference, 30 
printing, 84 
Sequence menu options, 55 

Image Settings, 33 
Brightness, 36 
Color Enhancement, 39 
Flatfield, 38 
Flip, 40 
Gamma, 36 
Image Type, 35 
Live Image Maximum, 41 
Minimum Exposure, 40 
Noise Filter, 41 
Rotate 90 degrees, 40 

Image Settings (3rd Party Interface mode) 
Image Flip, 112 

Image Settings (3rd Party Interface) 
Brightness, 107 
Color Enhancement, 112 
Gamma, 107 
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Image Rotate, 112 
Image Type, 106 
Live Image Maximum, 113 
Minimum Exposure, 113 
Noise Filter, 113 

Image Settings (TWAIN mode) 
Brightness, 92 
Color Enhancement, 97 
Image Flip, 98 
Live Image Maximum, 99 
Noise Filter, 99 

Image Settings (TWAINmode) 
Exposure Time, 93 
Gain, 93 
Gamma, 93 
Image Rotate, 98 
Image Type, 92 
Minimum Exposure, 98 
Quality/Speed, 92 

Image Type 
selecting, 35 
selecting (in the 3rd Party Interface), 106 
selecting (in TWAIN mode), 92 

images 
annotating, 63 
arranging for printing, 84 
compressing, 79 
flipping horizontally, 58 
flipping vertically, 58 
previewing in real time, 44 
rotating, 58 
saving automatically, 29 

Initialize Camera, 43 
installation 

hardware, xviii 
multiple SPOT cameras on one computer, xx 
PCI board, xviii 
SPOT software, xv 

on a Mac, xvii 
on Windows 95/98/NT/2000/ME, xv 

interface 
3rd Party, 102 
TWAIN, 86 

J 
JPEG Quality, 79 

L 
light sources, xi, xiii, 40, 98, 113 
lightening dark areas, 60 
Live Image Controls 

Exposure options 
Exposure Time, 37, 108 
Gain, 37, 108 
Quality/Speed, 107 

Live Image Maximum, 41, 90, 99, 105, 113 
Live Image mode 

and different light sources, 40, 98, 113 
video card related problems, xv 

live imaging, 44 

different light sources, xi, xiii 
low contrast image captures 

halo effect on, 38, 96, 111 

M 
Mac OS 

installing the SPOT software on, xvii 
magnified images 

navigating, 53 
manual 

introduction to, v 
organization of, vi 

Match Color, 60 
3rd Party Interface, 109 
TWAIN mode, 95 

measurements 
adding, 62 
types of, 63 

measuring specimens, 62 
Memory Usage Limit for image sequences, 30 
memos 

associating with an image, 70 
menus, 23 

Edit, 57 
Sequence, 55 
View, 52 

microscope 
connecting the SPOT camera to, xix 

microscopy techniques, 35, 92, 106 
monitors, xi 

Mac, xii 
Move Backward 

annotation mode, 69 
Move Forward 

annotation mode, 69 

N 
noise, electrical and thermal 

reducing in images, 41, 99, 113 

O 
objects 

report, 75 
on-line documentation, xx 
open 

image files, 25 
operating systems 

Mac, xii 
Windows, xi 

P 
Paste 

annotation mode, 69 
PCI board 

installing, xviii 
PDF documentation, xx 
photography 
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digital, 115 
pixel borders 

displaying, 53 
pixels (picture elements), 115 
Play Options (image sequences), 56 
Preferences, 30 

Add Extensions to File Names on Save (Mac), 31 
Image Sequences, 30 
Open Images in Fit to Window Mode, 31 
Thumbnail Button Size, 31 

previews 
thumbnail images, 25 

Print 
image files, 27 

printer properties, 81 
printer settings in Windows 98, xiv 
printer setup, 81 
printing, 81 

Auto-Arrange Images option, 83 
image sequences, 84 
multiple images on a page, 83 
reports, 80 
single images, 82 

processor 
Mac, xii 
Windows, x 

Profiles 
defining, 33 
defining in the 3rd Party Interface, 105 
defining in TWAIN mode, 90 

properties 
printer, 81 

Q 
Quality/Speed, 92 

Live Image Controls option, 107 
Quality/Speed exposure option, 36 
quick start, xxi 

capturing the initial image, xxii 
preparing the microscope and camera, xxi 

R 
RAM, recommended, x, xii 
real-time image preview, 44 
report objects 

Connected Lines, 76 
defining, 75 
double-clicking on, 73 
editing, 77 
Images, 76 
Lines, 76 
right-clicking on, 73 
Shapes, 76 
Text, 77 

reports 
attributes, 74 
creating new, 71 
defining attributes, 74 
defining view options, 73 
distributing, 80 

editing objects, 77 
printing, 80 
right-click and double-click functionality, 73 
saving, 79 
sizing and positioning report objects, 72 

requirements 
hardware, x 
software, x 

resolution 
monitor, xi 

Rotate Left, 58 
Rotate Right, 58 

S 
saving 

image files, 26 
reports, 79 

saving images automatically, 29 
selecting an image type, 35 
selecting an image type (3rd Party Interface), 106 
selecting an image type (TWAIN mode, 92 
Send to Back 

annotation mode, 69 
sequence files 

exporting to avi movie format, 27 
Sequence menu, 55 
sequential images 

capturing, 47 
number/timing options, 48 
save and name options, 48 
storage options, 48 
types of, 47 

setup 
calibration, 28 

Setup menu, 27 
Show Grid Lines, 53 
Show Image File Thumbnails, 25 
Show Pan Window, 53 
Show Tools dialog box, 64, 74 
snap to grid, 74 
software 

loading, xv 
SPOT 3rd Party Interface for Macs, 102 
SPOT camera operating principles 

gain, 34, 91 
SPOT cameras operating principles, 117 
SPOT program 

navigating in, 23 
SPOT RT camera operating principles 

automated exposure process, 118 
gain, 117 
pixel digitization, 117 

SPOT Vision 
catalog/ordering information, 121 
specifications, 119 

stage micrometer, 28 
status bar, 24 
status messages (image capture), 46 
system requirements, x 
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T 
taking a picture, 43 

first time instructions, xxi 
techniques 

microscopy, 35, 92, 106 
white balance, 45 
white balance (3rd Party Interface), 108 
white balance (TWAIN mode), 94 

theory 
digital imaging, 115 

thumbnails 
defining preferences for, 31 
displaying as previews, 25 

time lapse photography, 47 
toolbar, 24 
TWAIN interface 

establishing, 86 

U 
Undo 

annotation mode, 69 

V 
video cards 

Mac, xii 

problems with in Windows, xv 
Windows, x 

view full screen, 54 
View menu options, 52 
viewing and editing window, 23 

W 
wells on CCD chip, 115 
white balance 

techniques, 45, 94 
techniques (3rd Party Interface), 108 

White Balance, 45, 94 
3rd Party Interface, 108 

Windows 95 related errors, xvi 
Windows 95/98/NT/2000/ME operating systems 

installing the SPOT software on, xv 
Windows XP, xi 

Z 
zoom options 

Zoom In/Out, 52 
Zoom Level, 53 

zoomed images 
navigating around, 53 

zoomed images annotating, 53 
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